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IMPORTANT NOTICES

General

e Do not copy any part of this manual without written permission.
e If this manual is lost or worn, contact your dealer about replacement.
e The contents of this manual and equipment specifications can change without notice.

e The example screens (or illustrations) shown in this manual can be different from the
screens you see on your display. The screen you see depends on your system
configuration and equipment settings.

e Save this manual for future reference.

e The wrong use or modification of the equipment (including software) by persons not
authorized by FURUNO will cancel the warranty

How to discard this product

Discard this product according to local regulations for the disposal of industrial waste. For
disposal in the USA, see the homepage of the Electronics Industries Alliance
(http://www.eiae.org/) for the correct method of disposal.

How to discard a used battery

In the European Union

The crossed-out trash can symbol indicates that all types of

batteries must not be discarded in standard trash, or at a trash

site. Take the used batteries to a battery collection site

according to your national legislation and the Batteries Directive o

2006/66/EU.
In the USA

The Mobius loop symbol (three chasing arrows) indicates that @ @
Ni-Cd and lead-acid rechargeable batteries must be recycled. %(19 %
Take the used batteries to a battery collection site according to

local laws. Ni-Cd Pb

In the other countries

There are no international standards for the battery recycle symbol. The number of symbols
can increase when the other countries make their own recycling symbols in the future.



/A WARNING

A SAFETY INSTRUCTIONS

Do not open the equipment.

Hazardous voltage which can
cause electrical shock, burn
or serious injury exists inside
the equipment. Only qualified
personnel should work inside
the equipment.

A\ CAUTION

Use the proper fuse.

Use of a wrong fuse can result in fire or
permanent damage to the equipment.

This equipment is intended for marine
application.

Hazardous microwave.
Do not approach within
60 cm of the antenna radome
when it is transmitting.

Microwave radiation can be
harmful to the human body,
particularey the eyes.

Radiation Level | At
10W/m? 60 cm

WARNING LABEL

A warning label is attached to the
communication unit. Do not remove the
label. If the label is missing or damaged,
contact your dealer about replacement.

( N\

/N WARNING A\ Name: Warning Label (1)

To avoid electrical shock, do not| Type: 86-003-1011-1

remove cover. No user-serviceable . _92R-
parts inside. Code No.: 100-236-231

A A

Do not disassemble or modify the
equipment.

Fire, electrical shock or serious injury can
result.

Turn off the power immediately at the
ship's mains switchboard if water
leaks into the equipment or the equip-
ment is emitting smoke or fire.

Continued use of the equipment can cause
fire or electrical shock.

Any repair work must be done by a
licensed radio technician.

Improper repair work can cause electrical
shock or fire.
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FOREWORD

Introduction

FURUNO Electric Company thanks you for considering and purchasing the
FELCOM 16 Inmarsat Mini-C Mobile Earth Station. We are confident you will
discover why the FURUNO name has become synonymous with quality and
reliability.

The FELCOM 16 mainly consists of a communication unit and an antenna unit.
Connected to a PC (local supply), the FELCOM 16 provides a wide range of
communication services, such as e-mail and telex, for mobile and fixed terrestrial
subscribers in the Inmarsat C communication network. Its compact size permits
installation where space is limited.

FURUNO designs and manufactures this equipment with much attention to
operation and maintenance simplicity. However, please read and follow the
recommended procedures for operation and maintenance to get the most out of
the equipment.

This manual provides a brief introduction to the Inmarsat C system (pages x thru
xv). For more detailed information, refer to the information below.

Inmarsat C Maritime Customer Relations Officer
Maritime Services Operations Department
International Maritime Satellite Organization (Inmarsat)

Address: 99 City Road, London, EC1Y 1AX, UK
Telephone: +44 20 7728 1777 (Switchboard)

Fax: +44 20 7728 1142
URL: www.inmarsat.com
E-mail customer_care@inmarsat.com

Vil



FOREWORD

Features

Program Number

viii

E-mail facility. (To transmit E-mail, register with an LES provider which
provides e-mail services. E-mail charges are calculated separately.)

Built-in Enhanced Group Call (EGC) receiver. May be set to operate as
EGC-only receiver.

Store-and-forward telex communication (public telex network)

Data reporting and Polling

Diagnostic programs for maintenance

Menu driven operation

VMS (Vessel Monitoring System) applicable

PC Board Program No. Version No. Date of Modification
TERMINAL 1650166 03 5/2004
RF CON CPU 1650160 03 5/2004




SYSTEM CONFIGURATION

ANTENNA

UNIT
IC-116
SHIP'S MAINS o ;
100-115/200-230 VAC . acDC | ' PRINTER
19, 50/60 Hz @ - Power Supply: ; !
,,,,, i PR-240
SHIPSMAINS | § oo S — ,
12-24 VDC ; e i PERSONAL i
o —{ I B -=i  COMPUTER g
i (PCIAT compatible) i
COMMUNICATION UNIT IC-216 | s L
(with internal GPS receiver) *
JUNCTION BOX — : Standard
IC-315 (| e : Option
CATEGORY OF UNITS I + Local Supply
Antenna _Unlt_: _ Exposed to Weather SSAS ALERT UNIT *: SSAS Specification
Communication Unit: Protected from Weather 1C-307
Other Units: Protected from Weather [
SSAS ALERT UNIT
IC-307




INMARSAT C SYSTEM OVERVIEW

Introduction

The Inmarsat C system provides worldwide telex and data transmission and
reception of written information to owners of an Inmarsat C transceiver or a
terrestrial telex network via satellite. Further, e-mail may be sent via the internet.

Communication mode is store-and-forward telex, which means all information
sent are first stored at an LES and then delivered to designated party.

An EGC (Enhanced Group Call) receiver is built in the FELCOM 16 to receive
the following types of messages, broadcast by LESs:

e SafetyNET'“-governments and maritime authorities can use this service to
distribute maritime safety information to ships within selected areas.

e FleetNET™-commercial subscription organizations or shipping companies
can use this service to transmit trade information (for example, company
news or market prices) simultaneously to a selected group of ships, to
provide up-to-the-minute information.

e EGC system-related is sent by Inmarsat to certain shipping companies and
geographical areas.

Besides its primary application of ship-shore, shore-ship or ship-ship
communications, the Inmarsat C service has also proved beneficial to trucking
firms who have found it indispensable for communicating with their vehicles. In
this manual, however, we will concentrate on ship applications, the main
application.



INMARSAT C SYSTEM

Inmarsat C System Configuration

/;\\

ocCC
C

C

N

LES | [ LES |— LES

! ! ! ! !
! ! ! ! !
! ! ! ! !
! ! ! ! !
! ! ! ! !
! ! ! ! !
! : ! ! !
! ! ! ! !
I ! I I I
| \ i Sameasleft ;| Sameasleft | Same as left |
I ! | | |
[ %@ Satellite ! [ [ !
| Uy, ! | | |
! ! ! ! !
! / / \ ! ! ! !
1 ! 1 1 1
| MES, | | |
! ! ! ! !
|
| AOR-West . AOR-East ' IOR '  POR |

OCC: Operation Control Center
SCC.: Satellite Control Center
NCS: Network Coordination Station
MES: Mobile Earth Station

LES: Land Earth Station

Inmarsat C system configuration

Xi



INMARSAT C SYSTEM

Xii

The Inmarsat C system consists of the Operation Control Center (OCC), Satellite
Control Centers (SCC), Network Coordination Stations (NCS), Land Earth
Stations (LES) and Mobile Earth Stations (MES). The OCC, located at Inmarsat’s
London headquarters, coordinates a wide range of activities in the Inmarsat
system, including commissioning of mobile earth stations.

The Inmarsat C system divides the world into four regions and each region is
covered by its own satellite.

Inmarsat system satellites

Region Satellite Satellite Position
AOR-West Inmarsat 3, F4 54.0°W
AOR-East Inmarsat 3, F2 15.5°W
IOR Inmarsat 3, F1 64.0°E
POR Inmarsat 3, F3 178.0°E

In each region there is one NCS and several LESs. The NCS keeps track of all
Inmarsat C transceivers in its region and broadcasts information such as
navigational warnings, weather reports and news. The LESs provide the link
between the MES and the terrestrial telecommunications networks via satellite.
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INMARSAT C SYSTEM

Communications Network

The illustration below shows the Inmarsat C communications network.

Network NCS/NCS Signaling Link
Coordination

Station (NCS)

NCS/LES
Signaling Link NCS Common Channel
Mobile Earth
Station (MES)
pata 1 Cramner O\, " Data Terminal |
Communications : : Eqﬁpame?\rtnzg]'?E) : !
Network Land Earth ! Data_Clrc_wt :
Station | Terminating !
MES Message | Equipment :
(LES) Channel | (DCE) s
Telex Network oL : thanced Group ;|
LES TDM | ‘Calling (EGC) Receiver, |
N Channel T
Terrestrial
Communications
Network

Inmarsat C communications network

NCS common channel  The NCS has two major functions:
1) Transmitting information on a common channel.
2) Transmitting EGC messages to MESs.
NCS/LES signaling link  This is the link between NCS and all LESs in its
region. All EGC messages pass through this link.
LES TDM channel This channel carries the circuit control signal for
MES and transmits messages from LES to MES.
MES message channel  This channel carries messages from MES to LES.
MES signaling channel  This channel transmits requests, data reports, etc. In
addition, it carries login and logout from MES to
NCS.
NCS/NCS signaling link  This is the link between NCSs. It exchanges data
between MESs operating in different ocean regions.
MES interface The MES consists of the Data Circuit Terminating
Equipment (DCE) and the Data Terminal Equipment
(DTE). The DCE consists of the antenna unit, and
the DTE consists of the communications unit and
terminal unit (PC).
Terrestrial network The major functions of the LESs are:
interface
1) Telex store-and-forward conversion
2) Handling EGC messages
3) Data Reporting and Polling
4) Distress message processing

Xiv



INMARSAT C SYSTEM

Types of MES

There are three types of MES: class 1, class 2 and class 3. This FELCOM 16
is a class 2 MES.

Class 1: 1) Transmits messages to LES
2) Receives messages from LES
Class 2: 1) The functions of class 1 plus operation as an EGC receiver
when not transmitting or receiving.
2) EGC-only receiver
Class 3: The function of class 1 plus simultaneous operation as an
EGC-only receiver.

XV
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LRIT COMPLIANCE

This equipment can function as a marine communications terminal for the LRIT
(Long-Range Identification and Tracking) system, as prescribed by the IMO regulation
MSC.202(81). The LRIT uses the FELCOM's Data Report/Polling feature for LRIT position
reporting.

The LRIT system is fully automatic, thus no operation is required of the user. However,
follow the guidelines shown below to use this equipment as an LRIT device.

The data listed below is sent by the FELCOM when it receives a command from the LRIT
data center.

e ID number of this equipment
e Position of your ship

e Time of position
The FELCOM sends data at intervals between 15 minutes and 6 hours.

The FELCOM automatically receives commands (related to time of position reporting,

transmission interval) from the LRIT data center. To receive the commands at all times,
keep the equipment powered and logged in.

Satellite System

Coast Station

Country A
LRIT DATA
CENTER Country B
Country C
LRIT system

XVil



LRIT COMPLIANCE

Notes on the LRIT system

Power the equipment and keep it logged in at all times except for special occasions
such as when the ship is dry-docked for repairs. Position information is automatically
sent at fixed intervals, thus no operation is required. However, keep the equipment in a
ready state to received commands from the LRIT data center. Combined use for routine
messages, distress messages and SSAS (Ship Security Alert System) is possible.

The source of position data for this equipment is its internal GPS receiver thus no
external receiver is necessary.

This equipment must be powered in the following manner.
- Conn the equipment to both main and emergency power sources (via AC-DC power
unit PR-240).

If an error message appears, take the necessary measures to restore normal operation
as soon as possible. Shown below are representative alarms.
- WARNING: External NAV equipment failure.
Position data is not correctly input from the external GNSS equipment. Check the
GNSS equipment and the wiring between it and the FELCOM.
- WARNING: Internal GPS UNIT failure.
Position data is not correctly input from the internal GPS receiver. If this alarm occurs
frequently, have the set checked.
- WARNING: Synchronization loss. Please check the current Ocean Region. -
- WARNING: BBER over 80%. Scanning NCS start manually.
Problem with receiving the Inmarsat-C signal. Check if the current sea area is
suitable for your position. If it is not, change the sea area. If the area is suitable and
the alarm continues, check the antenna and antenna cable. Request service if the
problem persists.

XVili



1. OPERATIONAL OVERVIEW

1.1 Communication Unit

The communication unit is the heart of the FELCOM 16 system, transmitting and
receiving messages via the Inmarsat system.

[FUMRMUILTI@  INMARSAT MINI-C MOBILE EARTH STATION

& o ol
QO*\\ \,OO »\“‘ Q/QSL
0O OO O

POWER
Switch

O POWERI

Status LEDs
POWER: Lights (in green) when power is on.
LOGIN: Lights (in green) when logged in;
flashes (in green) in green in other instances.
TX: Lights (in green) when transmitting.
ERROR: Flashes (in red) for equipment error.

Communication unit 1C-216

1.1.1 Turning the power on/off
Press the [POWER] switch to power the communication unit and antenna on or
off.

Note: The example screens shown in this manual may not match the screens
you see on your display. The screen you see depends on your system
configuration and equipment settings.

1.1.2 Diagnostics

When the communication unit is turned on it automatically conducts a series of
diagnostic tests to check itself for proper operation. The test takes about 30
seconds and all lamps are on during the test. For further details, see Chapter 7.

1-1



1. OPERATIONAL OVERVIEW

1.2

1.2.1

1-2

Terminal Unit (PC) Operation

All operations are carried out from the terminal unit (local supply), through an
easy-to-follow menu system. In this manual the PC is referred to as “Terminal
Unit.” Note that it is necessary to supply a printer.

PC requirements

Operating system: Windows98, Windows 2000, Windows ME,
XP, or Vista

Memory: At least 32 MB

Free space in hard disk: At least 20 MB

CPU: Pentium 100 MHz or higher

Floppy disk drive

Windows is a registered trademark of Microsoft Corporation in the US and other
countries used under license.

Starting, quitting the application

For information about terminal unit operation see the PC’s owner’s manual.

1.
2.
3.

o

Turn on the communications unit.

Turn on the terminal unit.

Double-click the F16PC icon to start the application. After the program has
been loaded the standby display appears. For details about the standby
display see paragraph 1.3.

F16PC icon

Note: The example screens shown in this manual may not match the
screens you see on your display. The screen you see depends on your
system configuration and equipment settings.

To quit the application, press the [F12] key while pressing the [Alt] key. The
following display appears. (You may also quit the application by clicking the
Close button at the top right corner of the screen.)

OK to quit system?

Press the [«] key to choose Yes and then press the [Enter] key.
Turn off the terminal unit in accordance to Windows operating procedure.
Turn off the communications unit.

Note: If a different method is used to quit the application, any settings changed

before quitting will not be saved.
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Controls description

The FELCOM 16 is almost 100% keyboard controlled. Operation is carried out
with the function keys, numbered F1-F10 at the top of the terminal unit’s

keyboard.

Controls

Esc

F1-F10
Backspace
Insert

Delete

Home

End

PgUp

PgDn

[T 1, [, [=]
Enter

Shift

Alt
Space Bar
Caps Lock

Tab

Cancels key input and returns to previous display screen.
These are the function keys. They choose menus.
Deletes the character to the left of the cursor.

Works the same as “paste.” See “Copying and pasting text” in
paragraph 3.2.4.

Deletes the character selected with the cursor.

Moves the cursor to the top of the message being edited.
Moves the cursor to the bottom of the message being edited.
Goes to the previous page of the edit screen.

Goes to the next page of the edit screen.

Control the cursor.

Registers key input.

Chooses upper or lower case alphabet. Press and hold down
the key and then press the [Caps Lock] to get upper or lower

case alphabet. Note that only upper case alphabet are used in
telex.

Executes the shortcut key operation when combined with an
alphabet key. See paragraph 1.2.3.

Inserts a space. In addition, it displays the file list, a partial
view of a file, etc., depending on menu.

Turns upper case alphabet input on or off. The Caps Lock LED
lights when upper case input is on.

Inserts horizontal tab characters. The number of tab characters
the key can insert per line of text can be programmed for two,
four or eight tabs.
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1.2.3

1-4

Ctrl Works in combination with alphabet keys as follows:
Ctrl + [M]: Same as Enter.
Ctrl + [H]: Same As Back Space.
Ctrl + [I]: Same as Insert.
Ctrl + [V]: Same as Overwrite+Insert.
Num Lock Turns numeric input on or off. Note that you cannot enter
alphabet when the Num LED is lit.

Note: In telex, lower case, #, &, *, $, @, %, etc. are not used. A full list of
characters useable in telex appears in the Appendix. For e-mail any
character or symbol may be used.

Shortcut keys

The FELCOM 16 provides the keyboard shortcuts shown below for commonly
used functions.

Shortcut keys

Shortcut key Function
[Alt]+[N] Same as New in File menu
[Alt]+[O] Same as Open in File menu
[Alt]+[Q] Same as Close in File menu
[Alt]+[D] Same as Delete in File menu
[Alt]+[S] Same as Save in File menu
[Alt]+[P] Same as Print in File menu
[Alt]+[X] Same as Undo
[Delete] Same as Cut in Edit menu
[Alt]+[C] Same as Copy in Edit menu
[Insert] Same as Paste in Edit menu
[Alt]+[V] Same as Change Window in Edit menu
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1.2.4 Function keys

The function menus, which you access by pressing the function keys (F1-F10) at
the top of the keyboard, control most operations of this unit.

File Transmit ~ Reports Options Position

\Edit \ EGC Logs / Setup

\ | | [ / / ]
1 I T I !
AOEBEERDREE)

|

StopAlarm

Keyboard
Function key description
Menu Description

File (F1) Processes files.
Edit (F2) Provides text editing facilities.
Transmit (F3) Transmits messages.
EGC (F4) Sets up EGC message facilities.
Reports (F5) Sets up data reporting function.
Logs (F6) Displays sent and received message logs.
Options (F7) Login, logout; testing facilities.
Setup (F8) Sets up the system.
Pasition (F9) Enter your ship’s position manually.
Stop Alarm (F10) | Silences audio alarm.
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1.3  Standby Display

After the equipment is turned on and the diagnostic test has been conducted, the
standby display appears, showing the system status monitor. The system status
monitor provides various operating information. For a detailed description, see
paragraph 7.4.

File Edit Transmit EGC Reports Logs Options Setup Position StopAlarm
IMN: 443156710
Date 02-02-25 BBER 000
Time 01:32 (UTC) CIN OK ( 0dB)
Send Level OK ( 0)
Position LAT 34:30.00N Rx AGC Level OK (135)
LON 135:00.00E REF Offset Freq OK( OH2
Waypoint LAT Synthe Local OK
LON VCXO Control 131
Course 345 DEG
Speed 10.2KTS
Current NCS 344 (IOR) LOGOUT Antenna Power Supply ~ OK
Current Channel  NCSCC
Current TDM NCSCC Water Temperature DEG
MES Status Idle Water Current
GPS Status 2D Direction DEG
32818 Bytes free Speed KTS
DCE Memory Depth
Current State: IDLE UNSYNC 02-02-25 01:32 (UTC)
NCS: IOR LOGOUT LAT: 34:30.00N
DCE F16 Ver. ## LON: 135:00.00E
## = Version No. of RF CON Board
Standby display

After the diagnostic test has been completed, the equipment automatically starts
synchronizing itself with a satellite. When the indication “Retuning” is replaced
with * SYNC(NCS), the synchronization process is completed. Then, you are
ready to receiving EGC messages. For further details see paragraph 2.4.
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Display indications
The display is divided in three sections:
1) The function menu area

2) The working area
3) The operating status area

File Edit Transmit EGC Reports Logs Options Setup Position StopAlarm <e—— ]_) Function
_*— Menu

2) WORKING AREA

— 3) Operating

Status

3a 5 § )

Location of display indications

Below are the indications and meanings of the items in parentheses in the
illustration above.

(1) Communication network mode

No display Normal operation

Restoration Mode Problem at NCS

(Flashing)

Restoration Mode Previously designated LES is transmitting the
(Reverse video) NCS common channel signal.

1-7



1. OPERATIONAL OVERVIEW

(2) Communication unit status

IDLE Idle (awaiting receiving, awaiting transmitting)
IDLE (PENDING) Awaiting reply from LES

SENDING Sending

RECEIVING Receiving

LOGIN Logged in with NCS

LOGOUT Logging out with NCS

Data Report Sending data report

TESTING PV (Performance Verification) testing

TEST SETUP Requesting PV testing

SCANNING NCS scanning

EGC RECEIVER EGC-only receiver operation

(Reverse video)

Delivery Status Req. Transmitting delivery status request

Forced Clearing Stopping receiving, transmitting, or scanning

(3a) Communication status

CALLING Now calling

WAITING FOR ACKNOWLEDGEMENT Waiting for acknowledgement from
LES.

RECEIVING EGC MESSAGE Now receiving EGC message

WAITING FOR BACKOFF Waiting to transmit data report

Successful Login. Login was successful

Login failed. Login failed

Successful Logout. Logout was successful

Logout failed. Logout failed

Successful Forced Clearing. Forced clearing successful

Forced Clearing Failed. Forced clearing unsuccessful

SENDING MESSAGE PACKETS Sending TX message packets

WAITING FOR ACKNOWLEDGEMENT Waiting for acknowledgement from LES

Successful sending to LES. Message successfully sentto LES

Sending message failed. Message could not be sent to LES

Call rejected. LES rejected your message

Call pending. LES temporarily suspending
communications

Received Call. Call received from LES

Received Call(ITA2). Call(ITA2) received from LES

RECEIVING MESSAGE PACKETS Receiving message packets

CLEARING Clearing TX sequence

Successful receiving. You successfully received message

Receiving failed. You could not receive message

Successful Data Report. Data report successfully sent.

Data Report failure. Data report could not be sent.

PV TEST CALL is rejected. PV test call rejected by NCS

PV TEST CALL is pending. PV test pending by LES

TEST-RECEIVING MESSAGE Receiving test message from LES

TEST-SENDING MESSAGE Sending test message to LES
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Sending test distress alert to LES

WAITING FOR ACTIVATION Waiting start of PV test
WAITING FOR TEST RESULT Waiting for results of PV test
CLEARING Clearing PV test

PV TEST is Completed.
PV TEST Failure.

PV test is completed.
PV test failed.

(3b) RF CON board program version number

DCE F16 Ver. XX (XX = Version Number)

(4) Frame synchronization

Blank

SYNC (NCS)
SYNC (LES)
MES Sig. Ch
MES Msg. Ch
UNSYNC
Retuning

Changing channel, or during transmission
Synchronizing with NCS

Synchronizing with LES

Transferring to MES signaling channel
Transferring to MES message channel
Out of synchronization

Synchronizing with NCS or LES

(5) Ocean region receiving

No display
AOR-W
AOR-E
IOR

POR

(6) Logging status

LOGOUT
LOGIN
LOGIN (Flashing)

Out of synch with satellite
Atlantic Ocean Region-West
Atlantic Ocean Region-East
Indian Ocean Region

Pacific Ocean Region

Logged out with ocean region
Logged in with ocean region
Logging in with ocean region
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(7) Other information

No display No receive message in memory, or printer is
operating.

REC. MESSAGE EXISTS Displayed when a routine message has

(Reverse video) not been printed, or a confidential message is
received.

Data Report When data reporting is activated.

(Reverse video)

Message Report Message report setting is activated.

(Reverse video)

(8) Date and time

Date and time, received from the GPS navigator, are displayed. Manually input
date and time are also displayed.

(9) Ship’s position

Ships position, received from the GPS navigator, is displayed in latitude and
longitude and updated every 30 seconds, or manually input position is displayed.
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Menu Overview

Operation of the FELCOM 16 is carried out through a menu system which you
access with the function keys at the top of the screen. The example below
shows how to choose menu options from the Editor Setup menu.

1. Press the [F8] key to display the Setup menu.

File Edit Transmit EGC  Reports Logs Options Position StopAlarm

Setup

1. System Setup

2. Editor Setup

3. Terminal Setup
4. EGC Setup

5. Auto Mode Setup
6. E-Mail Setup

7. Directories

8. Configuration

Setup menu

2. Choose desired menu by pressing appropriate numeric key. For example,
press the [2] key to show the Editor Setup menu.

Note: You may also choose a menu by pressing the [T] or [{] key to choose it
and then pressing the [Enter] key.

File Edit Transmit EGC Reports Logs Options [Egdls] Position StopAlarm

Setup
Editor Setup

Text Mode AsCii

Edit Mode Insert
Word Wrap ON

Line No. ON

Tab Width 4 Char
Column Width 69

Cursor Type Block
Scroll Full Screen

Editor setup menu

3. Choose desired menu item by pressing the [T] or [{] keys followed by the
[Enter] key. A window displaying the options for the item selected or a
alphanumeric data entry window appears depending on your selection. For
example, choose Word Wrap.

OFF

Word wrap options window
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3. Press the [T] or [{] key to choose option desired and press the [Enter] key.
4. Press the [Esc] key.

Note 1: On some menus the update window appears after you press the [Esc]
key. This is done to ask you to confirm settings. Yes is selected in the
Update window; press the [Enter] key to register settings, or press [—]
to choose No and press the [Enter] key to escape.

Update
| No

Note 2: The following functions are not available:

Keying Sequence Item

F3-1 Selection of Priority on Transmit Message

F8-1 NAV PORT, MESSAGE OUTPUT PORT, ACTIVE
PORT, EGC OUTPUT PORT, NETWORK SETUP
on System Setup menu

F8-4 Waypoint on EGC Setup

1.5 Error Messages and Alerts

The terminal unit displays error messages and alerts to call your attention to
misoperation, failed operation and system error. A list of error messages appears
in Chapter 7 and alerts in the Appendix.

To erase an error message or alert, press the [Esc] key.

File Edit Transmit EGC  Reports Options  Setup Position  StopAlarm

Log
2. Recelve Message Log
Send Message Log
No. MessageFile Station LES Priority Send Status Delivery
CAUTION

No Message.

<Press ESC key to continue>

Location of error messages and alerts
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1.6 Choosing a Printer

Choose the printer to use as follows:

1. Press the [F1] key to display the File menu.

Edit Transmit EGC Reports Logs Options Setup Position StopAlarm

File
1. New ALT-N
2.0pen  ALT-O
3. Close ALT-Q
4. Save ALT-S

9. MIME (Decode)

File menu
2. Press the [8] key to choose 8. Print Setting.

Print Setting
Please select Printer
and press Enter key. Windows Printer
PP-510

3. Press the [T] or [{] key to choose appropriate printer.
No Printer: Choose this item if no printer is connected.
Windows Printer: Choose if a PC-use printer is connected.
PP-510: Choose if PP-510 is connected.

4. Press the [Esc] key to finish.
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2.

SYSTEM INITIALIZATION

2.1

This chapter provides the information necessary for initializing the FELCOM 16.
Once the equipment is initialized, you need do no more than press a few keys to
transmit and receive.

Inmarsat assigns an MES an Inmarsat Mobile Number (IMN) when it applies for
Inmarsat registration and it is entered during the installation of the MES. The
IMN is necessary to communicate in the Inmarsat system.

System Settings

The System Setup menu provides for input of date, time, operating mode, and
port function.

1. Press the [F8] key to choose the Setup menu.

File Edit Transmit EGC  Reports Logs Options Position StopAlarm

Setup

1. System Setup

2. Editor Setup

3. Terminal Setup
4. EGC Setup

5. Auto Mode Setup
6. E-Mail Setup

7. Directories

8. Configuration

Setup menu
2. Press the [1] key to display the System Setup menu.

Setup I
System Setup
01:53 02-02-25 (YY-MM-DD)
Entered at installation IMN
(Cannot be changed.) || MESOperationMode  INMARSAT-C
Nav Port INT
Active Port INT
Not used: M essage Output Port INT
EGC Output Port INT
Network Setup
" Command Window

System setup menu

Note: The IMN number is entered during the installation. The number cannot
be changed.
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3. Press the [{] key twice to choose MES Operation Mode.
4. Press the [Enter] key to open the MES operation mode options window.

Setup I
System Setup
System Date & Time 01:53 02-02-25 (YY-MM-DD)
IMN
Nav Port EGC
Active Port
Message Output Port INT
EGC Output Port EXT
Network Setup EXT
—| Command Window

System setup menu, MES operation mode options window

5. Press the [{] or [T] key to choose operating mode, INMARSAT-C or EGC.
The INMARSAT-C setting provides telex communications and operates as an
EGC receiver when the equipment is not transmitting or receiving. The EGC
setting enables EGC-only operation. In this case, “Current State: EGC
RECEIVER?” (in reverse video) at the bottom of the screen.

6. Press the [Enter] key to close the window.

7. Press the [Esc] key to open the update window.

Setup I
System Setup
System Date & Time 01:53 02-02-25 (YY-MM-DD)
IMN
MES Operation Mode INMARSAT-C
Nav Port INT
Active Port INT Update
Message Output Port INT | _________
EGC Output Port INT
L| Network Setup o
For technicians — Command Window

8. Yes is selected; press the [Enter] key to update system settings.
9. Press the [Esc] key to return to the standby display.

Note: If the internal GPS malfunctions, enter data manually as below.
1. Choose System Date & Time from the System Setup menu and then
press the [Enter] key.

Setup |
Syst
Bo0225 |(vv-MM-DD)
IMN
MES Operation Mode INMARSAT-C
Nav Port INT
Active Port INT
Message Output Port INT
EGC Output Port INT
Network Setup
—1 Command Window

Date and time entry window

2. Enter date with the numeric keys.
3. Press the [Enter] key to close the window.
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PC Window Setup

The Terminal Setup menu provides for set up of the PC window. Set up includes
selection of date display format, currency unit and window colors.

1.
2.

Press the [F8] key to choose the Setup menu.
Press the [3] key to display the Terminal Setup screen.

Terminal Setup
Date Disp. Form YY-MM-DD
Currency Unit uss
Screen Saver ON
Window Color

Terminal Setup menu

. Date Disp. Form is selected; press the [Enter] key to open its options window.

YY-MM-DD
MMM-DD-YY
DD-MMM-YY

Date options

Press the [{] or [T] key to choose date display format desired and then press
the [Enter] key to close the window.

Press the [{] key to choose Currency Unit.

Press the [Enter] key to open the currency unit options window.

EXE
Uss
EUR
YEN
OTHER

Currency unit options
Press the [{] or [T] key to choose the currency unit to use to calculate toll
charges. SDR means Special Drawing Right and it is the common unit
charge used by all LES to assess toll charges. For OTHER, enter currency
unit name (4 characters max.). Your selection appears next to Currency Unit
in the Terminal Setup menu.
Press the [Enter] key to close the window.
Press the [{] key to choose Window Color and press the [Enter] key.

—— Window Color

Window Color Setup
Default Color

Window color menu
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10.You may change the background and foreground colors for the various
display screens on the PC window as follows:

a)Choose Window Color Setup.

Window Color Setup

: Base Window
Fore Color :L_WHITE
Back Color : BLUE

To Change: ENTER To Change Value: L<=>R

Window color setup menu

b)Window is selected; press the [—] or [«] key to choose the item to adjust.

BASE WINDOW: Standby display
RCV Message Display: Communications memory display
EGC Message Display: Communications display
EDIT1 - EDIT 2 Editor screens
Function: Menu
Sub Menul — Sub Menu4: Sub menus
Message: Status message
EDIT BASE WINDOW

File Edit Transmit |[EGC Reports Logs Options Setup Position| StopAlarm

<[1] UNTITLED1 >

1
2.
:
MENU —+|
|
|
|
|

CAUTION
—<_|_ MESSAGE

Location of items

c) Press the [{] key to choose Fore Color.

d) Press the [—] or [«] key to choose foreground color desired

e) Press the [l] key to choose Back Color.

f) Press the [—] or [«] key to choose background color.

g) To change the color of other windows, repeat steps b-f.

h) Finally press the [Enter] key to show the Update window.

i) Yes is selected; press the [Enter] key.

Note: To restore all default color settings, choose Window Color from the
Terminal Setup menu, choose Default Color and then press the [Enter]
key. Yes is selected; press the [Enter] key.

11. Press the [Esc] key three times to return to the standby display.
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Login and Logout

Each time the terminal unit is turned on, register your vessel with the Inmarsat C
system to enable communications between your vessel and an LES. This is
called login.

Note that you can transmit or receive EGC messages even if you are not logged
in.

If you will not be using the FELCOM 16 for a prolonged period, you should
logout from the Inmarsat C system, before turning off the terminal unit. The
Inmarsat C system will then register you as inactive, notifying anyone trying to
call you that you are currently unavailable. If you do not log out before turning off
the power, some LESs may attempt to send a message to you. They may
charge your correspondent, even if you don’t receive the message.

Login

1. Confirm that “SYNC (NCS)” appears at the bottom of the screen.
2. Press the [F7] key to display the Options menu.

File Edit Transmit EGC Reports  Logs Setup Position StopAlarm

—— Options
2. Logout
3. Abort
4. Select NCS
5. Ocean Region
6. LES Information
7. Test

Options menu
3. Press the [1] key to display the Login screen.

—— Options ]

Login

Login screen
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Note: The terminal unit must be “idle” to login. (“Current State: IDLE”
appears at the bottom of the screen.) When it is not idle, “Ignored:
MES is not idle.” appears. Press the [Esc] key to return to the standby
display. Wait until the terminal unit becomes idle.

4. Yes is selected; press the [Enter] key to start login.
5. Login begins and the screen should now look something like the illustration
below, with “LOGIN” flashing.

File Edit Transmit EGC  Reports Logs Setup Position StopAlarm

—— Options ]

Login

Starting Login Process.
Press any key to escape.

LOGIN replaces IDLE.

/ Flashing during login
Current State: LOGIN SYNC (NCS) / 02-02-25 02:02 (UTC)
CALLING NCS: IOR LOGIN LAT: 34:30.00N
DCE F16 Ver. ** LON: 135:30.00E

Appearance of display screen during login

When login is completed, the message “Successful login.” appears. Then,
the terminal unit goes into “Idle” status and LOGIN stops blinking.

6. Press any key to return to the standby display.
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2.3.2 Logout

1. Press the [F7] key to display the Options menu.
2. Press the [2] key to display the logout screen.

Note: The terminal unit must be “idle” to logout. When it is not idle, “Ignored:

MES is not idle.” appears. Press the [Esc] key to return to the standby
display. Wait until the terminal unit becomes idle.

File Edit Transmit EGC  Reports Logs Setup Position StopAlarm
Options —]
Logout
Start
Current State: IDLE SYNC (NCS) 02-02-25 02:04 (UTC)
Successful Login. NCS: IOR LOGIN LAT: 34:30.00N
DCE F16 Ver.** LON: 135:30.00E

Options menu, logout screen

3. Yes is selected; press the [Enter] key to start logout. The screen now looks
something like the illustration below.

File Edit Transmit EGC

Options —]

Reports  Logs Setup Position StopAlarm

Logout

Starting Logout Process.
Press any key to escape.

Current State: LOGOUT
CALLING
DCE F16 Ver. **

SYNC (NCS)

02-02-25 02:02 (UTC)
NCS: IOR  LOGIN

LAT: 34:30.00N
LON: 135:30.00E

Appearance of display screen during logout

4. When logout is completed, “Successful Logout.” appears. “Current State”
then returns to IDLE.

5. Turn off the FELCOM 16.
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2.4
2.4.1

2-8

EGC Settings
What is the EGC (Enhanced Group Call) service?

The EGC service enables EGC information providers to send SafetyNET™,
FleetNET™ and System messages via an LES to a specific groups of ships, or

to

all ships within a defined geographical area.

Each type of EGC service is sent as follows:

1)

2)

3)

The information provider prepares the message, and then accesses the
appropriate Country of the international telex network to send the message
to an LES.

The LES processes and forwards it to the NCS for the ocean region
designated by the provider.

Then, the NCS broadcasts the message throughout the ocean region. (The
operator may choose the EGC messages to receive by position (one
position) and geographical position (nine areas). For further details see
paragraph 2.4.2.)

. . NCS common channel
Information Provider chi
* Meteorological body —> LES1
* Navtex station MES
* Coast guard ch?
* Rescue center —> LES2 MES
* Shipping company,
etc.
—>| LES3 chs YyYy MES

NCS

Ch1-Ch3 are dedicated
channels for each LES.

The EGC system

Three EGC services are available:

1)

SafetyNET™

This provides a means for information providers to distribute Maritime Safety
Information (MSI) from shore-to-ship. Authorized information providers
include:

a) Hydrographic Offices, for navigational warnings

b) National Weather Services, for meteorological warnings and forecasts

c) Rescue Co-ordination Center, for shore-to-ship distress alerts and other
urgent information

d) International Ice Patrol, for North Atlantic ice hazards
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2) FleetNET™
This service allows authorized information providers such as commercial
subscription services, shipping companies and governments, which have
registered with a LES that supports FleetNET™, to broadcast messages to
selected group of MESs. Typical applications of FleetNET™™ are

a) Fleet or company broadcasts

b) News broadcasts

c) Commercial weather services

d) Market quotations

e) Government broadcasts to all vessels on a country’s registration

3) System

EGC system-related is sent by Inmarsat to certain ship groups and
geographical areas.
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2.4.2

2-10

EGC setup

The FELCOM 16 receives EGC messages directed to its present position and
Navarea without further programming. The EGC Setup screen lets you choose
additional areas for which to receive messages and also the Navtex station and
type of message for Coastal Warning (NAVTEX Re-broadcast).

1. Press the [F8] key to display the Setup menu.

File Edit Transmit EGC  Reports Logs Options Position StopAlarm

Setup

1. System Setup

2. Editor Setup

3. Terminal Setup
4. EGC Setup

5. Auto Mode Setup
6. E-Mail Setup

7. Directories

8. Configuration

Setup menu

2. Press the [4] key to display the EGC Setup menu.

OMEGA messages
SATNAYV messages

Setup
Receive EGC Area
Navarea
Fixed Area
Not used. Waypoint (from NAV Equipment)
NAVTEX
Station Code
Type of Message (Can't reject other report)
Ice reports OFF
Meteo. forecasts ~ OFF
Pilot service OFF

DECCA messages OFF
LORAN messages OFF

Other navaid msg
QRU (no message)

OFF
OFF
OFF
OFF

EGC setup menu

3. The cursor is selecting Additional Position, where you can enter the L/L
position of an ocean region you want to receive broadcasts about. Press the

[Enter] key to open the additional position entry window.

4. Enter position as follows:
a) Enter latitude (XX° XX).

b) Press the [N] or [S] key as appropriate to enter coordinate.

¢) Enter longitude (XXX° XX).

d) Press the [E] or [W] key as appropriate enter coordinate.

o

6. Press the [{] key to choose Navarea.

Press the [Enter] key to close the additional position entry window.
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7. Press the [Enter] key to open the navarea entry window.

Setup
EGC Setup

Receive EGC Area
Additional Position
INEVELGED Sl
Fixed Area
Waypoint (from NAV Equipment)  OFF

NAVTEX
Station Code
- Type of Message (Can't reject other report)
|ce reports OFF OMEGA messages  OFF
Meteo. forecasts  OFF SATNAV messages OFF
Pilot service OFF Other navaid msg OFF
DECCA messages OFF QRU (nomessage)  OFF

LORAN messages OFF

EGC setup menu, Navarea entry window

8. Enter additional Navarea(s) (I-XVI, up to nine) in two digits, referring to the
illustration below for code number.

XIv
New Zealand

T N
South Africa <

XIV/

New Zealand

Australia

E

F-60° A 60°

Navareas
9. Press the [Enter] key to close the navarea entry window.

Note: “Fixed Area” is where you enter fixed areas (max. 3) for chart
correction service. However, this service is not yet available; enter no
data.
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10.Press the [{] key to choose Station Code.
11. Press the [Enter] key to open the station code entry window.

Setup

EGC Setup

Receive EGC Area
Additional Position el e
Navarea e e e e e
FixedAtea
Waypoint (from NAV Equipment)  OFF

NAVTEX

|

Type of Messag
Ice reports OFF OMEGA messages  OFF
Meteo. forecasts  OFF SATNAV messages OFF
Pilot service OFF Other navaid msg OFF
DECCA messages OFF QRU (nomessage)  OFF

LORAN messages OFF

EGC setup menu, station code entry window
12.Enter the navtex station code (A-Z) of the navarea, in upper case alphabet.
For details about navtex stations, consult the operator’s manual of the navtex
receiver.
13.Press the [Enter] key to close the station code entry window.
14. Choose message type to receive:
a) Press the [{] or [T] key to choose message type.
b) Press the [Enter] key.
c) Press the [{] or [T] key to choose ON or OFF as appropriate.
d) Repeat a) thru c) to set other message types.
e) Press the [Enter] key.
Note: Navtex messages “Coastal navigational information”, “Meteorological
warning” and “Search and rescue alert” (they do not appear on the
EGC Setup menu) must always be received.

15.Press the [Esc] key to open the update window.

Receive EGC Area
Additional Position —mleem e lee-
Navarea e mm e e e e e -
FixedArema e
Waypoint (from NAV Equipment)  OFF

NAVTEX
Station Code
Type of Message (Can't reject other report)
|ce reports OFF OMEGA messag
Meteo. forecasts ~ OFF SATNAV m Update
Pilot service OFF Other navaidmsg|- - - - - - - - -
DECCA messages OFF QRU (no messag I No

LORAN messages OFF

EGC setup menu, update window

16.Yes is selected; press the [Enter] key to update EGC settings.
17.Press the [Esc] key to return to the standby display.
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2.4.3 Adding EGC channels

The EGC Channel List stores EGC channels. There are currently four EGC
channels, one for each satellite. These four channels are pre-programmed into
the unit and marked in the EGC Channel List with asterisks. When more EGC
channels become available you can add them to the list as below.

1. Press the [F8] key to display the Setup menu.
2. Press the [8] key to display the Configuration menu.
3. Press the [3] key to display the EGC Channel List.

File Edit Transmit EGC Reports Logs Options Position  StopAlarm

Setup |
Configuration
EGC Channel List

EGC channel list

4. Using the arrow keys, place the cursor where there is no data entered.
Current EGC channels are marked with an asterisk. These channels cannot
be changed.
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5. Press the [Enter] key to open the EGC channel list entry screen.

Setup
Configuration

EGC Channdl List

ENTER: Set ESC: Quit
————— e

11080*  12580* | 10840* | 11088*

EGC channel list entry screen
6. Enter EGC channel frequency code. The EGC channel frequency code range

is 6000-14000.

~

Press the [Enter] key to close the text window.

8. Press the [Esc] key to open the update window.

Setup

Configuration

11080* | 12580* |
| |

EGC Channel List

ENTER: set ESC: quit
----- R +

Update
| No

EGC channel list, update window
9. Yes is selected; press the [Enter] key to register input.

Note: If the EGC channel frequency code entered is invalid, the message "Input
Error: Channel No." appears. Clear the error message by pressing the
[Esc] key. Place the cursor at the invalid frequency, press the [Enter] key

and enter correct frequency.

10.Press the [Esc] key twice to return to the standby display.

2-14



2. SYSTEM INITIALIZATION

24.4 Saving, printing EGC messages automatically

You may choose the EGC messages to save and print as follows:

Automatically saving EGC messages

1. Press the [F8] key to display the Setup menu.
2. Press the [5] key to display the Auto Mode Setup menu.

Auto Mode Setup
Auto Log Print OFF
Receive Alarm OFF

Auto Receive Message Save OFF
Auto Receive Message Print OFF
Data Report & Polling Print OFF
Auto EGC Message Save
Auto EGC Message Print

Auto EGC message save menu

3. Press the [{] or [T] key to choose Auto EGC Message Save and then press
the [Enter] key.

Auto Mode Setup
Auto EGC Message Save
OFF
FleetNET OFF
SafetyNET (Routine) OFF
SafetyNET (Sefety) OFF
SafetyNET (Urgent & Distress) ON

Auto EGC message print menu
4. Press the [{] or [T] key to choose message type and then press the [Enter]
key.
5. Choose ON or OFF as appropriate and press the [Enter] key to close the
window.
6. Press the [Esc] key three times to return to the standby display.
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Automatically printing EGC messages

1. Press the [F8] key to display the Setup menu.

2. Press the [5] key to display the Auto mode setup menu.

3. Press the [{] key to choose Auto EGC Message Print and then press the
[Enter] key.

Auto Mode Setup

Auto EGC Message Print
OFF
FleetNET OFF
SafetyNET (Routine) OFF
SafetyNET (Safety) OFF
SafetyNET (Urgent & Distress) OFF

Auto EGC message print menu
4. Press the [{] or [T] key to choose message type and then press the [Enter]
key.
5. Choose ON or OFF as appropriate and press the [Enter] key to close the
window.
6. Press the [Esc] key three times to return to the standby display.
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2.5

Adding NCS Channels

This section shows you how to add NCS channels to the NCS Channel List. 19
channels can be listed per each ocean region. Currently, there are four NCS
channels, and they are marked with asterisks in the list. Add NCS channels to
the list as below when they become operational.

2. SYSTEM INITIALIZATION

1. Press the [F8] key to display the Setup menu.

2. Press the [8] key to display the Configuration menu.

3. Press the [4] key to display the NCS Channel List.

o~

7.
8.
9.
10.Enter NCS channel frequency code. The frequency code range is

Setu

p

Configuration

NCS Channdl List

_—_ - - -
No | AOR

I 1D
-_—_—]= - = -

1 [

_____ _‘ —_— o — — + —_——— e — — o — —
(WEST) | AOR (EAST) | POR
FREQ | ID FREQ I ID  FREQ
_____ _‘ —_— o — — + —_——— e — — o — —
11080* | 144 | 12580* | 244 | 12580*
11 | | 2 |
1 | | 2 |
1 | | 2 |
1 | | 2 |
|1 | | 2 |
11 | | 2 |
|1 | | 2 |

IOR
1D FREQ
344 | 10840*

Press the [Enter] key to open the data entry window.

NCS channel list
Use the arrow keys to place the cursor in a blank ID column.

Enter NCS channel ID number, in two digits. (Entry of leading zero is not

necessary.) The ID n

umber range is 45-63.

Press the [Enter] key to close the window.
With the [—] key, choose the frequency column.
Press the [Enter] key to open the frequency entry window.

6000-14000.

11. Press the [Enter] key to close the window.
12.Press the [Esc] key to open the update window.

Setup
Configuration
NCS Channel List
___| _________ _‘ _________
No | AOR (WEST) | AOR (EAST)
| 1D FREQ 1| ID FREQ 1| ID
e Bl
11 044 | 11080* | 144 | 12580* | 244
210 1 111 2
L | 310 | 11 1 2
410 | 11 1 2
510 1 11 1 2
610 1 11 1 2
710 | 11 2
810 1 11 2

ENTER: Set ESC: Quit

| 12580*
I

+ b
| |
| |
______________ B i i et
| |
| |
| |
|
|
|
|
|

NCS channel list, update window
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13.Yes is selected; press the [Enter] key to register input.

Note: If the ID or frequency entered is invalid the message "Input Error: NCS
ID" (for invalid ID) or "Input Error: Channel No." (for invalid frequency)
appears. Clear the error message by pressing the [Esc] key. Place the
cursor at the invalid ID or frequency code. Then, press the [Enter] key
and enter correct ID or frequency.

14.Press the [Esc] key twice to return to the standby display.
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2.6

2.6.1

2. SYSTEM INITIALIZATION

LES List

The LES List provides for storage of 44 LES names per ocean region. By
entering approximate toll charges in the LES list, you can see that information on
the Transmit message menu.

Setting toll charges

Main LES (LES name and ID) are already registered in the FELCOM 16; but, toll
charges are not set. To set communication toll charges do the following:

1. Press the [F8] key to display the Setup menu

File Edit Transmit EGC  Reports Logs Options Position StopAlarm

Setup

2. Editor Setup

3. Termina Setup
4. EGC Setup

5. Auto Mode Setup
6. E-Mail Setup

7. Directories

8. Configuration

Setup menu
2. Press the [8] key to display the Configuration menu.

Setup |
Configuration

2.LESList

3. EGC Channdl List

4. NCS Channel List

5. E-Mail/SM S Service List
6. Save/Load

O. DITECIOITES

9. Configuration

Configuration menu
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3. Press the [2] key to display the LES List.

LESList
Ctrl+P: Print ENTER: List Entry ESC: Quit
B e il e B [ e
No | AOR(WEST) | AOR(EAST) | POR | IOR
| Name | Name | Name | Name
el o === - - - == B e
01 | QEEIESSI | Telenor S.S.Inc | Telenor S.S.Inc |
02 | StratosM.N. | Stratos M.N. | Stratos M.N. | Stratos M.N.
|| 03 I KDDI | KDDI | KDDI | KDDI
04 | Telenor SSAS | Telenor SSAS | Telenor SSAS | Telenor SSAS
05 | | Telecom Italia | I OTE
06 | | | I VSNL
07 1 | | |
08 | | | Korea Telecom | Korea Telecom
LES list

4. Using the arrow keys, choose the LES for which you want to enter toll
charges. For example, choose KDDI (Japan).
5. Press the [Enter] key.

Setup |
Configuration —
LESList
Ctrl+P: Print ENTER: List Entry ESC: Quit
———————————— D i B e i
AOR(WEST) | AOR(EAST) | POR | IOR
Name I Name I Name I Name
———————————— R T B e S
Telenor S.S.INC g —— = o
Stratos M.N. | Stratos M.N.
KDDI D +005 J <DDI
Telenor SSAS Remarks : , | Telenor SSNS
Charge (US$/256hit) | OTE
TELEX *****.** I VSNL
FAX *****.** |
E-Mail *xems. | Korea Telecom
S'\/IS *****.**
PSDN *****.**
X4OO *****.**

DNID *****.**
SPEC *****.**

Erase the Name to delete this LES.

LES list, LES data entry window
6. Press the [{] key to choose TELEX and press the [Enter] key to open the text
entry window.
7. Enter telex charges (per 256 bit) and press the [Enter] key.
For toll charges, contact appropriate LES.
8. Enter toll charges for other items similarly.
9. Press the [Esc] key to return to the LES list.
10.Press the [Esc] key three times to return to the standby display.
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2.6.2 Registering LES to LES list

Follow the procedure below to register newly constructed LESs.

1. Press the [F8], [8] and [2] keys to show the LES list.

2. Use the arrow keys to place the cursor where desired. For example, choose

005 in the AOR(WEST) column.

Setup |
Configuration
] LESList
Ctrl+P: Print ENTER: List Entry ESC: Quit
———————————— e B it
AOR(WEST) | AOR(EAST) | POR [ IOR
Name I Name I Name I Name
———————————— R it B e
Telenor S.S.Inc | Telenor S.S.Inc | Telenor S.S.Inc |
Stratos M.N. | Stratos M.N. | Stratos M.N. | Stratos M.N.
KDDI | KDDI | KDDI | KDDI
Telenor SSAS | Telenor SSAS | Telenor SSAS | Telenor SS.AS
_ | Telecom ltdia | Tdenor SSAS | OTE
| | | VSNL
I I I
| | Korea Telecom | KoreaTelecom
[
Place cursor here.
LES ID: XXX
i £ No. (00-43)
0: AOR(WEST)
1. AOR(EAST)
2: POR
3:I0R
Configuration menu
3. Press the [Enter] key.
Setup |
Configuration —
LESList
Ctrl+P: Print ENTER: List Entry ESC: Quit
———————————— e e At e
AOR(WEST) | AOR(EAST) | POR [ IOR
Name I Name I Name I Name
———————————— I B it SR
Telenor SS.Inc — = —— =t o
Stratos M.N. Name g | Stratos M.N.
KODI ID $005 J < DD
Telenor SSAS Remarks , | Telenor SSNS
Charge (US$/256hit) | OTE
TELEX *****.** | VS'\“_
FAX *****.** |
E-Mai] oo xx | Korea Telecom
SMS ’k****.**

PSDN *****.**
X4OO *****.**
DNID *****.**
SPEC *****'**

Erase the Name to delete this LES.

LES list options
4. Name is selected; press the [Enter] key to open the text entry window.
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2.6.3

2-22

© 00N O

“ame J

ID

Remarks :

Charge (US$/256hit)
TELEX *****.**
FAX *****.**
E_Mall *****.**
SMS *****.**
PSDN *****.**
X4OO *****.**
DNID *****.**
SPEC *****.**

Erase the Name to delete this LES.

LES list, text entry window
Enter LES name (maximum 15 characters).
Press the [Enter] key.
Press the [{] key twice to choose Remarks.
Press the [Enter] key.
Enter remarks (up to 20 characters).

10.Press the [Enter] key.

11. Press the [{] key to choose TELEX and press the [Enter] key.
12.Enter TELEX toll charges (per 256 bit) and press the [Enter] key.
13. Enter toll charges for other items similarly.

14.Press the [Esc] key to return to the LES list.

15.Repeat steps 2-14 to enter another LES.

16.Press the [Esc] key three times to return to the standby display.

Editing the LES list
1.

2.
3.
4. Do the following:

o

Press the [F8], [8] and [2] keys to shown the LES list.
Use the arrow keys to choose the LES you want to edit.
Press the [Enter] key.

Change station name: Press the [{] or [1] key to choose Name and then
press the [Enter] key. Press the [Backspace] key to erase name and then
enter new name. Press the [Enter] key.

Delete station: Press the [{] or [T] key to choose Name and then press the
[Enter] key. Press the [Backspace] key to erase name and then press the
[Enter] key.

Press the [Esc] key to quit.

Press the [Esc] key three times to return to the standby display.



2.6.4

Printing the LES list

2. SYSTEM INITIALIZATION

1. Press [F8], [8] and [2] to display the LES list.

2. To print the LES list, press the [P] key while pressing the [Ctrl] key.

No. Name

01 Telenor S.S.Inc
02 StratosM.N.

03 KDDI

04 Telenor SS.AS
12 Xantic (NED)
21 France Telecom
22 Xantic (AUS)

No. Name
01 Telenor S.S.Inc

3. To return to the standby display, press the [Esc] key three times.

LESList ( Printed at 02-02-25 02:33)

+++++ AOR (WEST) ++++

LESID
001
002
003
004
012
021
022

+++++ AOR (EAST) +++++

LESID
101

Remarks

USA

CANADA
JAPAN
NORWAY
NETHERLANDS
FRANCE
AUSTRALIA

Remarks
USA

Sample LES list printout
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2.7
2.7.1

2-24

Station List

Adding stations to the station list

The FELCOM 16 provides an “address book” for storing 64 station I1Ds. Enter
station IDs as below.

1. Press the [F8] key to display the Setup menu.
2. Press the [8] key to display the Configuration menu.
3. Press the [1] key to display the Station List.

File Edit Transmit EGC Reports Logs Options RSzt Position StopAlarm

Setup |
Configuration —|
Station List
Group StationName  Type  Code D / Address
abc@ furuno.co.jp
02 Xyz E-Mall  xyz@ furuno.co.|p
03 Seagull TELEX 584 463609999
04
05
L—| 06
o7
08
‘PageUp, Page Down: Move Cirl+P: Print
Sort (Ctrl+G: Group, Ctrl+N: Station Name, Ctrl+T: Type)

Sample station list

4. Operate the [{] key to place the cursor on a blank line.
5. Press the [Enter] key.

Station Name

Destination Type TELEX
Prefix Code

Country Code

Station ID

Modem Type

Address

Remarks

Erase the Name to delete this station.

Station list items

6. Press the [Enter] key to open the station group entry window.
7. Enter station group name, using up to five characters.

8. Press the [Enter] key to close the window.

9. Press the [|] key to choose Station Name.

10.Press the [Enter] key to open the station name entry window.
11. Enter station name, using up to 15 characters.

12.Press the [Enter] key to close the window.

13.Press the [|] key to choose Destination Type.

14.Press the [Enter] key to open the destination type window.
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TELEX

FAX
E-Mail
SMS
PSDN
X400
DNID
SPEC
TELEX (Prefixed)
FAX  (Prefixed)
PSDN  (Prefixed)
X400  (Prefixed)
DNID  (Prefixed)
SPEC  (Prefixed)

Destination (communication) type options

TELEX: Telex communication

FAX:  Facsimile service

E-Mail: E-mail (electronic mail) Service
SMS:  Short Message Service

PSDN: Packet Switched Data Network
- to an office computer via a data network using X.25 standard.

X400: For future use
DNID: Data Network ID. See page 5-12.

SPEC: Ship-to shore requests for safety service, accessed by using special
code numbers

15. Press the [{] or [1] key to choose destination type desired.
16. Press the [Enter] key to close the window. Follow appropriate procedure on

the next several pages.

Procedure for Telex

1.
2.
3.

No ok

8.
9.

Press the [{] key to choose Country Code.

Press the [Enter] key.

For ship-to-shore telex, enter international telex country code; ship-to-ship
telex, enter ocean region. A list of international telex country codes appears
in the Appendix.

Ocean Region

AOR-East: 581 POR: 582

IOR: 583 AOR-West: 584

Press the [Enter] key.

Press the [{] key to choose Station ID.

Press the [Enter] key to open the station ID entry window.

Enter telex subscriber number (for ship-to-shore) or MES Inmarsat Mobile
Number (for ship-to-ship). Up to 15 characters, including space, can be
entered.

Press the [Enter] key to close the window.

Press the [{] key to choose Remarks.

10.Press [Enter] to open the remarks entry window.
11. Enter remarks, using up to 20 characters.
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2-26

12.Press the [Enter] key to close the window.
13.Press the [Esc] key to return to the station list.

14.

To enter another “Telex” station repeat the procedure from step 4 on page
2-24.

15.Press the [Esc] key three times to return to the standby display.

Procedure for FAX

11.

12.
13.
14.
15.
16.
17.
18.

19.

Press the [{] key to choose Country Code.

Press the [Enter] key to open the country code entry window.

Enter international telephone code of subscriber. See the Appendix for list of
telephone codes.

Press the [Enter] key to close the window.

Press the [{] key to Station ID.

Press the [Enter] key to open the station ID entry window.

Enter fax number.

Press the [Enter] key to close the window.

Press the [{] key to choose Modem Type.

. Press the [Enter] key to open the modem type options window.

Modem Type

V21 V.21 300bps Duplex
V22 V.22 1200bps Duplex
V22B  V.22bis 2400bps Duplex
V23 V.23 600/1200bps
V26B  V.26his 2400/1200bps
V26T V.26ter 2400bps Duplex
V27T  V.27ter  4800/2400bps
V32 V.32 9600bps Duplex
Other

Modem type options window

Press the [{] or [T] key to choose mode type of subscriber. For a landline fax
or a fax-equipped Inmarsat B MES, choose “T30 FAX.”

Press the [Enter] key to close the window.

Press the [{] to choose Remarks.

Press the [Enter] key.

Enter remarks, using up to 20 characters.

Press the [Enter] key to close the window.

Press the [Esc] key to return to the station list.

To enter another “Fax” station repeat the procedure from step 4 on page
2-24.

Press the [Esc] key three times to return to the standby display.
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Procedure for E-mail

Press the [{] key to choose Address.

Press the [Enter] key to open the e-mail address entry window.

Enter recipient’s e-mail address.

Press the [Enter] key to close the window.

Press the [{] to choose Remarks.

Press the [Enter] key.

Enter remarks, using up to 20 characters.

Press the [Enter] key to close the window.

Press the [Esc] key to return to the station list.

10 To enter another “E-mail” station repeat the procedure from step 4 on page
2-24.

11. Press the [Esc] key three times to return to the standby display.

©CoNoOah~wDdRE
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2.7.2

2-28

Editing the station list
1. Press[F8], [8] and [1] to display the Station List.

File Edit Transmit EGC Reports Logs Options

Setup

Position  StopAlarm

Setup |

Configuration —|

Station List

Group Station Name  Type  Code ID / Address
01 abc E-Mail abc@ furuno.co.jp
02 Xyz E-Mall  xyz@ furuno.co.|p
03 Seagull TELEX 584 463609999
04
05
L—| 06
07
08
Page Up, Page Down: Move Ctrl+P: Print
Sort (Ctrl+G: Group, Ctrl+N: Station Name, Ctrl+T: Type)

Station list

Note: You may sort the list by group name, station name or communication

type as follows:

Group name: Each press of [Ctrl] + [G] sorts the list by group name,

ascending or descending order.

Station name: Each press of [Ctrl] + [N] sorts the list by station name,

in ascending or descending order.

Comm. type: Each press of [Ctrl] + [T] sorts the list by communication

type, in ascending or descending order.

N

3. Do one of the following:

Change station name: Press the [{] or [T] key to choose Station Name and
then press the [Enter] key. Press the [Backspace] key to erase station name

and then enter new data. Press the [Enter] key.

Press the [{] or [T] key to choose a station and then press the [Enter] key.

Delete station: Press the [{] or [T] key to choose Station Name and then

press the [Enter] key. Press the [Backspace] key to erase station name and

then press the [Enter] key.

»

Press the [Esc] key to save changes.

5. Press the [Esc] key three times to return to the standby display.
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2.7.3 Printing the station list

1. Press [F8], [8] and [1] to display the Station List.
2. press the [P] key while pressing the [Ctrl] key.

Station List ( Printed at 02-02-25 02:38)

No. Group Name Type Dedt, ID, Modem / Address Remarks
01 x1 abc E-Mail abc@ furuno.co.jp
02 x2 Xyz E-Mail xyz@ furuno.co.jp

03 x3 Seagull TELEX 584 463609999
Station Name k\* Subscriber's Number
Group Name Country Code

Sample station list printout
3. Press the [Esc] key three times to return to the standby display.
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2.8  Entering Own Ship’s Position

When the internal GPS navigator is abnormal, manually enter position as below.

1. Press the [F9] key to display the Position menu.

File Edit Transmit EGC  Reports Logs Options Setup StopAlarm

Ship Position
34:30.00N

LON 135:30.00E

Ship position window
2. Press the [Enter] key to open the latitude entry window.

Ship Position
E4:30.00N
LON

Latitude entry window
3. Enter latitude (XX° XX) and then press the [N] or [S] key as appropriate to
enter coordinate.
Press the [Enter] key to close the window.
Press the [{] key to choose LON.
6. Press the [Enter] key to open the longitude entry window.

o~

Ship Position

LAT
035:30.00E

Longitude entry window
7. Enter longitude (XXX° XX) and then press the [E] or [W] key as appropriate
to enter coordinate.
8. Press the [Enter] key to close the window.
9. Press the [Esc] key to open the update window.

File Edit Transmit EGC  Reports Logs Options Setup StopAlarm

Ship Position
LAT 34:50.00N
L Update 00E

Ship position, update
10.Yes is selected; press the [Enter] key to update position and close the Ship
Position menu. The position entered appears at the bottom right corner of the
system status monitor screen.
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2.9 Creating A Directory

Incoming and outgoing messages may be saved to the hard disk. If no directory
is specified, all messages are saved to the My Documents folder (in Windows
Vista, messages are saved to the Felcom16 folder in Documents).

2.9.1 Creating a directory where to store messages

The procedure below shows how to create a directory on the root directory in the
hard disk.

1. Press the [F8] key to display the Setup menu.
2. Press the [7] key to display the Directories menu.

Directories

M essage Directory

EGC Message Directory

Directories menu
3. Press the [T] key to choose Message Directory and then press the [Enter]
key.

File Edit Transmit EGC Reports Logs Options Setup Position StopAlarm

Setup i Display will vary with computer
- M Directory ———————— 114 05 type
[Settings\xxxx\MyDocuments\FELCOM16\ ¢——}——
- - Filename - - - Size - - - Date & Time - - - - - -
.. <DIR> 11
EGC <DIR> 11

3 Files exist 1456640 bytes free

To View: SPACE Make Dir: INS  Remove Dir: DEL

Setup menu, message directory (Windows XP)
4. Press the [Insert] key.

Make Directory
L

Directory name entry window
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5. Enter directory name and press the [Enter] key. Entered name appears.

Root directory
(Top of hard disk hierarchy)
Setup

Message Directory

[Setting\xxxx\MyDocuments\FELCOM16\ABC\ ]
- - Filename - - - Size - - - Date & Tim¢ - ---- -

. <DIR>  2002-02-28 20:54
- <DIR>  2002-02-15 02:13

Directory Name

Message Directory (Windows XP)

Note 1: To create a directory within a directory at step 5, repeat steps 4 and
5.
Note 2: To return to the above stage, place the cursor on [«¢] and then
press the [Enter] key.
6. Press the [Esc] key to show the Update window.
Yes is selected; press the [Enter] key.
8. Press the [Esc] key twice to return to the standby display. Then, received
messages (transmitted messages) are saved to the directory created above.

~

Note 1:To remove a directory, do steps 1-3 in the above procedure, choose the
directory to remove and then press the [Delete] key.

Note 2: A directory for EGC messages can also be made as above. In this case
choose EGC Message Directory at step 3.
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2.9.2 Specifying directory where to store messages

You may specify the directory where to store messages on the hard disk as
follows:

1. Press the [F8] and [7] keys to show the Directories menu.
2. Press the [T] key to choose Message Directory and press the [Enter] key.

Root Directory
(Top of hard disk hierarchy)

Setup

M,

ge Directory
[Setting\xxxx\MyDocuments\FELCOM16\ABC\ 1
- - Filename } - - Size - - - Date & Time - - - - - r
<DIR>  2002-02-28 20:54

D e <DIR>  2002-02-15 02:13

Directory Name

Message directory

Press the [{] key to place the cursor on [ee].

Press the [Enter] key. Root directory is displayed.

Press the [{] or [T] key to choose a directory.

Press the [Enter] key.

Pres the [Esc] key to show the Update window.

Yes is selected; press the [Enter] key.

Press the [Esc] key twice to return to the standby display.

©ooNO Ok

Note: The directory where to store EGC messages can also be created as
above. Choose EGC Message Directory at step 2 in the above procedure.
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2.10 E-mail Service/SMS Station List

E-mail service providers and SMS stations are already registered in the
FELCOM 16. To add new e-mail service providers or SMS stations, follow the
procedure below.

1. Press the [F8] key to display the Setup menu.

2. Press the [8] key to display the Configuration menu.
Setup |

Configuration

2. LESList

3. EGC Channel List

4, NCS Channdl List

5. E-Mail/SMS Service List
6. Save/load

O. DITECIOITES

9. Configuration

Setup menu, configuration
3. Press the [5] key to display the E-mail/SMS Service List.

Setup |

Configuration —— ) )
E-Mail/SMS Service List
I

|
i LES Name IAORW|AORE |POR |IOR
e T T T T T T T T T T T T T T T T T T~ "
Telenor S.S.Inc 001 101 201 321
| Xantic (NED) | 012 (112 (212 | 312
| Stratos M.N. | 002 (102 |202 |302
d 04 | Telenor SSAS | 004 (104 | | 304
d 05 | KDDI | 003 |103 |203 | 303
L1 06 | SingaporeT. | | 210 | 328
07 | France Telecom | 321 321 321 321
08 | Xantic(AUS) i 322 5322 5322 iszz
|

Setup menu, E-Mail/SMS service list
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4. Press the [{] to choose a blank line in the Station Name column and then

press the [Enter] key.

Service ID (E-Malil)
(SM9)

LES ID(AORW)
(AORE)
(POR)
(IOR)

To:

Cc:

Subject:

Separator:

SMS:

Attach File(MIME)

OFF

Enter data for LES which offers e-mail services. For

details contact LES directly.

Example

Enter data of the KDDI LES as follows:

Service LES Name

Service ID (E-Mail)

Service ID (SMS)

LES ID (AORW)
(AORE)
(POR)
(IOR)

To:

Cc:

Subject:

Separator:

SMS:

Attach File(MIME)

KDDI
28

66

004

104

204

304

To:

CC:
Subject:
Blank
Blank
ON(UUENCODE)

E-mail setup items
5. Press the [Enter] key to open the service LES name entry window.

Service LES Name |I

Service ID (E-Mail)
Service ID (SMS)
LESID(AORW)

Attach File(MIME)

OFF

Service station list, service station name entry window

© o ~NOo

Type in LES which provides e-mail service.

Press the [Enter] key to close the window.

Press the [{] key to choose Service ID (E-Mail).

Press the [Enter] key to open the service ID entry window.

10 Enter E-mail Service ID (Special Access) Code.

11. Press the [Enter] key to close the window.

12.Press the [{] key to choose Service ID (SMS).

13.Press the [Enter] key to open the Service ID (SMS) entry window.
14.Enter SMS Service ID (Special Access Code)

15.Press the [Enter] key to close the window.
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16.Press the [{] key to choose LES ID.

17.Press the [Enter] key to open the LES ID entry window.

18.Enter ID of AOR-W.

19.Press the [Enter] key to close the window.

20.Repeat steps 17-19 to enter AOR-East, POR and IOR.

21.Press the [{] key to choose “To:.”

22.Press the [Enter] key to open the “to” header entry window.

23.Type appropriate “To” header (for example, TO:, to+, etc.).

24.Press the [Enter] key to close the “to” header entry window.

25.Press the [{] key to choose “Cc:.”

26.Press the [Enter] key to open the “Cc” header entry window.

27.Type appropriate “Cc” header (for example, CC:, cc+, etc.).

28.Press the [Enter] key to close the “Cc” header entry window.

29.Press the [{] key to choose “Subject:.”

30.Press the [Enter] key to open the subject entry window.

31.Type appropriate Subject header (for example, Subject:, subject+, etc.).

32.Press the [Enter] key to close the window.

33.Press the [{] key to choose “Separator.”

34.Press the [Enter] key to open the separator entry window.

35. Type appropriate Separator (for example, blank space, STX:, etc.).

36.Press the [Enter] key to close the window.

37. Press the [{] key to choose SMS.

38. Press the [Enter] key to open the SMS window.

39.If it is necessary to enter special Prefix “sms+” before telephone number,
enter the keyword now. For example, for Singapore Telecom enter
sms+8190123456789.

40. Press the [Enter] key to close the window.

41. Press the [{] key to choose “Attach File (MIME).”

42.Press the [Enter] key to open the Attach File (MIME) window.

43.Choose ON(BASE64), ON(UUENCODE) or OFF as appropriate.
BASEG64: General text converter
UUENCODE: UNIX text converter

44.Press the [Enter] key to close the window.

45.Press the [Esc] key four times to return to the standby display.
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E-mail Setup
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Choose the LES where to forward e-mail. Also, you may need to register with an

LES which provides e-mail services.

1. Press the [F8] key to display the Setup menu.
2. Press the [6] key to choose E-mail Setup.

— Setu —
P E-Mail Setup

LES Name

01 Telnor S.S.Inc

__________________________ T—————p—————p—————————

| | | |
IAORW|AORE |POR |IOR
T

6. Auto Mode Setup

7. E-Mail Setup

8. Directories
9. Configuration

E-mail setup

3. Press the [Enter] key to open the e-mail station list.

E-Mail Setup
| | |

i LES Name IAOR.W|AORE |POR i IOR
N - T T———77 T 77— "
01 Telenor S.S.Inc 001 101 201 321
02 | Xantic(NED) | 012 (112 (212 312
03 | StratosM.N. | 002 102 |202 302
04 | Teenor SSAS | 004 |104 |204 304
05 | KDDI | 003 }103 {203 303
06 | SingaporeT. I I 1210 | 328
07 | France Telecom 321 |321 321 321
08 | Xantic (AUS) i 322 i322 i322 iazz

|

E-mail station list

4. Press the [{] or [T] key to choose the LES where e-mail is to be sent.

5. Press the [Enter] key.

6. Press the [Esc] key twice to return to the standby display.
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2.12 Saving, Loading System Settings

System settings (as well as messages) may be saved to a selected folder and
loaded onto the terminal unit. This is useful for having backup copies of system
settings.

2.12.1 Saving system settings

1. Press the [F8] key to show the Setup menu, then press the [8] key to open
the Configuration menu.
2. Press the [6] key to choose Save/Load.

— Save/Load —

Save

Load

Save/Load Window
3. Pressthe [t ] to select [Save], then press the [Enter] key.

1ALL

2. Station List

3.LESList

4, E-Mail/SMS Service List
5. Other

Save Window
4. Key in the numeric corresponding to the item you want to save.
ALL: All contents (Distress Alert Setup)
Station List: Station List
LES List: LES List
E-Mail/SMS Service List: E-mail service/SMS service list

Other: Other than Distress Alert Setup menu, Station List, LES List, E-mail
service/SMS service list.

Browse For Folder 3 ilil

Select the Folder that wou want to store your documents in,

Deskiop -
@ My Documents

E, My Compuber

" My Metwork, Places

[

New Folder I OK | Cancel |

7z

[Destination Folder] dialogue box (Windows XP)

5. Select your destination folder and click [OK]. The “OK to save?” dialogue
box appears.

6. Select [YES] and click, or press the [Enter] key, to save chosen system
setting to the selected folder.
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Loading system settings to the terminal unit

1.

w

Press the [F8] key to show the Setup menu, then press the [8] key to open
the Configuration menu.

Press the [6] key to choose Save/Load.

Press the [{] key to choose Load, and press the [Enter] key.

1. ALL

2. Station List

3.LESList

4. E-Mail/SMS Service List
5. Other

Load Window

Press appropriate numeric key to choose the item to load.

Select a destination folder and press the [OK] button. The “OK to load?”
dialogue box appears.

Select [Yes] and press the [Enter] key to load chosen system setting.
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3. FILE OPERATIONS

This chapter describes how to prepare, edit, save and print files (messages).

3.1 Files and Working Areas

To create a new message it is necessary to open a new file. After a new file is
opened, one of two working areas in the internal memory is secured to create
the message. The term “open a file” also refers to the loading of a prepared file
into a working area.

When you remove a file from a working area this is called “closing a file.”

INTERNAL MEMORY

HARD DISK MEMORY FELCOM 16's
TWO WORKING AREAS

Screen

FILE 1 > 1 i——o

No—I|pisplay

[ 5 ]

FILE 2 > 2 O

Can select one

for display.
FILE 3 (Change Window

on Edit menu)

Internal memory
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3.2 Preparing Files

There are two types of files: routine and confidential. Files can be assigned a file
name and saved to the hard disk for later use. A message may contain
maximum 32 Kbytes of characters.

3.2.1 Preparing a routine file
1. Press the [F1] key to display the File menu.

Edit Transmit EGC Reports Logs Options Setup Position StopAlarm

File
1. New ALT-N
2.0pen  ALT-O
3. Close ALT-Q
4. Save ALT-S

9. MIME (Decode)

File menu

2. Press the [1] key to choose New. The display should now look something like
the illustration below.

=] Edit Transmit EGC Reports Logs Options Setup Position StopAlarm
<[1] UNTITLED1>
ooo1|
Cursor can be a square or an underline.
[ S B + + + + ——<
TELEX 1 Char. [ Line i) 1 Cal. 1] [Insert ]

Text editor screen

Note: When two working areas are opened and you try to open a third file,
the message “Save this message” appears. When this occurs close an
open file to free a working area.

w

The cursor is on the first line. Type your message.
4. To transmit the message you have just prepared, go to paragraph 4.1.2. To
save it to the hard disk, for future transmission, go to paragraph 3.3.
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3.2.2 Preparing a confidential file

If communicating with another FURUNO FELCOM, you can prepare a
confidential message by entering “S???-addressee code(-password):” in the first
line of the message text. You can also receive confidential messages containing
this header from a land subscriber or any MES.

There are two types of confidential messages: message with addressee code
and message with both addressee code and password.

When the FELCOM 16 receives a confidential message, the message is neither
displayed nor printed immediately. To display or print the contents of a
confidential message, the recipient executes the procedure shown in paragraph
4.2.3.

Addressee code and password

Caller and recipient agree beforehand on both the addressee code and the
password. The addressee code might be the title of the recipient; for example,
CAPTAIN. The password could be the classification of the message; for example,
SECRET.

Preparing message with addressee code

Type the addressee code as shown in the illustration below and then type the
text of message.

|— Be sure to enter colon.

S??7?-addressee code:¢ (text of message)

T— maximum 8 characters

Addressee code

Preparing message with both addressee code and password

Type the addressee code and password as shown in the illustration below and
then type the text of message.

Be sure to enter colon.

Y
S??7?-addressee code-password:  (text of message)

T T maximum 8 characters

Addressee code and password

When the recipient receives a message with both addressee code and password,
he must enter the password to view contents of the message.
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3.2.3 Editor menu setup

The Editor menu sets the parameters of the text editor.

1. Press the [F8] key to display the Setup menu.
2. Press the [2] key to display the Editor Setup menu.

File Edit Transmit EGC Reports Logs Options Position  StopAlarm

Setup |
Editor Setup

Ascii

Edit Mode Insert

Word Wrap ON

Line No. ON

Tab Width 4 Char

Column Width 69

Cursor Type  Block

Scroll Full Screen

Editor setup menu

3. The illustration above shows the default editor setup settings. To change

settings:

a)Press the [|] or [T] key to choose item.

b)Press the [Enter] key to open corresponding options window.
c)Press the [|] or [T] key to choose setting.

d)Press the [Enter] key to register setting.

e)Press the [Esc] key twice to return to the standby display.

Text Mode:

Edit Mode:

Word Wrap:
Line No.:

Tab Width:

Column Width:

Cursor Type:
Scroll:

3-4

Choose “Telex” when creating a telex message. Only upper
case alphabet is permitted in telex. Use “ASCII” when
creating an e-mail message. Upper and lower case alphabet
may be used in an e-mail.

Choose “Insert” (insert character at cursor location) or
“Overwrite” (write over character at cursor location).

Turns on/off automatic hyphenation at the end of a line.
Turns line number display on or off.

Sets horizontal tab width; two, four or eight tabs per line.

Choose “69” for Telex or “40 to 80" for ASCII.
Chooses cursor configuration, “l* or underline.

Sets how much the screen moves up over the page (Full
Screen or Half Screen) when [PgUp] or [PgDn] key is
operated.
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Edit Transmit EGC  Reports Logs Options Setup Posirion StopAlarm

<[1] UNTITLED1>

0001

™

Cursor can be a square or an underline.

Line Number
Displayed if Line No. is turned on in
Editor Setup menu.

Text editor screen

3.2.4  Working with text

Cutting and pasting text

1. Use the arrow keys to place the cursor on the first character
cut.

of the text to be

2. Highlight the text to be cut by pressing the [—] key while pressing and
holding the [Shift] key. You can use the [«] or [—] key to adjust the highlight.

The figure below shows the appearance of highlighted text.

<[1] UNTITLED1>

0001/WE ARE CONFIDENT THAT YOU WILL ENJOY MANY YEARS OF OPERATION WITH

(002N INMARSAT STANDARD C MOBILE EARTH STATION CONGRATULATIONS§
0003[CONGRATULATIONS ON YOUR CHOICE OF FURUNO FELCOM &
S N N — S S S S S R S S <

<— Highlight

TELEX 173Char. [ Line 2/ 3 Col. 55] [Insert ]

Appearance of highlighted text
3. Press the [F2] key to choose the Edit menu.

Edit
2. Copy ALT-C
3. Paste INS
4. Insert (With Citation)
5. Select All ALT-A
6. Search or Replace
7. Goto Line
8. Timeor Pos. Ins
9. Change Window ALT-V

Edit menu

4. Press the [1] key to choose Cut. The highlighted text is cut and the remaining
text is reformatted. If a mistake is made, you can immediately restore the text

by pressing the [Insert] key.



3. FILE OPERATIONS

5. To move text to a new location after it has been cut, place the cursor at the
exact spot in the message where the cut text is to start. When the text cursor
is placed correctly, press the [F2] key and then the [3] (Paste) key.

Copying and pasting text

1. Choose the text you want to copy.
<[1] UNTITLED1>

0001| THE FURUNO FELCOM INMARSAT STANDARD C MOBILE EARTH STATION, A
O0OO2ISATELLITE COMMUNICATIONS [GIN[ml PACKAGE FOR VIRTUALLY EVERY VESSEL.Z

S oo oo o S oo oo <
TELEX 131 Char. [ Line 2/ 2 Col. 66] [Insert ]

Appearance of highlighted text

2. Press the [F2] key to display the Edit menu.
3. Press the [2] key to choose Copy. The text selected is copied to the

clipboard.
4. Place the cursor at the exact spot on the message where the copied text is to
start.
<[1] UNTITLED1>
0001|THE FURUNO FELCOM INMARSAT STANDARD C MOBILE EARTH STATION, A
0002|SATELLITE COMMUNICATIONS UNIT PACKAGE FOR VIRTUALLY EVERY VESSEL.
0003
Cursor
ek m e R o B R o o o <
TELEX 131Char. [ Line 2/ 2 Col. 66] [Insert ]

Cursor selects location where to paste text
5. Press the [F2] key followed by the [3] key. The text is placed at the cursor

location.
<[1] UNTITLED1>
0001/ THE FURUNO FELCOM INMARSAT STANDARD C MOBILE EARTH STATION, A
0002|SATELLITE COMMUNICATIONS UNIT PACKAGE FOR VIRTUALLY EVERY VESSEL.
0003|UNIT &
ek e S Fom e R Fom e S U Fommmmmmem <
TELEX 137Char. [ Line 3 3 Col. 5] [Insert ]

Text pasted at cursor location
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Insert (with Citation)

When you reply to a received message, you can insert the received message.
“>" is placed at the head of the received message to distinguish it from your
message.

Select All

Chooses the entire current file for cut and copy.

Search and Replace

Searching text

The Search feature lets you search for text in a forward or backward direction.

1. Atthe Edit menu, press the [6] key to choose “6 Search or Replace.”

—— Search or Replace

1. Search Alt-F

2. Replace Alt-R

Search and replace menu
2. Press the [1] key to choose “1. Search.”

Search

Search Word

Direction Forward

Search window
3. Search Word is selected; press the [Enter] key to show the search word entry
window.
4. Type the word to find and press the [Enter] key.
5. Press the [|] key to choose Direction and press the [Enter] key.

————— Search
Search Word
Forward
o]

Direction window
6. Press the [|] or [1] key to choose direction to search from the cursor location;
Forward or Back and press the [Enter] key.
7. Press the [Esc] key.

Search Start?
e
| No

Search start window
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8.

9.

Yes is selected; press the [Enter] key.

When the unit finds the word, the cursor stops at the first character of the
word. If the string could not be found, the message “Not Found (To Quit:
ESC)” appears. Press the [Esc] key to quit.

To continue the search, press the [Enter] key.

IReplacing text

The Replace feature helps you replace every occurrence of a word or phase with
another word or phase in a file.

1.

w

No oA

At the Edit menu, press the [6] key to choose “6 Search or Replace.”

—— Search or Replace

1. Search Alt-F
2. Replace Alt-R

Search and replace menu
Press the [2] key to choose “2. Replace.”

—— Replace
Replace Word

Direction Forward
Query or ALL Query

Replace menu

Search Word is selected; press the [Enter] key to open the search word entry
window.

Enter search word and then press the [Enter] key.

Press the [{] key to choose Replace Word and press the [Enter] key.

Enter replace word and then press the [Enter] key.

Press the [{] key to choose Direction and then press the [Enter] key.

Replace

SearchWord ABC
Replace Word 123

o]
Forward

Query or ALL Back

Replace menu, direction menu

Press the [|] or [1] key to choose direction to search from the cursor location
and press the [Enter] key.
Press the [{] key to choose Query or All and then press the [Enter] key.

—— Replace
SearchWord ABC
Replace Word 123

Direction

All

Replace menu, query or all
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10. Press the [|] or [1] key to choose Query or All.
Query: Stop at each occurrence of word to answer yes or no to
replacement.
All: Replace every occurrence of word without stopping to confirm.

11. Press the [Esc] key. The following display appears.

Replace Start?
R
| No

Replace start window
12. Yes is selected; press the [Enter] key to start the replacement. If you selected
“All” at step 10 all occurrences of the search word are replaced with the
replace word. If the string could not be found, the message “Not Found (To
quit: ESC)” appears. Press the [Esc] key to quit.

If you selected “Query” at step 10, the message below appears when the
search word is found. Press the [Enter] key to replace the word, or hit the
Space bar to go to the next occurrence of the search word.

Replace OK? (OK: ENTER Pass: SPACE To quit: ESC)

Go to line

Moves the cursor to the desired line in the current file.

Goto Line

1.Topof Text HOME

2. End of Text END
3. Goto Line

Goto line options

1. Top of text: Go to top of text
2. End of text: Go to end of text
3. Go to line: Specify line number to go to

Time or Pos. Ins

Inserts time or position in a sentence.

1. Atthe Edit menu, press the [8] key to choose “8. Time or Pos. Ins.”

—— Timeor Pos. Ins.

2. Position

Time or position insert options
2. Press the [1] key to insert time; [2] key to insert position at the cursor
position.
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3.3 Saving Files

After you have created a message you may wish to save it to the hard disk, for

future use.

You can save a message two ways: Save it without losing your place on the
screen (called “save”), or save it before clearing the screen (called “close”).

3.3.1 Save file, retain place on screen

1. Press the [F1] key to display the File menu.
2. Press the [4] key. The screen should look something like the one below.

line.

screen.

3-10

m Edit Transmit EGC Reports Logs Options Setup Position StopAlarm

File

<[1] UNTITLED1>

|
Save BILE EARTH STATION, A

[Settings\xxxx\MyDocuments\FELCOM16\ll IRTUALLY EVERY VESSEL.
- - Filename - - - Size - - - Date & Time - - - - - - . .

<DIR>  02:02-25 02:33 e O Toaa g on
. <DIR>  02-02-25 02:52
EGC <DIR>  02-02-25 02:59
E0970715.001 864  02-02-25 03:13

4 Files exist 579584 bytes free
|| To View: SPACE Make Dir: INS  Remove Dir: DEL -+ +
Col. 4] [Insert ]

Save screen (Windows XP)

3. Enter a file name, up to eight characters with extension name (three
characters). You may not use a colon, quotation mark or semicolon or vertical

(file name) . (extension name)

3 characters
period
8 characters

Configuration of file menu
4. Press the [Enter] key to save the file to the hard disk and keep it on the



3.3.2

Save file, clear screen

1. Press the [F1] key to display the File menu.
2. Press the [3] key. The message “Save this message?” appears on the
screen.

3. FILE OPERATIONS

®llE] Edit

Transmit

EGC Reports

Logs

Options

Setup Position

StopAlarm

File

1. New ALT-N

2. Open ALT-O
3. Close ALT-Q
4. Save ALT-S

5. Delete
6. Rename

9. MIME (Decode)

ON YOUR CHOICE OF FU

Save this message?

TELEX

178 Char.

[Line 3/

<[1] C:\SEIZOUSE>

T THAT YOU WILL ENJOY MANY YEARS OF OPERATION WITH
ITANDARD C MOBILE EARTH STATION FELCOM

RUNO FELCOM. &

File menu, close

3. Yes is selected; press the [Enter] key.

file prompt

Type file
name here.

m Edit Transmit

EGC

Reports Logs

Options

Setup Position

StopAlarm

File

Save

<[1] CAUNTITLED>

B WD

EGC
E0970715.001

QD

~

o]

e}

Al To View: SPACE

74 Files exist 1910

<DIR> 08-02-25 20:54
<DIR> 08-02-25 02:13
<DIR> 08-02-25 05:42

868 08-02-25 02:33

Make Dir: INS

578560 bytes free +

Remove Dir: DEL | Col. 4 }

—————— OM. 3

1ARS OF OPERATION WITH
[Settings\xxxx\MyDocuments\FELCOM16\1 Y ] r)N FELCOM
- - Filename - - - Size - - - Date & Time

+

[Insert

]

4. Enter a file name.
5. Press the [Enter] key to save the file name and clear the screen.

Save scr

een
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3.4  Opening Files

3.4.1 Opening files

1. Press the [F1] key to display the File menu.
2. Press the [2] key. The screen shows a list of the files stored on the hard disk.
3. Press the [{] or [T] key to choose a file.
To view a portion of a file, press the space bar. After confirming, press the [Esc]
key.

File

Open

SEIZOU
THE FURUNO FELCOM INMARSAT STANDARD C MOBILE EARTH STATION, A
SATELLITE COMMUNICATIONS UNIT PACKAGE FOR VIRTUALLY EVERY VESSEL.
UNIT &

Partial view of a file
4. Press the [Enter] key.
A few moments later the contents of the file appear on the screen and the

title bar shows the file name. You may repeat this procedure to load a second
file into a working area.

3.4.2 Switching between files

You can switch between files in the working area by pressing the [9] key
(Change Window) on the Edit menu ([F2]), or pressing Alt+V on the editor
screen.

—— FURUNO —

ABC

<

DIF2]
(2 9: Change Window

or [ALT] + [V]

How to alternate display of files in working area 1 and 2.

How to switch between files
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3.4.3 Opening a file when both working areas are occupied

3. FILE OPERATIONS

If both working areas in the memory are occupied when you attempt to open a
file, you are asked if you want to save the file currently chosen before clearing it

to open another file.

Save this message?
I
| No

Prompt for closing a file

1. To save the file, press the [Enter] key. (Choose “No” and press the [Enter]

key if you do not need to save the file. Go to step 4.)

EEY Edit Transmit EGC

Reports Logs Options

Setup Position StopAlarm

File —Satti ‘r‘xxx\MyDocuments\FEICOM16\E0970715.001>
Save ARS OF OPERATION WITH
7 [xxxx\MyDocuments\FELCOM16\E0970715.0018 1)N FELCOM
3 - - Filename - - - Size - - - Date & Time - - - - - - OM. &
4 . <DIR> 08-02-25 20:54
-l .. <DIR> 08-02-25 02:13
3 BGC <DIR>  08-02-25 05:42
9 E0970715.001 42 08-02-25 02:33
_7 E0970715.002 868 08-02-25 02:52
-| E0970715.003 22 08-02-25 02:59
8 E0970715.004 675 08-02-25 03:13
'9 E0970715.005 1910 08-02-25 03:48
| 74 Files exist 578560 bytes free n +
A| To View: SPACE Make Dir: INS ~ Remove Dir: DEL | Col. 4 } [Insert 1

2. To enter same file name as edited file, press the [Enter] key.

Save screen

File aready exists. Overwrite?

Overwrite file window

3. Yes is selected; press the [Enter] key.
4. Press the [1] or [|] key to choose file to open and then press the [Enter] key.
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3. FILE OPERATIONS

3.5 Saving a File Under a New Name

1. Open a file referring to paragraph 3.4.1.

Edit the file.

Press the [F1] key.

Press the [3] (Close) or [4] (Save) key depending on your objective. [3] saves
the file and closes the screen; [4] saves file and keeps position on the
screen.

o

JIlE] Edit Transmit EGC Reports Logs Options Setup Position  StopAlarm

File <[1] C\SEIZOUSE>
1. New ALT-N |T THAT YOU WILL ENJOY MANY YEARS OF OPERATION WITH
2. Open ALT-O [TANDARD C MOBILE EARTH STATION FELCOM
CNO[SIp.YR 6] | ON YOUR CHOICE OF FURUNO FELCOM. &
4. Save ALT-S

5. Delete  ALT-D

_6'_ I?e_n?nle ______ Save this message?
7.Print  ALT-P o | o
____________ REA  No
8. Print Setting
9. MIME (Decode)
N R R ommmmeem R <
TELEX 178 Char. [ Line 3/ 3 Co. 52] [Insert ]

Save screen, prompt for saving a message before closing

5. For “Close,” press the [Enter] key.
6. Press the [Backspace] key to delete original file name. Enter file name for

new file.
m Edit Transmit EGC Reports Logs Options Setup Position StopAlarm
—— File Mnnﬁxxxx\MyDocuments\FELCOMl6\E0970715 .001>
Save IARS OF OPERATION WITH
2 [xxxx\MyDocuments\FELCOM16\E0970715.0018 1PN FELCOM
3 - - Filename - - - Size - - - Date & Time - - - - - - OM.
4 . <DIR> 08-02-25 20:54
.. <DIR> 08-02-25 02:13
J EGC <DIR> 08-02-25 05:42
_6 E0970715.001 42 08-02-25 02:33
7 E0970715.002 868 08-02-25 02:52
-| E0970715.003 22 08-02-25 02:59
8 E0970715.004 675 08-02-25 03:13
'9 E0970715.005 1910 08-02-25 03:48
| 74 Files exist 578560 bytes free + +
A To View: SPACE Make Dir: INS ~ Remove Dir: DEL | Col. 4 } [Insert ]

Save screen
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7. Press the [Enter] key.

3. FILE OPERATIONS

Note: Should you decide to save the file under the original name, skip step 6.
The screen shown at the top of the next page appears. Overwrite the
file by pressing the [Enter] key, or choose “No” and press the [Enter]

key to escape

m Edit Transmit EGC Reports Logs Options Setup Position StopAlarm
File Satsi Ixxxx\MyDocuments\FELCOM16\E0970715.001>
Save S OF OPERATION WITH
7 [xxxx\MyDocuments\FELCOM16\E0970715.001 1PN FELCOM
3 - - Filename - - - Size - - - Date & Time - - - - - - M. 3
4 . <DIR> (8-02-25 20:54
.. <DIR> 08-02-25 02:13
2 EGC <DIR> (08-02-25 05:42
E0970715.001 42 0§ . .
| Bo970715002 868 of File already exists. Overwrite? |
-| E0970715.003 22 0 : No
8 E0970715.004 675 O :
_9 E0970715.005 1910 08-02-25 03:48
| 74 Files exist 578560 bytes free + +
A| To View: SPACE Make Dir: INS  Remove Dir: DEL | Col. 4 } [Insert ]

Overwrite confirmation screen

3.6 Printing Files

You can print out a hard copy of a file stored on the hard disk.

1. Press the [F1] key to display the File menu.
2. Press the [7] key. Alist of files stored on the hard disk appears.

75 Files exist

[Settings\xxxx\MyDocuments\FELCOM 16\

- — Filename - - - Size - - - Date & Time

<DIR> 08-01-10 07:21
.. <DIR> 08-01-10 06:22
EGC <DIR> 08-02-25 06:29
E0970715.001 836 08-02-23 04:53
E0970715.002 20 08-02-18 08:55
E0970715.003 29 08-01-14 10:03
E0970715.004 128 08-02-11 15:02
E0970715.005 146  08-02-10 17:37

578560 bytes free

To View: SPACE Make Dir: INS

Remove

Dir: DEL

Sample print screen
3. Press the [1] or [|] key to choose a file. To get a partial display of the file, tap

the space bar. After confirming the file, press the [Esc] key.
4. Press the [Enter] key to print the file.
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3. FILE OPERATIONS

3.7

3-16

Combining Files

In the procedure below we’ll combine file A and B.

1.
2.
3.

o

Open file A.

Open file B.

Place the cursor at the beginning of file B. While pressing and holding down
the [Shift] key, press the [{] key to highlight the entire file. (You can also
choose a portion of the file.)

Press the [C] key while holding down the [Alt] key to place file B on the
clipboard.

Press the [V] key while holding down the [Alt] key to switch to File A.

Place the cursor at the end of the text and then press the [Enter] key.

Press the [Insert] key. File B is inserted at the end of the file A.



3. FILE OPERATIONS

3.8 Deleting Files

1. Press the [F1] key to display the File menu.
2. Press the [5] key. Alist of files stored on the hard disk appears.

File ,

Delete
[Settings\xxxx\MyDocuments\FELCOM16\ 1
- - Filename - - - Size - - - Date & Time - - - - - -

.. <DIR> 08-01-10 20:54
EGC <DIR> 08-02-25 02:13
E0970715.001 42 08-02-23 05:42
E0970715.002 868 08-02-18 02:33
E0970715.003 372 08-01-14 02:52
E0970715.004 6794 08-02-11 02:59
E0970715.005 864 08-02-10 03:13
75 Files exist 578560 bytes free
To View: SPACE Make Dir: INS  Remove Dir: DEL

Sample delete screen
3. Press the [1] or [|] key to choose the file you want to delete. To verify the
contents of that file, tap the space bar. After confirming the contents, press
the [Esc] key.
4. Press the [Enter] key. The prompt “OK to delete file?” appears.

File
Delete
[xxxx\MyDocuments\FELCOM16\E0970715.001 ]
- - Filename - - - Size - - - Date & Time - - - - - -

. <DIR> 08-01-10 20:53

oo <DIR> 08-01-10 20:54
EGC <DIR> 08-02-25 02:13

E0970715.001 42 08-0223 05:42
E0970715.002 868 98-07-15
E0970715.003 372 98-07-15| OK to delete file?
E0970715.004 6794 98-07-15 | No
E0970715.005 864 ’

75 Files exist 578560 bytes free

To View: SPACE Make Dir: INS  Remove Dir: DEL

Prompt for verification of file delete

5. Press the [Enter] key to delete the file, or press the [{] and [Enter] keys to
escape.
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3. FILE OPERATIONS

3.9 Renaming Files

Do the following to rename a file.

1. Press the [F1] key.
2. Press the [6] key.

File |
Rename
[Settings\xxxx\MyDocuments\FELCOM16\ 1
- - Filename - - - Size - - - Date & Time - - - - - -
.. <DIR> 08-01-10 20:54
EGC <DIR> 08-02-25 02:13
E0970715.001 42 08-02-23 05:42
E0970715.002 868 08-02-18 02:33
E0970715.003 372 08-01-14 02:52
E0970715.004 6794 08-02-11 02:59
E0970715.005 864 (08-02-10 03:13
75 Files exist 578560 bytes free
To View: SPACE Make Dir: INS  Remove Dir: DEL

File, rename

Press the [1] or [|] key to choose the file you want to rename.
4. Press the [Enter] key.

w

Rename

Enter new filename

Test

Rename window

5. Delete old file name and then type new file name.
6. Press the [Enter] key.
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3. FILE OPERATIONS

3.10 Decoding E-mail Attachment

When you can't read an e-mail attachment because it has been coded by MIME
(Multipurpose Internet Mail Extensions), you may decode it as below.

1. Save the MIME-coded file to the hard disk. (See paragraph 4.2.5 for the
procedure.) This step is not necessary if Auto Receive Message Save is
turned on in the Auto Mode Setup menu.

2. Press the [F1] key to open the File menu.

3. Press the [9] key to choose MIME(Decode).

m Edit Transmit EGC Reports Logs Options Setup Position StopAlarm

File — ]

Decode
[Setting\xxxx\MyDocuments\FELCOM16\ 1
- - Filename - - - Size - - - Date & Time - - - - - -
1 e <DIR>  08-02-25 02:52

EGC <DIR>  08-02-25 02:59
E0970715 001 42 08-02-25 03:13
1 E0970715 001 868  08-02-25 03:13
| E0970715 001 54 08-02-25 03:13
4 Files exist 579584 bytes free

1 To View: SPACE Make Dir: INS  Remove Dir: DEL
|

Decode window

4. Press the [1] or [|] key to choose the file you want to decode.
5. Press the [Enter] key.

File chosen at step 4

MIME Decode
Checking 'E0970715.001" - -
D
Decode 'ABC.ini"? | Decode
I No

|
File attachment

Decode window
6. Yes is selected; press the [Enter] key to decode the file.

File ————

Save
[Settings\xxxx\MyDocuments\FELCOM 16\ 1
- - Filename - - - Size - - - Date & Time - - - - - -

.. <DIR> 08-01-10 20:54

EGC <DIR> 08-02-25 02:13
E0970715.001 42 08-02-23 05:42
E0970715.002 868 (8-02-18 02:33
E0970715.003 372 08-01-14 02:52
E0970715.004 6794 08-02-11 02:59
E0970715.005 864 08-02-10 03:13

75 Files exist 578560 bytes free

To View: SPACE Make Dir: INS  Remove Dir: DEL

Save window
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3. FILE OPERATIONS

7. To change file name, press the [Backspace] key to erase the file name, new
file name and then press the [Enter] key. After decoding the file the screen
looks something like the one shown below.

MIME Decode
Checking 'E0970715.001" - - -
Decode 'ABC.ini'?
Now decoding - -
Complete.
Decoded 1 file (s).
Press any key to escape.

MIME decode screen
8. Press the [Esc] key twice to return to the standby display.
9. Press the [F1] and [2] keys in that order.

10. Press the [1] or [|] key to choose the file selected at step 7 and then press
the [Enter] key.
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4.

INMARSAT C COMMUNICATIONS

4.1

41.1

This chapter explains how to transmit and receive. Before conducting any
communications, be sure to login with the NCS in your area, following the
instructions in paragraph 2.3.1.

To transmit e-mail, you may need to register for e-mail services with an LES
which provides such services. Further it is necessary to register with an LES
which provides e-mail services in order to send e-mail from a land subscriber to
the FELCOM 16. For further details contact an LES.

Transmitting

To transmit a message, create the message, attach the address of the recipient
and then send it to the LES. The address of the recipient in the Inmarsat C
system is his telex number, for transmission via landline, or MES Inmarsat
Mobile Number (IMN), when transmitting to a ship.

The message can be one you've just prepared or one stored on the hard disk.
(Messages cannot be transmitted by direct keyboard input.)

Code description

Code can be specified at the terminal unit according to data type.

IA5: International alphabet No. 5, ASCII code (7 bit).
Specify this code to transmit English containing lower case alphabet.

ITA2: No. 2 international communications alphabet (5 bit). Specify this code for
message which contains only No. 2 international communications
alphabet (see A-11). ITA2 code is transmitted faster than IA5 code.
Land-based telex equipment uses ITA2. The LES converts all codes into
ITA2. Code which cannot be converted is shown with the question mark
(?).

DATA: Data (8 bit). Use this code to transmit data.
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4. INMARSAT C COMMUNICATIONS

Message, subscriber, destination type and code

Message | Subscriber Destination Type | Code Remarks

Inmarsat C MES | Telex IA5
_ Telex Telex ITA2

English
Fax PSTN IA5 Modem type “T30 FAX”
E-mail E-mail IAS
Inmarsat C MES | PSDN DATA

Russian Fax Not available
E-mail E-mail DATA
Inmarsat C MES | PSDN DATA
Telex Not available

Japanese
Fax Not available
E-mail E-mail DATA Attachment file
Inmarsat C. MES | PSDN DATA

Data
Land Network PSDN DATA

4.1.2

4-2

Transmitting prepared message

This section explains how to transmit a message you have just prepared. For
code number services, see the table in paragraph 4.1.6.

Transmitting a message to a station registered on station list

1. Prepare message on the screen. For e-mail or SMS, set Text Mode in the
Editor Setup menu to Ascii. See paragraph 3.2.3. For e-mail attachment,
prepare the attachment and save it to the hard disk. SMS messages over
160 characters in length are sent in parts.

2. Press the [F3] key to display the Transmit menu.

File Edit EGC Reports Logs Options Setup Position StopAlarm
- Transmit <[1] UNTITLED1>

1. Transmit Message

2. Cancel

3. Request Delivery Status
ek mmmm e o B [ T +- S — + ——<
TELEX 25Char. [ Line 2/ 2 Co. 1] [Insert ]

Transmit menu
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3. Press the [1] key to display the Transmit Message menu.

Displayed if toll charges have been entered. See para. 2.6.1.
|

File Edit EGC Reports Logs Options SetIIJp Position  StopAlarm
-——— Transmit ————— <[1] UNTITLED1>
Transmit Message
Not used. J» Priorit Normal
Message now being edited  Size Y 24
~| Station Name Cost ****xxx% xx(|SE)
Destination Type TELEX
Prefix Code
Country/Ocean Code
Station ID
Modem Type
_ Address
Subject
L Attach File _ |
LESID
Option
Confirmation ON
Send Delay 00:00
Delivery Delay Immediate
Code IA5
[ TRANSMIT ]

Transmit message menu

4. Press the [{] key to choose Station Name.
5. Press the [Enter] key to open the Station List.

File Edit EGC Reports logs Options  Setup StopAlarm
Transmit ———
Transmit Message
Priority Normal IB)
Message F Station List ol a
Group StationName Type  Code ID/Address
Dedtinetio =~~~ -~~~ -~~~ -~~~ -~~~ -~~~ """ "~""""""" """ """ "°~% OHz)
Country| Qg FURUNO TELEX 81 321
Station | 02 x2 FRNINMBTSTS TELEX 583 343199999
Modem| 03 X3 Seagulll E-Mail Seagull @furuno.co.jp
Addresy 04 x4 whale E-Mail whale@furuno.co.jp
Subject | 05
Attach LEY 06
Option 07
Confirn] 08
SendD| .~ T - Tt o T T
Deliver 7 |:Select SPACE: Select Stations B.SPACE: Cancel Mark  INS: Edit
Code Sort (Ctrl+G: Group, Ctrl+N: Station Name, Ctrl+T: Type)
[ TRANSMIT ]

Transmit message menu, station list
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4-4

6. Press the [t] or [{] key to choose station and then press the [Enter] key. To
choose multiple stations* (simultaneous transmission), choose a station and
then press the Space bar. Selected stations are marked with an asterisk (in
case of Telex or FAX). For e-mail address, press the Space bar to choose
“To” “Cc,” Blank, “To”... consecutively. * = Max. 10 telex stations, 7 FAX, 10
e-mail and one SMS.

Note 1:

Note 2:

Note 3:

Note 4:

Station List
Group Station Name Type Code ID/Address

01 x1 FURUNO TELEX 81 321

* 02 x2 FRNINMBTSTS TELEX 583 343199999

03 x3 Seagull E-Mail  Seagull @furuno.co.jp
04 x4 whale E-Mail whae@furuno.co.jp
05
06
07
08

1 | :Select SPACE: Select Stations B.SPACE: Cancel Mark  INS: Edit
Sort (Ctrl+G: Group, Ctrl+N: Station Name, Ctrl+T: Type)

Station list

Messages having different communication format or prefix code
(two digit code) cannot be sent simultaneously.

To stop simultaneous transmission (erase asterisk, To or Cc), press
the [Backspace] key.

You may sort the list by group name, station name or
communication type as follows:

Group name: Each press of [Ctrl] + [G] sorts the list by group name,
ascending or descending order.

Station name: Each press of [Ctrl] + [N] sorts the list by station
name, in ascending or descending order.

Comm. type: Each press of [Ctrl] + [T] sorts the list by
communication type, in ascending or descending order.

You may edit the communication charges (see paragraph 2.7.1)
from the Station List by pressing the [Insert] key. After editing
charges, press the [Esc] key. “OK to save” appears; press the
[Enter] key.

7. For E-malil follow the procedure below. For other communication formats go

to step 8.

(1) Press the [{] key to choose Subject.

(2) Press the [Enter] key to open subject entry window.

(3) Type subject.

(4) Press the [Enter] key to close the window.

(5) To attach a file, press the [{] key to choose Attach File.
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(6) Press the [Enter] key to open the attach file window.

- Transmit ———— <[1] UNTITLED1>
Transmit Message

Priority Normal

Message File Message now being edited  Size 24

Station Name Cosgt ¥**xxxxx %% (|SP)

Destination Type E-Mail
Prefix Code Select File
Country/Ocean Code
Station ID I
Modem Type
Address
Subject

= .

LESID

Option
Confirmation
Send Delay
Delivery Delay
Code ENTER: Select DEL: Remove

[ TRANSMIT ]

Transmit message menu, select file window opened
(7) Press the [Enter] key to open the file list window.
(8) Press the [1] or [{] key to choose a file and then press the [Enter] key.

(9) Press the [Esc] key to close the window.

8. Press the [{] key to choose LES ID. If the communication format is e-mail the
LES set in paragraph 2.11 appears.

9. Press the [Enter] key to open the LED setting window.

= Transmit ———— <[1] UNTITLED1>
Transmit Message
Priority Norma
Message File Message now being edited  Size 24
Station Name Cogt #+++xxxx % (S$)
Destination Type TELEX
Prefix Code
Country/Ocean Code
Station ID
Modem Type
Address
Subject
L Attach File
Name LESID Remarks
Option Telenor S.S.Inc 201 USA
Confirmation 202
Send Delay KDDI 203 JAPAN
Delivery Delay KoreaTelecom 208 KOREA
Code Singapore Telecom210 SINGAPORE (NCS, 1D244)
[ TRANSMIT ]

LES ID options
10.Press the [1] or [{] key to choose LED desired.

Note: You may edit the communication charges (see paragraph 2.7.1) from
the Station List by pressing the [Insert] key. After editing charges,
press the [Esc] key. “OK to save” appears; press the [Enter] key.

11. Press the [Enter] key to close the window.
12.Press the [1] key to choose Confirmation.
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4-6

13. Press the [Enter] key to open the confirmation window.

14. To request notification of delivery from the LES, choose ON. If not necessary
choose OFF.

15. Press the [Enter] key to close the window.

16.Press the [{] key to choose Send Delay.

17.Press the [Enter] key to open the send delay entry window.

18.To send a message after a certain delay, enter a time up to 99 hours 59
minutes. (The Send Delay is used to time message arrival to suit recipient’s
office hours.)

19.Press the [Enter] key to close the window.

20.Press the [{] key to choose Delivery Delay.

21.Press the [Enter] key to open the delivery delay options window.

22.Delivery Delay requests the LES for “Immediate” or “Deferred” transmission
to the recipient designated. Press the [1] or [{] key to choose Immediate or
Deferred. For information on this service, consult with LES where message is
to be sent.

23.Press the [Enter] key to close the window.

24.Press the [{] key to choose Code and press the [Enter] key.

25.Press the [t] or [{] key to choose “IA5 (for e-mail, fax) ”, “ITA2 (for telex)”,
“DATA” or “SMS” as appropriate.

26.Press the [Enter] key to close the window.

27.Press the [{] key to place the cursor on TRANSMIT.

28.Press the [Enter] key to open the start window.

Transmit Message

Priority Normal
Message File SEISETU.TXT Size 46
Station Name FURUNO COSt ****x*kk* *x (USB)
Destination Type TELEX

Prefix Code

Country/Ocean Code 81

Station ID 321

Modem Type

Address

Subject

Attach File
LESID 303 (KDDI) Start
Opton |-

Confirmation ON I No

Send Delay 00:00

Delivery Delay Immediate

Code IAS

Transmit message screen

29.Press the [Enter] key to send the message to the message queue. (To
escape, choose “No” and press the [Enter] key.) The message “Message is
entered in sending Queue. Press any key.” appears.

Note 1: If some data has not been entered, the message “Input Error: xx.”
(xx: error content) appears.

Note 2: When you send a message which contains more than 32 KB of data,
the message “Message file is too large (but sent only with 32 KB).”
appears. The message is sent with only 32KB of data.
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Note 3: Messages sent to the message queue may contain up to 32 KB of
data. If data is larger than 32 KB, the message “Cannot enter this
message to sending Queue. Press any key.” appears.

30.Press the [Esc] key twice to return to the standby display.

The message(s) will be transmitted according to the Send Delay setting.
“Current State: SENDING” appears at the bottom of the screen while the
message is being transmitted. If the message was transmitted successfully,
“Successful Sending message” appears and the TX message is printed (if

“Confirmation is ON).

Sent Message

DELIVERY CONFIRMATION OFF

Message File
LES

Priority
Destination

: OOFOX.TXT Message Size : 277 characters

: Stratos M.N. Date :02-03-10

- Normal Time :06:06 (UTC)

: TELEX (Prefixed) 00111222222222222222 (IA5)
00111333333333333333
00111444444444444444

Display log printout example (“Confirmation” OFF)
When Confirmation is ON and you receive a delivery status message, the
message “Delivery Status received for (file name).” appears and the delivery

status message is printed.

Sent Message

DELIVERY CONFIRMED

Message File : OOFOX.TXT Message Size : 277 characters
LES : Stratos M.N. Date 1 02-03-10
Priority : Normal Time :06:06 (UTC)
Destination : TELEX (Prefixed) 00111222222222222222 (IA5)

Display log printout example (“Confirmation” ON, delivery confirmed)

Sent Message but not delivered
DELIVERY FAILURE : xxx

Message File  : 0OFOX.TXT Message Size : 277 characters
LES : Stratos M.N. Date : 02-03-10
Priority : Norma Time :06:06 (UTC)
Destination : TELEX (Prefixed) 00111222222222222222 (1A5)

Display log printout example (“Confirmation” ON, delivery failed)

Sent Message but not delivered
DELIVERY STATUSNOT RECEIVED (In case of timeout)

Message File
LES

Priority
Destination

: 00FOX.TXT Message Size : 277 characters
: Stratos M.N. Date 1 02-03-10
- Normal Time :06:06 (UTC)

: TELEX (Prefixed) 00111222222222222222 (1A5)

Display log printout example (“Confirmation” ON, delivery status not received)
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4 )
TRANSMIT MESSAGE STATUS

The terminal unit displays transmit message status as follows:

Message Send failed. This appears if the message could not
be transmitted because of technical reasons such as satellite
malfunction, signal degradation, or no reply from LES. Try to
transmit the message again.

Message Send rejected. This appears when the LES rejects
the message because of non-technical reasons such as unpaid
subscriber's fee.

Message Send pending.This appears when the circuits at the
LES are busy. Your message will be transmitted when a circuit
becomes clear.

- J

Transmitting a message to a station not registered on station list

1. Prepare message on the screen. For e-mail or SMS, set Text Mode in the
Editor Setup menu to Ascii. See paragraph 3.2.3. For e-mail attachment,
prepare the attachment and save it to the hard disk. SMS messages over
160 characters in length are sent in parts.

2. Press the [F3] key to display the Transmit menu.

3. Press the [1] key to show the Transmit Message menu.

Displayed if toll charges have been entered. See para. 2.6.1.
|

File Edit EGC Reports Logs Options SetIIJp Position  StopAlarm

- —— Transmit ——— <[1] UNTITLED1>
l Transmit Message

Priorit Normal
Message now being edited  Size Y 24
~| Station Name Cost *++xxxxx x%(USP)
Destination Type TELEX
Prefix Code
Country/Ocean Code
Station ID
Modem Type
Address
Subject
L Attach File ]
LESID
Option
Confirmation ON
Send Delay 00:00
Delivery Delay Immediate
Code IA5
[ TRANSMIT ]

Not used.

Transmit message menu
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4. Press the [{] key twice to choose the Destination Type.
5. Press the [Enter] key to open the destination type options window.

- Transmit ——— <[1] UNTITLED1>
Transmit Message
Priority Normal
Message File Message now being edited  Size 24
Station Name Cost ¥****xxx %% (SH)
[TeLex N
Prefix Code
Country/Ocean Code | E-Mail
Station ID CSDN
Modem Type PSDN
| Address X400
S o
—| | patachFle TELEX (Prefixed) -
- FAX (Prefixed)
Option PSDN  (Prefixed)
Confirmation X400  (Prefixed)
Send Delay DNID  (Prefixed)
Delivery Delay SPEC (Prefixed)
Code IA5
[ TRANSMIT ]

Transmit message menu, destination type options window
6. Press the [t] or [{] key to choose Destination Type among “TELEX,” “FAX” or
“E-mail” as appropriate.
7. Press the [Enter] key to close the window.
8. Continue the procedure according to destination type:
TELEX: See procedure next page
FAX: See procedure on page 4-12
E-mail:  See procedure on page 4-13
SMS: See procedure on page 4-14
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Communication type: TELEX
1. Press the [{] key to choose Country/Ocean Code.
2. Press the [Enter] key to open the country/ocean code entry window.

- Transmit ——— <[1] UNTITLED1>
Transmit Message
Priority Normal
Message File Message now being edited  Size 24
Station Name Cosgt ¥***xxxx %% (|S§)
Destination Type TELEX
Prefix Code
" CauntryiOcean Code| IR
Station ID
Modem Type
_ Address
Subject
L Attach File _
LESID
Option
Confirmation ON
Send Delay 00:00
Delivery Delay Immediate
Code IA5
[ TRANSMIT ]

Transmit message menu, country/ocean code window
3. For ship-to-shore telex, enter recipient’s telex country code. For example, to
use KDDI (Japan) enter 72. For ship-to-ship telex, enter recipient’'s ocean
region.
Ocean Region
AOR-East: 581
POR: 582
IOR: 583
AOR-West: 584

4. Press the [Enter] key to close the window.
5. Press the [{] key to choose Station ID.
6. Press the [Enter] key to open the station ID entry window.

- Transmit ——— <[1] UNTITLED1>
Transmit Message
Priority Normal
Jy MessageFile Message now being edited  Size 24
Station Name Cost ********.**(U%)
Destination Type TELEX
Prefix Code
Country/Ocean Code
]
Modem Type
- Address
Subject
— Attach File -
LESID
Option
Confirmation ON
Send Delay 00:00
Delivery Delay Immediate
Code IA5
[ TRANSMIT ]

Transmit message menu, station ID window opened
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7. Type either recipient’s telex subscriber number (ship-to-shore) or IMN

(ship-to-ship).

8. Press the [Enter] key to close the window.
9. Press the [{] key to choose LES ID.
10.Press the [Enter] key to open the LES ID entry window.

= Transmit ————— <[1] UNTITLED1>

Priority
Message File
Station Name
Destination Type
Prefix Code
Country/Ocean Code
Station ID
Modem Type
Address
Subject
L Attach File
Option
Confirmation
Send Delay
Delivery Delay
Code
[ TRANSMIT ]

4. INMARSAT C OPERATIONS

Transmit Message
Normal
Message now being edited  Size 24
Cost ********.**(U%)
TELEX
Name LESID Remarks
Telenor S.S.Inc 201 USA
202
KDDI 203 JAPAN
Korea Telecom 208 KOREA
Singapore Telecom210 SINGAPORE (NCS, 1D244)

LED ID entry window

11. Press the [1] or [{] key to choose LES.
12.Press the [Enter] key to close the LES ID entry window.
13.Follow from step 12 on page 4-5; set Confirmation, Send Delay, Delivery

Delay, Code and the choose TRANSMIT to send message.
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4-12

Communication type: FAX
Press the [{] key to choose Country/Ocean Code.

Press the [Enter] key to open the country/ocean code entry window.

Enter telephone country code of recipient, referring to the list in the Appendix.
Press the [Enter] key to close the window.

Press the [{] key to choose to choose Station ID.

Press the [Enter] key to open the station ID entry window.

Enter recipient’s fax number.

Press the [Enter] key to close the window.

Press the [{] key to choose Modem Type.

10 Press the [Enter] key to open the modem type options window.

- Transmit ————— <[1] UNTITLED1>

©CoNORWDE

Transmit Message
Priority Normal
Message File Message now being edited  Size 24
Station Name Cost ****x*%k (| JSE)
Destination Type FAX
Prefix Code
Country/Ocean Code ——— Modem Type
Station ID
v2l V.21 300bps Duplex
_ Address V22 V.22 1200bps Duplex
Subject V22B  V.22bis 2400bps Duplex
L Attach File V23 V.23 600/1200bps ' —
LESID V26B V.26bis 2400/1200bps
Option V26T V.26ter 2400bps Duplex
Confirmation V27T V.2T7ter 4800/2400bps
Send Delay V32 V.32 9600bps Duplex
Délivery Delay Other
Code 1A5
[ TRANSMIT ]

Transmit message menu, modem type options window

11. Press the [1] or [{] key to choose modem type. For transmission to landline
fax or to fax-equipped Inmarsat B MES, choose “T30.” (You cannot transmit a
FAX to another Inmarsat C MES.)

12.Press the [Enter] key to close the window.

13.Press the [{] key to choose LES ID.

14.Press the [Enter] key to open the LES ID window.

15.Press the [1] or [{] key to choose LES ID.

16.Press the [Enter] key to close the window.

17.Follow from step 12 on page 4-5; set Confirmation, Send Delay, Delivery
Delay, Code and the choose TRANSMIT to send message.



Communication type: E-mail

4. INMARSAT C OPERATIONS

1. Press the [{] key to choose Address.
2. Press the [Enter] key to open the address entry window.

- Transmit ——— <[1] UNTITLED1>

Transmit Message |

Priority
Message File
Station Name
Destination Type
Prefix Code
Country/Ocean Code
Station ID
Modem Type
-
Subject
L Attach File
LESID
Option
Confirmation
Send Delay
Delivery Delay
Code
[ TRANSMIT ]

Normal
Message now being edited Size 24
Cost ********.**(U%)
E-Mail
INET

201 (Telenor S.S.Inc)

ON

00:00
Immediate
VAYS)

Transmit message menu, address entry window

o0k w

Type recipient’'s e-mail address.

Press the [Enter] key to close the window.

Press the [{] key to choose Subject.

Press the [Enter] key to open the subject entry window.

- Transmit ——— <[1] UNTITLED1> |

Priority

Message File

Station Name

Destination Type
Prefix Code

Station ID

Modem Type

Address

Subject

L Attach File

LESID

Option
Confirmation
Send Delay
Delivery Delay
Code

[ TRANSMIT ]

Transmit Message
Normal
Message now being edited  Size 24
COS ********.**(Uﬁ)
E-Mail

Country/Ocean Code

INET

201 (Telenor S.S.Inc)

ON
00:00
Immediate
IA5

Transmit message menu, subject entry window opened

7. Type subject.

8. Press the [Enter] key to close the window.

9. If you want to attach a file, press the [{] key to choose Attach File.
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4-14

10.Press the [Enter] key to open the select file window.

- Transmit ——— <[1] UNTITLED1>
Transmit Message

Priority Normal

Message File Message now being edited  Size 24

Station Name Cost ***x*x%% x* (|SE)

Destination Type E-Mail
Prefix Code Sdlect File
Country/Ocean Code
Station 1D |
Modem Type
Address
Subject

- —

LESID

Option
Confirmation
Send Delay
Dedlivery Delay
Code ENTER: Select DEL: Remove

[ TRANSMIT ]

Transmit message menu, select file window

11. Press the [Enter] key to open the file list window.

12.Press the [1] or [{] key to choose a file and then press the [Enter] key to
close the window.

13.Press the [Esc] key to open the select file window. The LES ID selected at
paragraph 2.11 appears.

14.Follow from step 12 on page 4-5; set Confirmation, Send Delay, Delivery
Delay, Code and the choose TRANSMIT to send message.

Communication type: SMS

Press the [{] key to choose Address.

Press the [Enter] key to open the address entry window.
Type recipient’s mobile phone number.

Press the [Enter] key to close the window.

Press the [{] key to choose LES ID.

Press the [Enter] key to open the LES ID selection window.
Choose LES ID.

Press the [Enter] key to close the window.

Follow from step 12 on page 4-5.
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Transmitting a file stored on the hard disk

1. Close any open files.
2. Press the [F3] key to display the Transmit menu.

File Edit EGC Reports Logs Options Setup Position StopAlarm

Transmit

1. Transmit M essage

2. Cancel
3. Request Delivery Status

Transmit menu
3. Press the [1] key to choose Transmit Message.

File Edit Transmit EGC Reports Logs Options Setup Position StopAlarm
Transmit ———
Transmit Message
Priority Normal
Size 24
Station Name Cost ****xxsxdk %k (|JS&)
Destination Type TELEX
Prefix Code
Country/Ocean Code 82
Station 1D 65-2111
Modem Type
Address
Subject
Attach File
LES ID 203 (KDDI)
Option ON
Confirmation 00:00
Send Delay Immediate
Delivery Delay 1A5
Code
[ TRANSMIT ]

Transmit message menu
4. Press the [{] key to choose Message File and press the [Enter] key.

File
Send . .

[Settings\xxxx\MyDocuments\FELCOM16\  4——}-— Displaymay vary depending
- - Filename - - - Size - - - Date & Time - - - - - - on computer and OS type
. <DIR> 08-01-10 20:53
.. <DIR> 08-01-10 20:54
EGC <DIR> 08-02-25 02:13
E0970715.001 42 08-02-23 05:42
E0970715.002 868 08-02-18 02:33
E0970715.003 372 08-01-14 02:52
E0970715.004 6794 08-02-11 02:59
E0970715.005 864 08-02-10 03:13

75 Files exist 578560 bytes free
To View: SPACE Make Dir: INS  Remove Dir: DEL

Send window (Windows XP)

5. Press the [t] or [{] key to choose a file and press the [Enter] key. (You can
view a part of a file by tapping the space bar. After confirming the contents,
press the [Esc] key.)
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Note: When an e-mail with attachment is transmitted, the file volume
increases by 1.5 times because of MIME coding. In this case, you can
do the following to lower toll charges:

a) Select file to attach from Message File.
b) Choose DATA from Code.

6. To transmit the message to a station registered on the station list, follow from
step 12 on page 4-5. To transmit to a station not listed on the station list,
follow from step 4 on page 4-9.

4.1.4 Canceling transmission on a message awaiting transmission

As noted earlier a transmit message is held in the buffer, usually until it is
transmitted satisfactorily. To cancel transmission on a message held in the buffer,
do the following:

1. Press the [F3] key to display the Transmit menu.
2. Press the [2] key to display the Cancel screen.

File Edit EGC Reports Logs Options Setup Position  StopAlarm
- Transmit ——— <[1] UNTITLED1>
1. Transmit Message Cancel
Message File Priority Send Status Delivery
edit_msg.001 Normal Waiting
ek mm e f S B [ S [ <
TELEX 25Char. [Line 2/ 2 Co. 1] [Insert ]

Cancel screen
Send status
Waiting: Waiting to transmit message.
Sending: Now sending message.
Fail: Failed transmission
Rejected: Message rejected by LES.
Pending: LES circuits occupied.

3. Press the [1] or [{] key to choose the message you want to cancel.
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4. Press the [Enter] key to open the cancel window.

File Edit EGC Reports Logs Options Setup Position  StopAlarm

- ———— Transmit <[1] UNTITLED1>

1. Transmit Message Cancel

No. Message File Station LES Priority Send Status Delivery

01 ABC FURUNO  Telenor S.S.Inc  Normal Waiting

02 FELCOM FUSA Telenor S.SInc  Normal Sending

Cancel
Yes HEE\[e}

R SR oo oo oo oo oo <
ASCII 25 Char. [Line 2/ 2 Caol. 1] [Insert ] |

Cancel window

5. Press the [Enter] key to cancel a message, or choose “No” and press the
[Enter] key to escape from the Cancel menu.
6. Press the [Esc] key twice to return to the standby display.

Requesting delivery status

Automatically receiving delivery status

You can automatically receive delivery status of messages you send to a LES,
by selecting “Confirming ON” in the Transmit Message menu. Transmitted
messages which request delivery status appear in the Message Status List.

The Message Status List holds delivery status information for 30 messages.
When the list is full, the oldest entry is deleted to make room for the latest.

1. Press the [F3] key to show the Transmit menu.

Transmit

2. Cancel

File Edit EGC Reports Logs Options Setup Position StopAlarm

1. Transmit Message

3. Request Delivery Status

Transmit menu

2. Press the [3] key to display the Request Delivery Status list. If no messages
are present “No message.” appears.

Request Delivery Status

No. Message File Station LES Priority Send Status Delivery
01 ABC FURUNO KDDI Normal Waiting

02 DEF FURUNO KDDI Normal Sending

03 GHI ASDFASDF  KDDI Normal 02-02-26 9:40 OCC(002)
04 JKL KDDI Normal 02-02-25 20:16

05 MNO ABCDEFGHIJ KDDI Normal 02-01-23 16:09 Complete
06 edit msg.002 KDDI Normal 02-01-22 9:48 EEE(001)
07 edit msg.001 KDDI Normal 02-01-20 12:34 ?7?7?7??

Sample request delivery states
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IMessage status list description]

No.:
Message File:

Station:

LES:
Priority:
Send Status:

Delivery:

Message number

File name. For no file name, “edit msg. 00X” appears (X =

number from 001-999).

Name of remote party (recipient)

The LES which received the message.

Normal only

The transmission status from the MES (own ship) to the LES;

waiting or sending, and data and time of transmission for

messages transmitted.

The delivery status from the LES to the recipient.

Complete: Message transmitted successfully

White space: Delivery status not yet received

Reason for no delivery:

OCC(002): Delivery tried (twice), but recipient busy.

ABS: Absent subscriber

BK: Message aborted

BMC:No end of message or end of transmission received

DER:Out of Order

DTE: Remote DTE clearing

EOS:Element of Service not subscribed (E-mail)

FMT: Format error

IAB: Invalid answerback

INC: Inconsistent Request (E-mail)

INF: Call the Network Information service

INV: Invalid Call

ITD: Awaiting delivery

LDE: Maximum message length exceeded

LPE: Local Procedure Error

NA: Access Barred

NC: Network Congestion

NCH:Subscriber’s number has been changed

NP: Not Obtainable

NRC:Reverse charging acceptance not subscribed

RIS: Recipient Improperly Specified (E-mail)

RDI: Redirected call

RPE: Remote Procedure Error

RSB: Retransmission still being attempted

TMD:Maximum number of addresses exceeded

UNK:Unknown status (for example when the Logical
channel number is zero)

Note: Some codes may not be used depending on LES.
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Manually requesting delivery status

You can manually request an LES for delivery status of a message you have

transmitted within the past 24 hours.

1. Press the [F3] key to display the Transmit menu.
2. Press the [3] key to display the Request Delivery Status list.

Request Delivery Status

No. Message File Station LES Priority Send Status Delivery
01 ABC FURUNO KDDI Normal 02-02-25 16:10
02 editmsg.002 FURUNO KDDI Normal

Request delivery status display

3. Press the [t] or [{] key to choose a file.
4. Press the [Enter] key. The start window appears.

Request Delivery Status

No. Message File Station LES Priority Send Status Delivery
01 ABC FURUNO KDDI Normal 02-02-25 16:10
02 editmsg.002 FURUNO KDDI Normal
Start
B No

Sample message file list

5. Yes is selected; press the [Enter] key to request status. If request was
successful the message “Successful Deliver Status Request.” appears.

6. Press the [Esc] key twice to return to the standby display.

Several minutes later the message “Delivery status received for (file name)”
appears on the display. The reply from the LES appears in the Delivery column

of the Request Delivery Status list.
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4.1.6

4-20

Accessing the code number services

Arange of special safety and general maritime services, known as the code
number services, may be transmitted. The list on the next page shows the code

number services available.

To access a code number service do the following:

1. Using the text editor, prepare message requesting a code number service.
2. Press the [F3] key to open the Transmit menu.
3. Press the [1] key to display the Transmit Message menu.

Displayed if toll charges have been entered. See para. 2.6.1.

File Edit EGC Reports Logs Options Setll.lp Position  StopAlarm
- Transmit —————— <[1] UNTITLED1>
Transmit Message
Not used. Priorit Normal
Message now being edited Size Y 24
-| Station Name Cogt ***xxxxx % (SP)
Destination Type TELEX
Prefix Code
Country/Ocean Code
Station ID
Modem Type
. Address
Subject
L Attach File _
LESID
Option
Confirmation ON
Send Delay 00:00
Delivery Delay Immediate
Code IA5
[ TRANSMIT ]

Transmit message menu

©ooNOo oA

Press the [{] key twice to choose Destination Type.

Press the [Enter] key to open the destination type options window.
Press the [{] or [] key to choose SPEC (Special).

Press the [Enter] key to close the window.

Press the [{] key to choose Station ID.

Press the [Enter] key to open the station ID entry window.

10 Key in code number referring to the table on the next page.
11. Press the [Enter] key to close the window.
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Maritime safety service code number services

Code Content Remarks
31 Maritime enquiries Desirable for requesting information
including service offerings.
32 Medical advice Used for requesting medical advice.
33 Technical assistance Desirable for addressing technical enquiries
to appropriate personnel.
37 Time and charges Desirable for mobile operator when sending
requested at end of call traffic for a third party.
38 Medical assistance Used for requesting medical assistance.
39 Maritime assistance Used for requesting maritime search and
rescue assistance
41 Meteorological reports Necessary for ease of addressing weather
reports from ship to meteorological centers.
42 Navigational hazards and Used for making urgent navigational
warnings meteorological danger reports.
43 Ship position reports Used for routing of messages to ship safety

reporting systems.

12.Press the [{] key to choose LES ID.

13.Press the [Enter] key to open the LES window.

14.Press the [1] or [{] key to choose appropriate LES and press the [Enter] key.
15.Press the [{] key to choose TRANSMIT.

16.Press the [Enter] key to show the start window.

17. Press the [Enter] key to transmit the message prepared.

Note: If some data is missing the message “Input error.xx (xx: error) is
displayed.
18.Press the [Esc] key twice to return to the standby display.
The message “Current State: SENDING” appears at the bottom of the screen
during transmission. If the message was transmitted successfully “Successful

Sending message” appears and the message is printed (Confirmation is
turned ON). You can see the contents on the Display Log.

Note 1: At present, not all LESs are offering the code number services. Contact
the LES Operations Coordinator directly for information.

Note 2: Some code number services may be provided free of charge by LESS,
while other services are available for a fee, in some cases at reduced
rates. For information, contact the LES directly.
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4.1.7 Displaying the send message log

1. Press the [F6] key to display the Logs menu.

Logs

2. Recelve Message Log
3. EGC Log
4.Log

1. Send Message Log

Logs menu

2. Press the [1] key to show the Send Message Log. The contents are the same
as the Request Deliver Status list. (See page 4.17.)

Send Message Log
No. Message File Station LES Priori
01 ABC FURUNO KDDI
02 DEF FURUNO KDDI
03 GHI ASDFASDF KDDI
04 XKL KDDI
05 MNO ABCDEFGHIJ KDDI

ENTER: Show Details

Normal Waiting

Normal Sending

Norma 02-02-26 9:40 OCC(002)
Normal 02-02-25 20:16

Normal 02-01-23 16:09 Complete

ty Send Status Dedlivery

Send message log

3. Pressthe [1] or [|] key to choose a file.
4. Press the [Enter] key to show data.

—— Up to 10 stations displayed
in case of multiple addressees
Send Message Detail

Destination Type: E-Mail

Station
abc@furuno.co.jp

Subject
Test

LESID: 203 (KDDI)

Attachment file

Attach File
ABC
DEF

Message Ref. No. : 00001125
A

Number assigned by LES

Send message details (example: e-mail)
5. Press the [Esc] key three times to return to the standby display.
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Receiving
When a message is received

Each time the FELCOM 16 receives a telex or e-mail it displays the message
“Successful Receiving message.” If Auto Receive Message Save and Auto
Receive Message Print in the Auto Mode Setup are set for ON, the message is
automatically saved and printed (except confidential and password affixed
messages).

Received message alarm

If Receive Alarm in the Auto Mode Setup menu is set for ON, the audio sounds
when a telex or e-mail is received. You may silence the alarm with the [F10] key.

Reqistration

Each message received is assigned a message number. This number is also
used when saving the file to the hard disk.

R 0 0 3 04 25 001
Receive 0:PC year month  day receive
message no.

Message number
Log

The Log (see paragraph 4.3) shows message number, priority, date and time of
transmission, LES ID and file size (in bytes) of the latest 50 received and
transmitted messages.

Printing

When Auto Receive Message Print in the Auto Mode Setup menu is set for ON,
received messages (except confidential and password affixed messages) are
automatically printed. Manual printing is also available.

Saving and filing

The terminal unit saves and files a received message to the Display Message
List. The Display Message List shows the following:

Received message no.

LES ID

Priority

File size (in bytes)

Message classification

Password for confidential messages
Date and time of transmission
Status
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4.2.2

4.2.3

4-24

Setting the receive alarm
An audio alarm may be set to sound when a routine or confidential message is
received. The factory setting is OFF. Set alarm volume at the PC.

1. Press the [F8] key to display the Setup menu.
2. Press the [5] key to display the Auto Mode Setup menu.

Auto Mode Setup
Auto Log Print OFF
Receive Alarm OFF
Auto Receive Message Save OFF
Auto Receive Message Print OFF
Data Report & Polling Print OFF
Auto EGC Message Save
Auto EGC Message Print

Auto mode setup menu
Press the [{] key to choose Receive Alarm.
Press the [Enter] key to open the Receive Alarm options window.
5. To enable the audio alarm, choose ON. As soon as ON is selected a beep
sounds. The alarm will be released when a telex or e-mail is received.
6. Press the [Enter] key to close the window.
7. Press the [Esc] key twice.

W

Displaying, printing received messages

Received messages (except confidential or password affixed) are automatically
printed when the Auto Receive Message Print in the Auto Mode Setup is turned
on. To print confidential or password affixed messages follow the procedure
below.

If you cannot read an e-mail attachment (because it is MIME-coded), go to
paragraph 3.10.

1. Press the [F6] key to show the Logs menu.
Logs

1. Send Message Log

2. Recelve Message Log
3. EGC Log
4.Log

Logs menu
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2. Press the [2] key to display the list of received messages.

Received Message Log

MessageNo. LES Priority Size Addressee Recdate& Time Status
R0971106.001 KDDI Normal 32767 02-02-06 16:10  Saved
R0971105.002 KDDI Normal 200 CAPTAIN 02-02-0517:30

R0971105.001 KDDI Norma 1234 02-02-05 14:15  Printed
R0971024.001 KDDI Normal 8251 02-01-2413:20  Saved

Memory Available: 12345 Bytes

ENTER: Display S: Save D: Delete

Receive message log

Display message list description

Message No.: Received message no.

LES: LES name

Priority: Normal

Size: Size of file in bytes

Addressee: Addressee code appears for confidential messages.
Nothing appears for routine messages.

Rec date & time: Date and time message was received.

Status: Printed: message printed

Saved: message saved to hard disk

No display: not yet printed confidential message, or
printer malfunction

Memory available: Received message memory available in the terminal unit

3. Choose afile. To get a partial display of a file selected, tap the space bar. A
part of the file appears in the View Window. Press the [Esc] key to return.

4. Press the [Enter] key for routine messages and messages with addressee
code (no password).

Display Receive Message <R0971123.002->
FROM FURUNO
TO FRONTIER
THE QUICK BROWN FOX JUMPS OVER LAZY DOG.
ABCDEFGHIJKLMNOPQRSTUVWXY Z. 1234567890

Ctrl+P: Print

Sample received message
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For messages with both addressee code and password, the password entry
window appears. Enter the password and then press the [Enter] key. If the
password is entered incorrectly, the buzzer sounds. Reenter the password.

Receive Message Log

MessageNo. LES Priority Size
R0021106.001 KDDI Normal 767
R0021105.002
R0021105.001
R0021101.001 KDDI Normal 3256
R0021024.001 KDDI Normal 8251

Rec date & Time Status
02-11-06 16:10  Saved

02-11-05 14:15
E \02—11—01 3:45  Printed

02-10-2413:20  Saved

J PASS woRrbD: ||

Enter: Display S: Save D: Delete

Location of password
5. To print a message, press the [P] key while pressing the [Ctrl] key.

Receive Message (SECRET)
A Appears only for confidential messages
Message No. : R0970323.001
Message Ref. No. : 00000000
LES :LESor LESID
Priority : Normal
Message Size : 205 characters

Receive Date & Time : 02-02-25

Sample printout
6. Press the [Esc] key three times to return to the standby display.
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About attachments

The FELCOM 16 receives a file with an attachment over a landline two ways.
(The method depends on the LES.)

° Mail main text and text mail which includes information about the attachment.

e Attachment data

— Mail and attachment file data
Attachment data

Receive Message Log
MessageNo. LES Priority Size Addressee Recdate& Time Status
g R0021105.002 Normal 18 02-11-05 17:40
R0021105.001 KDDI Normal 210 02-11-0517:30  Printed
R0021104.001 KDDI Normal 1234 02-11-04 14:15  Printed
R0021101.001 KDDI Normal 3256 OFFICER 02-11-01 3:45 Printed
R0021024.001 KDDI Normal 8251 02-10-2413:20  Saved

Memory Available: 3317 Bytes

Enter: Display S:Save D: Delete

Receive message log

Some files stored on the Receive Message Log may not be readable. Choose
the file and press the [Enter] key. If the file is unreadable, because itis in a
language other than English (for example, Japanese). Press the [S] key to save
the file to the hard disk. Open the file with a different application.

One attachment
Display Receive Message <R0021105.001->

FROM : FURUNO
TO: FRONTIER

1 attachment
18 bytes, test

Text

|
Attachment name

Example of main text and text mail with attachment data
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4.2.4  Automatically printing received messages

You may automatically print received messages (except confidential or password

affixed) as follows:

1. Press the [F8] key to display the Setup menu.

2. Press the [5] key to display the Auto Mode Setup menu.

Auto Mode Setup

Auto Log Print

Receive Alarm

Auto Receive Message Save
Auto Receive Message Print
Data Report & Polling Print
Auto EGC Message Save
Auto EGC Message Print

OFF
OFF
OFF
OFF
OFF

Auto mode setup menu
Press the [1] or [|] key to choose Auto Receive Message Print.

Press the [Enter] key.

Press the [1] key to choose ON.

Press the [Enter] key to close the window.
Press the [Esc] key twice.

No Ok

4.2.5 Saving received messages to the hard disk

1. Press the [F6] key.

2. Press the [2] key to display the Receive Message Log.

ENTER: Display S: Save D: Delete

Receive Message Log
MessageNo. LES Priority
R0971106.001 KDDI Normal 32767

02-02-04 16:10

R0971105.002 KDDI Normal 200 CAPTAIN 02-02-0517:30
R0971105.001 KDDI Normal 1234 02-02-05 14:15
R0971101.001 KDDI Normal 3256 OFFICER 02-02-01 3:45
R0971024.001 KDDI Normal 8251 02-01-24 13:20

Memory Available: 3317 Bytes

Size Addressee Recdate & Time Status

Saved
Printed
Printed
Printed
Saved

Sample delete message screen

3. Press the [1] or [|] key to choose a file. To confirm contents of a file, press the
[Enter] key. For confidential messages, the password entry window appears
after pressing the [Enter] key. Enter the password and press the [Enter] key.

4. Press the [S] key to copy the file to the hard disk. For confidential messages
the password entry window appears. Enter password and press the [Enter]

key.

Note: If a file by that name already exists on the hard disk, “Already exist on

DISK.” appears.
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4.2.6  Automatically saving received messages to the hard disk
You may automatically save received messages other than confidential or
password-affixed messages to the hard disk as follows:

1. Press the [F8] key.
2. Press the [5] key to display the Auto Mode Setup menu.

Auto Mode Setup
Auto Log Print OFF
Receive Alarm OFF
Auto Recelve Message Save OFF
Auto Receive Message Print OFF
Data Report & Polling Print OFF
Auto EGC Message Save
Auto EGC Message Print

Auto mode setup menu

Press the [1] or [|] key to choose Auto Receive Message Save.

4. Press the [Enter] key to open the auto receive message save options
window.

Press the [1] key to choose ON.

Press the [Enter] key to close the window.

7. Press the [Esc] key twice.

w

o o

Note: To designate directory where to store receive messages, see paragraph
29.2.
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4.2.7 Deleting received messages

1. Press the [F6] key to display the Logs menu.
2. Press the [2] key to choose Receive Message Log.

Receive Message Log
MessageNo. LES Priority Size Addressee Recdate& Time Status
R0971106.001 KDDI Normal 32767 02-02-04 16:10  Saved
R0971105.002 KDDI Normal 200 CAPTAIN 02-02-0517:30 Printed
R0971105.001 KDDI Norma 1234 02-02-05 14:15  Printed
R0971101.001 KDDI Norma 3256 OFFICER 02-02-01 3:45 Printed
R0971024.001 KDDI Norma 8251 02-01-2413:20  Saved

Memory Available: 3317 Bytes

ENTER: Display S: Save D: Delete

Sample receive message log

3. Press the [1] or [|] key to choose the message you want to delete. You can
confirm the contents of the message by pressing the [Enter] key. For
password-affixed messages, the password entry window appears. Enter the
password and press the [Enter] key. After confirming the contents, press the
[Esc] key.

4. Press the [D] key. You are asked if you are sure to delete the message. For
password affixed-message, the password entry window appears. Enter
password and press the [Enter] key.

Receive Message Log
Message No. LES Priority Size Addressee Recdate & Time Status
R0021106.001 KDDI Normal 32767 02-11-06 16:10  Saved
R0021105.002 KDDI Normal 200 CAPTAIN 02-11-0517:30 Printed
R0021105.001 KDDI Normal 1234 02-11-0514:15  Printed
R0021101.001 KDDI Normal 3256 OFFICER 02-11-01 3:45 Printed
R0021024.001 KDDI Normal 8251 02-10-2412:20  Saved

Memory Available: 331 | No

Enter: Display S: Save D: Delete

Delete window

5. Press the [Enter] key to delete the message, or choose No and then press
the [Enter] key to escape.
6. Press the [Esc] key twice to return to the standby display.
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Display Log

The Display Log stores the particulars of the latest 50 received and transmitted
messages. When the log becomes full, the oldest message is automatically
deleted.

Displaying and printing the display log

1. Press the [F6] key to display the Logs menu.
2. Press the [4] key to show the Display Log.

2, 3, 4. 5. 6, 7 8 9 0 1
Log
1. SR Mé&wgeNo. Type Pri Dae Time LES Station Size Cond
“01 S T0971110.001 TELEX Nrm 02-02-25 19:10 302 FURUNO 12345 Success
02 R R0971110.001 TELEX Nrm 02-02-25 19:25 302 — ~— ~— — — 365 Success
50 (max)
Ctrl+P: Print

Sample display log
3. To scroll the Display Log screen, press the [1] key several times.
4. To print the log, press the [P] key while pressing the [Ctrl] key and press the
[P] key. To stop printing, press the [Esc] key.

Display log description

1) Log no.

2) SIR S: Send message, R: Received message

3) Message No.: Message no. or file name

4) Type: Message type (Telex, e-mail, etc.)

5) Pri: Communications priority; “Nrm” is for general administrative
communications.

6) Date: Date message was received (transmitted).

7) Time: Time message was received (transmitted).

8) LES: ID of LES which handled the message

9) Station: Transmitting station name. Blank for unregistered station or
received message.

10) Size: Size of message in bytes

11) Cond: Transmission results. Blank if a received message.
Success: Successful transmission
Fail: Failed transmission

Rejected: Message rejected by LES
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4.3.2

4-32

Automatic printing of display log

The Display Log can be automatically printed every 24 hours as follows:

1. Press the [F8] key to display the Setup menu.

2. Press the [5] key to display the Auto Mode Setup menu.

o0k w

Auto Mode Setup

Auto Log Print

Receive Alarm

Auto Receive Message Save
Auto Receive Message Print
Data Report & Polling Print
Auto EGC Message Save
Auto EGC Message Print

OFF
OFF
OFF
OFF
OFF

Auto mode setup menu
Auto Log Print is selected; press the [Enter] key.

Press the [1] key to choose ON.
Press the [Enter] key to close the window.

Press the [Esc] key twice to return to the standby display. The log will be

printed at 00:00 (UTC) each day.




4.4

44.1

4. INMARSAT C OPERATIONS

EGC Messages

When an EGC message is received, RECEIVING EGC MESSAGE appears at
the bottom left corner of the display. If Auto Message Save in the Auto Mode
Setup is ON, EGC messages are automatically saved. EGC messages are
automatically received, printed and saved to the terminal unit selected with EGC
Output Port on the System Setup menu. The memory capacity for EGC
message is 32 Kbytes. When the EGC message memory becomes full, the
oldest EGC message is automatically deleted.

Displaying and reprinting EGC messages

1. Press the [F4] key.
EGC

1. Display EGC Message

2. EGC Network ID

EGC menu
2. Press the [1 key to show the Display EGC Message screen.

File Edit Transmit Reports Logs Options Setup Position StopAlarm

Display EGC Message <E0021102.023>

EGC Message --- MET Navarea Warning or MET Forecast ---
Message Sequence No. : 00472

LES : KDDI
Priority - Urgent
Size : 285 characters

Receive Date & Time : 02-11-02 06:08 (UTC)

ZCzZC

NAVAREA XI WARNING

NAVAREA X1 0752.

ARAFURA SEA.

DERELICT F/V PARTIALLY SUBMERGED ADRIFT
IN 10-12.6S 133-19.6E, GEODETIC DATUM
UNKNOWN, AT 180200Z NOV.

CANCEL 0749/02.

Ctrl+P: Print Ctrl+S: Save

Sample display EGC message screen
Press the [1] or []] key to scroll the screen.
. To print a message, press the [P] key while pressing the [Ctrl] key and press
the [P] key. To stop printing, press the [Esc] key.
To save the message, press the [S] key while pressing the [Ctrl] key.
Press the [Esc] key to return to the standby display.

W

o 0

EGC messages can be automatically saved to the hard disk. See paragraph
2.4.4 for details.
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4.4.2

4-34

Displaying EGC closed network ID (ENID)

To join a FleetNET™ service, an MES must be registered with an information
provider. The information provider adds the MES to the group which is to receive
the service, by downloading a Group Call ID (via an LES which supports
FleetNET™ broadcasts), uniquely addressed to the MES. The MES stores the
ID and can accept broadcasts from the information provider. The MES operator
cannot change this stored EGC closed network IDs (ENIDs). Up to 64 ENIDs are
stored on a non-volatile memory.

The ENID stored can be accessed for downloading and deleting via the satellite
path. It is possible for an MES operator to inhibit (or activate as required), via the
terminal unit, selected ENIDs previously downloaded.

Along with the ENID the name of the information provider is stored. In the event
that a download command is received and the ENID storage area is full, an
ENID which has been inhibited (de-activated) by the MES operator will be written
over. If none has been inhibited, then the new download is not accepted.

Follow the procedure below to inhibit or activate an ENID.

1. Press the [F4] key to display EGC menu.
2. Press the [2] key to display the EGC Network ID List.

File Edit Transmit jS€]& Reports Logs Options Setup Position StopAlarm

EGC |
1.Di EGC Network ID List

ﬂ ENTER: Activate SPACE: Inhibit Ctrl+P: Print ESC: Quit
Mark "' means activation

01 * 00001 202 FURUNO
02 * 00002 202 FURUNO
03 * 04001 202 FURUNO
04 * 04002 202 FURUNO
05 * 04003 202 FURUNO
06 * 04005 202 FURUNO
07 * 04006 202 FURUNO
08 * 04007 202 FURUNO

EGC network ID list
3. Press the [1] or [|] key to choose the ENID you want inhibit (or activate).
4. Press the space bar to inhibit, or the [Enter] key to activate. The asterisk
mark disappears when an ENID is inhibited.
5. Press the [Esc] key to return to the standby display.
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Displaying the EGC message log

1. Press the [F6] key to show the Logs menu.
2. Press the [3] key to display the EGC message log.

EGC Message Log
Message No. LES Priority Size Seg. No. Rec date& Time Type

E0021118.028 KDDI Urgent 428 01641 02-11-18 10:27 ME
E0021117.002 KDDI Safety 1455 02035 02-11-1705:23 U.M Rct
Memory available: 32767 Bytes

ENTER: Display S: Save D: Delete

EGC message log
Scroll: Press the [1] or []] key.
Display message: Press the [Enter] key.
Save message: Press the [S] key.
Delete message: Press the [D] key. The Delete window appears
and Yes is selected; press the [Enter] key.

3. Press the [Esc] key twice to return to the standby display.
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D.

DATA REPORTING AND POLLING

5.1

This chapter provides the information necessary for data reporting and polling
reception. Data reporting provides automatic data transmission at regular
intervals from your ship to your home office. When your ship receives a polling
command from your home office; that is, a request for navigation data from your
ship, it automatically transmits this data to your home office.

No operator intervention is required during polling reception.

Satellite

R,

Data report /\/‘ E
Message report Polling
= 7
ﬂ e S
N =

Mobile Earth Station Land Earth Station Subscriber

Data Reporting

Data reporting provides automatic data transmission at predetermined intervals
from your ship to your home office. The data are position, speed, bearing and
other data sent from the internal GPS navigator.

The data transmitted from the FELCOM 16 is temporarily stored in a data
reporting file at the LES. When an operator at your home office accesses the
LES, the LES delivers the data to your home office. Some LESs may deliver it
without being accessed.

Data reporting can be initiated by setting a data report on the FELCOM 16 or
receiving a polling command from your home office.

FELCOM 16 offers two types of reports as follows:
e Data reporting (on MES signaling channel)

Refer to paragraph 5.1.1.
eMessage reporting (on MES message channel)

Refer to paragraph 5.1.2.
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51.1 Setting a data report

1. Press the [F5] key to display the Reports menu.
—— Reports

1. Data Report

2. Message Report
3. Data Network 1D

Reports menu
2. Press the [1] key to choose Data Report.

—— Data Report ——

1. Data Report 1

2. Data Report 2
3. Data Report 3
4. Data Report 4

Data report menu
3. Press [1], [2], [3] or [4] as appropriate.

Data Report

Data Report Programming
XN o

Report Length  Position and Course/Speed
Destination
DNID
LESID
Member No.
Activation Regular Interval
Interval Time 00:10
Report Times 1 (---: No Limit)
Start Timel -
Start Time2
Start Time3
Start Time4

Data report menu

4. Status is selected; press the [Enter] key to open the status options window.
5. Press the [|] or [1] key to choose appropriate option.

OFF: Data report off

ON: Enhanced Data Report (Data report w/confirmation)

ON: Usual Data Report (Standard data report)

For assured transmission, choose ON: Enhanced Data Report.

Press the [Enter] key to close the window.

Press the [{] key to choose Report Length.

Press the [Enter] key to open the report length options window.

Press the [|] or [1] key to choose appropriate option.

Pasition only: Own position

Position and Course/Speed: Position, course and speed

Position and Course/Speed with SEA INF: Position, course, speed, water
temperature, tide, and depth

© 0N

10.Press the [Enter] key to close the window.
11. Press the [{] key to choose Destination.
12.Press the [Enter] to show the DNID list.
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13.Choose DNID (Data Network ID) desired and press the [Enter] key. (LES ID
and Member No. are automatically selected according to DNID.)14. Press
the [{] key to choose Activation.

14.Press the [Enter] key to open the activation options window.

15.Press the [|] or [1] key to choose “Regular Interval” or “Daily” as appropriate.

16.Press the [Enter] key to close the window.

17.Do one of the following depending on the selection you made at step 15.

“Regqular Interval” selected at step 15

(1) Press the [{] key to choose Interval Time.

(2) Press the [Enter] key to open the interval time entry window.

(3) Key in the interval time. The interval should be at least 10 minutes.
(4) Press the [Enter] key to close the window.

(5) Press the [{] key to choose Report Times.

(6) Press the [Enter] key to open the report times entry window.

(7) Key in the report times, or press the [Back Space] key to display “---“ to
choose “No Limit” to transmit data until the “Status” setting is turned OFF.

(8) Press the [Enter] key to close the window.

“Daily” selected at step 15

(1) Press the [{] key to choose Start Time 1.

(2) Press the [Enter] key to open the start time entry window.
(3) Key in the start time, in 24-hour notation.

(4) Press the [Enter] key to close the window.

(5) If necessary enter start times for Start Time 2-4.

18.Press the [Esc] key to show the update window.

Data Report
Data Report Programming

Status OFF
Report Length  Position and Course/Speed
Destination

DNID

LESID

Member No.
Activation Regular Interval

Interval Time 01:00

FELERMIUEY 24 (---:NoLimit)

Start Timel : Update
Start Time2  --:-- |_________
Start Time3 --l-- Yes I No
Start Timed  --:--

Data report menu (regular interval reporting)

19.Yes is selected; press the [Enter] key to register settings.
20.Press the [Esc] key to return to the standby display.
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5.1.2  Setting a message report

1. Press the [F5] key to display the Reports menu.
—— Reports

1. Data Report

2. Message Report
3. Data Network 1D

Reports menu

2. Press the [2] key to display the Message Report menu. Four addresses may
be registered.

Message Report
1. Message Report 1
2. Message Report 2
3. Message Report 3
4. Message Report 4

Message report menu
3. Press [1], [2], [3] or [4] as appropriate

Message Report
Message Report Programming
Status OFF
Station Name
Destination Type TELEX
Prefix Code
Country/Ocean Code
Station ID
Modem Type
Address
Subject
LESID
Activation Regular Interval
Interval Time 00:10
Report Times 1 (---:NoLimit)
Start Timel
Start Time2
Start Time3
Start Timed -
Report Contents NAV
File

Message report menu

4. Press the [{] key to choose Status.

Press the [Enter] key to open the status options window.

6. Press the [|] or [1] key to choose “ON” or “OFF” as appropriate.
ON: Message report on
OFF: Message report off

o

~

Press the [Enter] key to close the window.
Press the [{] key to choose Station Name.
9. Press the [Enter] key to display the Station List.

©
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10.Press the [|] or [1] key to choose a station.

Note: You may sort the list by group name, station name or communication
type as follows:
Group name: Each press of [Ctrl] + [G] sorts the list by group name,
ascending or descending order.
Station name: Each press of [Ctrl] + [N] sorts the list by station name,
in ascending or descending order.
Comm. type: Each press of [Ctrl] + [T] sorts the list by communication
type, in ascending or descending order.
11. Press the [Enter] key to close the window.
12.For e-mail following a)-d) below. For other communication formats, go to step
13.
a) Press the [{] key to choose Subject.
b) Press the [Enter] key to show the title window.
c) Type title.
d) Press the [Enter] key to close the window.
13.Press the [{] key to choose LES ID.
14.Press the [Enter] key to display the LES List.
15.Press the [|] or [1] key to choose an LES.
16.Press the [Enter] key to close the window.
17.Press the [{] key to choose Activation.
18.Press the [Enter] key to open the activation options window.
19.Press the [|] or [1] key to choose “Regular Interval” or “Daily” as appropriate.
20.Press the [Enter] key to close the window.
21.Do one of the following depending on the selection you made at step 19.
“Reqular Interval” selected at step 19
(1) Press the [{] to choose Interval Time.
(2) Press the [Enter] key to open the interval time entry window.
(3) The interval should be at least 10 minutes.
(4) Press the [Enter] key to close the window.
(5) Press the [{] key to choose Report Times.
(6) Press the [Enter] key to open the report times entry window.

(7) Key in the report times, or press the [Back Space] key to display “---“ to
choose “No Limit” to transmit data until the “Status” setting is turned OFF.

(8) Press the [Enter] key to close the window.
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“Daily” is selected at step 19

(1) Press the [{] to choose Start Time 1.
(2) Press the [Enter] key to open the start time entry window.
(3) Key in the start time.
(4) Press the [Enter] key to close the window.
(5) If necessary, key in the start time of Start Times 2-4.

22.Press the [{] key to choose Report Contents.

23.Press the [Enter] key to open the report contents options window.
24.Press the [L] or [T] key to choose the contents of message report and press

the [Enter] key to close the window.
Position, speed, course

NAV:
NAV(R):

FILE:

25.Press the [Esc] key to show the update window.

Position, speed, course. The difference between this and “NAV”
above is that blank areas in data are shortened to lessen toll

charge.

Choose a file. (When chosen “FILE” is activated. Choose file

with cursor and press the [Enter] key.)

PIN Code
Message Report Programming

Status
Station Name

Destination Type

Prefix Code

Country/Ocean Code

Station ID
Modem Type
Subject
LESID
Activation
Interval Time
Report Times
Start Timel
Start Time2
Start Time3
Start Time4

Report Contents

File

Message Report

ON
FRNINMBTSTSES
TELEX

583
343199710

303 (KDDI)
Daily
01:00
24 (---:NoLimit)
08:00

NAV

Update
| No

Message report screen

26.Yes is selected; press the [Enter] key.
27.Press the [Esc] key twice to return to the standby display.
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Automatic printing of data report, polling command

Data reports and polling commands are automatically printed, in the default state.
If you do not require automatic printing of data reports or polling commands do
the following:

1. Press the [F8] key to open the Setup menu.
2. Press the [5] key to choose Auto Mode Setup.

Auto Mode Setup
Auto Log Print OFF
Receive Alarm OFF
Auto Receive Message Save OFF
Auto Receive Message Print OFF
Data Report & Polling Print OFF
Auto EGC Message Save
Auto EGC Message Print

Auto mode setup menu

3. Press the [|] or [1] key to choose Data Report & Polling Print.

4. Press the [Enter] key to open the options window.

5. Press the [|] key to choose OFF. (Choose ON for automatic printing of data
report and polling command.)

6. Press the [Enter] key to close the window.

7. Press [Esc] key twice.
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5.2

5.2.1

5-8

Polling

When the FELCOM 16 receives a polling command from your home office it
automatically transmits data to your home office. The data are position, speed,
bearing and other data sent from a navigator or an interface unit.

A polling command from your home office can also activate a data report or
message report if the corresponding setting is completed on the FELCOM 16. If
a polling command with a file name is received, the FELCOM 16 transmits the
file to your home office.

Polling commands

This paragraph shows you how to make the polling command at your home
office.

There are two kinds of polling commands: one is sent on the MES signalling
channel and the other is sent on the MES message channel.

¥

Polling command on MES signalling channel

Request a land station to make the polling command because the format varies
with land station.

Polling command on MES message channel

To make the polling command, enter D???, hyphen, PIN code (max. 8 digits),
hyphen, file name, colon.

To send file data, type a hyphen and file name. Then, only the file specified in
the directory of the Message Directory is transmitted. If neither hyphen nor file
name is entered, nav data (own ship position, course, speed, etc) is transmitted.
For PIN Code setting, refer to the next page.

File Name
|

!
D?72-XXXXXXXX-TEST:

|

PIN Code

Polling command
If the above polling command PIN code and the PIN code set on the message

report menu (see next page) are the same, data is sent to the subscriber set on
the message report menu.
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¢ PIN Code

The PIN (Personal ID Number) code is an eight-digit code number agreed
upon by communicating parties, and there is no rule for determining PIN
code. It is a password used in message reporting. When a ship receives a
polling command w/PIN code from a shore subscriber and the code matches
that of the ship, the ship sends a message report.

To register PIN code number do the following:

1. Press [F5] to show the Report menu.
2. Press the [2] key to open the Message Report menu.
3. Press [1], [2], [3] or [4] key to show the following menu.

For polling command
‘ Message Report
PIN Code

Message Report Programming

Status OFF

Station Name
Destination Type TELEX
Prefix Code
Country/Ocean Code
Station ID
Modem Type
Address
Subject

LESID

Activation Regular Interval
Interval Time 00:10
Report Times 1 (---:NoLimit)
Start Timel
Start Time2
Start Time3
Start Time4 i--

Report Contents NAV
File

Message report menu

4. PIN Code is selected; press the [Enter] key to open the PIN code entry
window.

Enter PIN code number (max. 8 digits).

Press the [Enter] key.

7. Follow from step 4 on page 5-4.

o 0
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5.2.2

5-10

Other polling commands
Telex

P???/PIN Code/TELEX/LES number/Country number/Subscriber’s number/File
name:

E-mail

P???/PIN Code/EMAIL/LES number/ E-mail address/File name:

Public Switched Telephone Network

P???/PIN Code/PSTN/Modem type/LES number/Country number/Subscriber’s
number/File name:

Modem type is selected from T30, V21, V22B, V22, V23, V26B, V26T, V27T or
V32.

Packet Switched Data Network

P???/PIN Code/PSDN/LES number/Country number/Subscriber’s number/File
name:

Data Network Identification

P???/PIN Code/DNID/LES number/Subscriber’s number/File name:

Facsimile

P???/PIN Code/FAX/LES number/Country number/Subscriber’s number/File
name:

Telex service

P???/PIN Code/SPEC/LES number/Country number/Subscriber’s number/File
name:

For ship-to-ship communication, country number is ocean region number.
Subscriber’s number includes Station ID, Telex ID, etc.

If file name is not specified (P???/PIN Code/~/Subscriber’'s Number), the
FELCOM 16 sends ship’s position, speed and course.

For example, you transmit polling command to MES of PIN code 12345678 via
KDDI station (Pacific Ocean: 203) specifying telex number 720-5644325. Then,
that MES transmits position, speed, bearing, water temperature, current and
depth.

P??7?/12345678/TELEX/203/720/5644325/:

To have other MES transmit position, speed and bearing by e-mail to
abc@furuno.co.jp, for example, use the following command.

P???/12345678/EMAIL/203/abc@furuno.co.jp:



5.2.3 Polling reception

5. DATA REPORTING AND POLLING

No operator intervention is required during polling reception.

The printer prints the status of polling reception and transmits data in response

to polling request as shown below.

TX start frame (time) Data reporting

POLLING Message - - - Program Unreserveq Data Reporting = -
D> LESID 1101 (Telnor S.S.Inc)

Sub Address : 000 Member Number : 001 Response: No Response

Receivg/Data & Time: 02-02-25 00:01 (UTC) Received
Polling
Start Frame: 00030 Interval: 00030 >—— TX interval Command

02-02-25 00:01 (UTC)
Data Report Program has been initiated by Polling.

POLLING Message - - - Initiate Unreserved Data Reporting - - -

:101 (Telnor S.S.Inc
SubAddress 1000  Member Number :001 Respong Data Report_>
Receive Data & Time: 02-02-25 00:01 (UTC)

TX data set on Data

Start Frame: 00030 Interval: 00030

,,,,,,,,,,,,,,,,,,,,,,,,,, Report . ________

Data Reported (Poll Response)

LES :Telnor SS.Inc  Date  :02-02-25

DNID :0000D Time :00:03 (UTC)

Member No. :001 Tx message

Position LAT  10:14.03N recipient and
LON 124:36.81E TX data

02-02-25 00:06 (UTC)
Successful Data Report Sending.

. Received
Receive Message Polling
Message No. : R0020205.002 Command
Message Ref. No. : 00616923

LES : KDDI

Priority : Normal

Message Size 121 characters

Receive Data & Time: 02-02-25 04:07 (UTC)
KDD INMARSAT-C SERVICE 25-FEB-02 04:02:28 UTC REF:616923
XXXXXXXXX ABCD X viaKDDI LES

D??7?2-12345678-test:test

02-02-25 04:09 (UTC)
Successful Sending message.

Sent Message Tx message

DELIVERY CONFIRMATION OFF recipient and
TX data
Message File : Report Message Size : 284 characters
LES : KDDI Date 1 02-02-25
Priority : Normal Time 1 04:09 (UTC)
Destination : TELEX 582 (IA5)
582+
Date & Time 02-02-25 04:07 (UTC)
Position LAT 12:34.56N Water Temp
LON 123:45.67E Water Current KTS

Course 321.1
Speed 1L1KTS Depth FT

Sample MES message channel printout
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5. DATA REPORTING AND POLLING

5.3

5.3.1

5-12

DNID (Data Network Identification)

Group data exchange (polling, data reporting) is available by registering with an
LES which provides such services. When you make a contract with an
information provider, DNIDs are downloaded from the information provider to
your FELCOM 16, via the appropriate LES.

Up to 64 DNIDs can be downloaded to the FELCOM 16. You can see which
DNIDs are stored as below.

Displaying DNID

It is necessary to contract with an LES to exchange data within a group. The
LES sends a DNID (Data Network Identification) number to each member of the
group. The FELCOM 16 can store 64 DNIDs.

1. Press the [F5] key to display the Reports menu.
2. Press the [3] key to display the Data Network ID list.

Sub address—‘ Member number using DNID
Data Network ID
Mark "*' means activation. CtrI+J3: Print
No. Act DNID LES Subaddr Member Text
01 * 00004 101 000 001
02 * 00004 101 002 003
03 = 23456 101 002 223
04 + 03333 101 002 044
05 03333 101 000 044
06 * o7777 101 000 099
o7 * 09999 101 000 088
08
09
10
*

DNID effective

Data network ID list

Note: Asterisk-marked DNIDs are available for use.



5. DATA REPORTING AND POLLING

5.3.2 Enabling/Disabling DNID

DNID can be enabled or disabled as follows:

1. Press the [F5] key followed by the [3] key to show the Data Network ID list.

Press the [{] or [T] key to choose desired DNID from the data network ID list.

3. Press the [Enter] key to enable or disable the DNID as appropriate. An
asterisk appears next to the DNID when it is enabled.

Note: If a DNID is disabled during data reporting, “running data program
(poll)” is displayed and polling is cancelled.

4. Press the [Esc] key twice to return to the standby display.

N

5-13
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(This page intentionally left blank.)
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6. OTHER FUNCTIONS

This chapter describes how to abort operation, scan NCS, choose EGC and
NCS channels and display LES information.

6.1  Aborting an Operation

You can abort transmission, receiving or scanning (on the NCS common
channel) as follows:

1. Press the [F7] key to display the Options menu.

—— Options
2. Logout
3. Abort
4. Select NCS
5. Ocean Region
6. LES Information
7. Test

Options menu (when FELCOM 16 functions as Inmarsat MES)
2. Press the [3] key to choose Abort.

—— Options ]

Abort

|No

Abort screen

3. Yes is selected; press the [Enter] key to abort current operation.
The message “FORCED CLEARING” replaces “SENDING” or “RECEIVING”
at the bottom of the screen. When the process has been aborted, the
message “Process Aborted. Press any key to escape.” appears.

Note: If aborting is attempted in modes other than those mentioned above, the
message “Ignored: Can not abort current process.” appears.
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6. OTHER FUNCTIONS

6.2

6-2

Scanning NCS Common Channel

When “unsync” condition (UNSYNC displayed at bottom center of the screen)
continues for six minutes and error rate in received message is greater than 80%
(BBER indication reads more than 80), choose suitable ocean region. Note that
the FELCOM 16 must be IDLE and the MES mode must be INMARSAT C in
order to scan common channel.

If the FELCOM 16 is not idle the message “Ignored: MES is not idle” is displayed.
Press any key to erase the message and then wait until the equipment is in idle
state.

1. Press the [F7] key to display the Options menu.
2. Press the [5] key to display the Ocean Region menu.

—— Options —
Ocean Region

Auto
West-Atlantic
East-Atlantic

Indian

b NCS you are currently tuned to appears in reverse video.

Ocean region menu

3. Press the [{] or [T] key to choose another NCS and press the [Enter] key. If
Auto is selected, FELCOM 16 scans all ocean regions in turn.

—— Options —
Ocean Region

Auto |
West-Atlantic
East-Atlantic Start

Pacific |- --------

NCS scan confirmation screen
4. Yes is selected; press the [Enter] key to start the scanning.

The message “Starting Scan Process. Press any key to escape.”
appears during the scanning.

5. Press the [Esc] key twice to return to the standby display.



6. OTHER FUNCTIONS

Choosing EGC Receiving Channel

EGC channel can be selected when the terminal unit is set to operate as an
EGC-only receiver. However, this procedure is shown for reference only;
currently there is only one EGC channel per NCS.

1. Press the [F7] key to display the Options menu.
—— Options

2. Logout

3. Abort

4. Select EGC Ch.
5. LES Information
6. Test

Options menu (when FELCOM 16 functions as EGC receiver)
2. Press the [4] key to choose Select EGC Ch.

EGC Channel List

ENTER: Set ESC: Quit
————— ek I AP

UReclogg | 12580 | 10840* | 11088*
I I I

EGC channel list

3. Choose desired channel and then press the [Enter] key.
4. Press the [Esc] key to return to the standby display.
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6. OTHER FUNCTIONS

6.4

6-4

Choosing NCS Channel

You may select NCS common channel as shown below. Currently, each satellite
transmits one global beam. In the future, the satellites will transmit multiple spot
beams, namely, the NCS will have multiple channels.

The below procedure is provided for reference.

1. Pressthe [F7] key to display the Options menu.
2. Press the [4] key to display the NCS Channel List.

—— Options —|
1. Login

NCS Channel List

PR _| _________ _‘ _________
No | AOR (WEST) | AOR (EAST)

+

|

IID FREQ | ID FREQ |
Bl e Amm - - e e S

|

|

|

|

|

|

|

|

01 | 044 | 11080* | 144 | 12580* | 244 | 12580* | 344 | 10840*

0210 | 1 1 2 |

3 1
3 |
3 |
3 |
3 |
3 1
3 |

[eNeolNoNelNoNo]

N

NCS channel list

3. Choose desired channel and then press the [Enter] key. Then, the FELCOM
16 starts to synchronize with the NCS channel selected.
4. Press the [Esc] key to return to the standby display.



6.5

LES Information

Each time you log in LES data is automatically downloaded through the NCS
common channel to the FELCOM 16, and saved to the LES Information display.

You may view this display as follows:

6. OTHER FUNCTIONS

1. Press the [F7] key to show the Option menu.

2. Press the [6] key (Inmarsat MES) or [5] key (EGC receiver) to show the LES

—— Options
2. Logout
3. Abort
4. Select NCS
5. Ocean Region
6. LES Information
7. Test

FELCOM 16 functions

as Inmarsat MES

Information display.

LES Informatig)

—— Options
2. Logout
3. Abort
4. Select EGC Ch.
5. LES Information
6. Test

FELCOM 16 functions
as EGC receiver

Options menu

From left in order B8 to B1

LESIDName Status " Setvices  TDM Ch.
201  Telenor SS.Inc 11111000
202  Stratos M.N. 11111000
203 KDDI 11111000
204  Telenor SS.AS 11111000
208 Korea Telecom 11111000
210  SingaporeT. 11111000
211 Beijing Marine 11111000
212  Xantic (NED) 11111000

From left in order 1B8 to IB1, 2B8 to 2B1

If bit is 1 alphabet is displayed.

LES information display
3. Use the [1] or [|] key to scroll the list.
4. Press the [Esc] key twice to return to the standby display.
Description of LES information table

Bit No. | Status Flag Meaning
B8 Return link speed 1 600 bps
0 300 bps
B7 Operational or spare satellite 1 Operational
operation 0 Spare
B6 LES status 1 In service
0 Out of service
B5 LES status 1 Clear
0 Congested
B4 Used only by land earth stations | 1 Terrestrial links open
0 Terrestrial links closed
B3-1 Spare
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Services:

Alphabet shown only when Flag is “1” for a bit.

Bit No. | Flag Meaning Display
1B8 1 Maritime distress alerting A

0 No Maritime distress alerting None
1B7 1 SafetyNET traffic S

0 No SafetyNET traffic None
1B6 1 Inmarsat-C traffic C

0 No Inmarsat-C traffic None
1B5 1 Store and Forward T

0 No Store and Forward None
1B4 1 Half Duplex H

0 No Half Duplex None
1B3 1 Full Duplex D

0 No Full Duplex None
1B2 1 Closed Network N

0 No Closed Network None
1B1 1 FleetNET Traffic F

0 No FleetNET Traffic None
2B8 1 Prefixed store and forward message supported P

0 Prefixed store and forward message not supported None
2B7 1 Land mobile alerting Not used

0 No Land mobile alerting
2B6 1 Aero-C service supported

0 Aero-C service not supported
2B5 1 ITA2 transmission supported I

0 ITA2 transmission not supported None
2B4 1 Data transmission supported B

0 Data transmission not supported None
2B3 1 Basic X.400 supported X

0 Basic X.400 not supported None
2B2 1 Enhanced X.400 supported E

0 Enhanced X.400 not supported None
2B1 1 Low power C MES supported L

0 Low power C MES not supported None

TDM Ch.: TDM channel used by LES to transmit.




7.

MAINTENANCE,
TROUBLESHOOTING

7.1

This chapter provides the information necessary for the maintenance and
checking of the FELCOM 16. Please read the safety information at the beginning
of this manual before attempting any maintenance procedure.

General Checking and Maintenance

Turn off the power before conducting any maintenance procedures other than
the cleaning of the communication unit.

NOTICE

Do not apply paint, anti-corrosive sealant
or contact spray to coating or plastic
parts of the equipment.

Those items contain organic solvents that
can damage coating and plastic parts,
especially plastic connectors.

Cleaning the communication unit

Dust and dirt can be removed from the communication unit with a soft, dry cloth.
DO NOT use chemical cleaners. They may remove paint and markings or
deform the equipment.

Checking connectors and earth terminal on the communication unit

Check that the connectors and earth terminal on the communication unit are
tightly fastened. If the copper strap (earth material) has rusted, clean it.

When the power can’t be turned on

When the communication unit cannot be turned on do the following:

e Check that the power cable connector on the rear panel of the
communication unit for tightness.

e Check if the ship’s mains switchboard is turned on.

e Have a qualified technician check the power voltage at the power connector
on the rear of the communication unit.
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7. MAINTENANCE, TROUBLESHOOTING

7.2 Diagnostics
The system is equipped with a diagnostic test which check it for proper
operation.

7.2.1 Self test at power on

The terminal unit performs the ROM sum check and RAM read and write test
when turned on. If the test results are normal the equipment goes into standby. If
error is found you cannot transmit. Contact your dealer for advice.

7.2.2 Testing the communication unit through the keyboard,
displaying program version no.

The communication unit must be idle to execute the test.

1. Press the [F7] key to display the Options menu.

—— Options —— Options

2. Logout 2. Logout

3. Abort 3. Abort

4, Select NCS 4. Select EGC Ch.

5. Ocean Region 5. LES Information

6. LES Information 6. Test

7. Test
FELCOM functions as FELCOM functions as
Inmarsat MES EGC receiver

Options menu

2. Press the [7] key ([6] key if the FELCOM 16 functions as an EGC receiver) to
display the Test menu.

Test

1. PV Test

2. PV Test Result
3. Diagnostic Test

Test menu
3. Press the [3] key to choose Diagnostic Test.
—— Options

Test 1
Diagnostic Test

Start window

4. Yes is selected; press the [Enter] key to start the test. The message “Now
testing” (flashing) appears during the testing.

When the test is completed, the screen shows the test results as shown at
the top of the next page.
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—— Options

Test

TERMINAL 1650166-**

Press any key to escape.

Diagnostic Test
RFCON CPU 1650160-** <

7. MAINTENANCE, TROUBLESHOOTING

ROM
RAM
EEPROM
GPS

OK
OK
OK
OK

—— Program No.
** = Version no.

Sample communication unit self test results

The results are shown as OK or NG (No Good). For any NG, contact your

dealer for advice.

5. Press the [Esc] key to stop the test and return to the Test menu.

Note: Diagnostic test-related error messages appear at the bottom of the screen
as follows: TROUBLE: RFCON CPU ROM NG, TROUBLE: RFCON CPU
RAM NG, TROUBLE: RFCON CPU EEPROM NG
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7. MAINTENANCE, TROUBLESHOOTING

7.3

7.3.1

7-4

Performance Verification (PV) Test

After the FELCOM 16 is installed, the installer usually confirms that it is
functioning properly, by logging in and conducting the PV test. This test consists
of the receiving a test message from an LES, transmitting a message to an LES
and a distress alert test.

The results of the test appear on the PV test result display.

The PV test cannot be conducted from an auxiliary terminal unit. Note that the
test can also be initiated by an NCS.

PV test sequence

1.

hwn

© o NO O

Choose PV Test from the Test menu.

The MES requests an NCS to conduct the PV test.

NCS acknowledges request for testing.

The MES, upon receiving acknowledgment from NCS, goes into pending
state.

NCS will choose an LES to perform the test.

The LES transmits a test message to the MES.

The MES transmits a test message to the LES.

The LES receives test message.

The MES automatically transmits the distress alert test within two minutes
after completion of step 8.

10.When the distress alert test is finished, the LES sends the results of the PV

test to the MES.



7. MAINTENANCE, TROUBLESHOOTING

7.3.2 PV test procedure

1. Confirm that the communication unit is in idle condition and logged in.
2. Press the [F7] key to display the Options menu.

3. Press the [7] key to choose Test.

4. Press the [1] key to choose PV Test.

—— Options ]
Test 1
PV Test
Start
- | No

PV test screen
5. Yes is selected; press the [Enter] key to transmit the PV test request to NCS.
—— Options —]

Test |
PV Test

Starting PV Test Process.
Press any key to escape.

PV test screen

Note: If the terminal unit is not idle when the test is initiated, the screen
displays “Ignored: MES is not idle now. Cannot start PV Test.” And if
you are not logged in, “Ignored: MES is not Login. Please operate
Login.” appears.

6. Press the [Esc] key to return to the standby display.
7. The (automatic) testing sequence is as follows:
a) The screen displays “Current State: Idle (pending!)” when you receive the
acknowledge signal from the NCS.

b) When preparations for testing have been completed, “Current State:

TESTING” appears at the bottom of the screen. Further, the following
message appears.

Automatic test mode: Normal communication disabled.
Do not press any distress button unless you are in distress.

c) Receive a message from the LES. Send a test message to the LES.
d) Then, the distress alert test is automatically conducted after you have sent a
test message. Do not operate the equipment at this time.
e) When testing has been completed, “Current State: IDLE” appears at the
bottom of the screen.
8. The test results appear on the PV Test Result screen. See the next section
for how to interpret the results.
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7.3.3 Results of PV test

1. Atthe standby display, press the [F7] key to display the Options menu.
2. Press the [7] key to display the Test menu.
3. Press the [2] key to display the results of the PV test.

—— Options ]
Test |
PV Test Result
Ctrl+P: Print  ESC: Quit
Test Date & Time 02-02-25 01:58 (UTC)
L | Attempts First attempt
BBER Pass

Shore-to-Ship Attempts  First attempt
Ship-to Shore Attempts  First attempt

Distress Alert Pass (Test OK)
Signal strength Pass (Greater than Std level + 10dB)
Overall Result Pass (Applicable tests pass)

Sample PV test results
4. To return to the standby display, press any key.

Interpreting the PV test results display

Test Date & Time: Date and time of test

Attempts: Number of times the PV test was conducted.

BBER: Bulletin Board Error Rate (%). “Pass” appears for no
error.

Shore-to-Ship Attempts: Number of tests initiated by LES.
Ship-to-Shore Attempts: Number of tests initiated by MES.

Distress Alert: “Pass (Test OK)” appears for successful testing.

Signal Strength: “Pass” appears if signal strength is greater than
standard level.

Overall Result: “Pass” appears for satisfactory completion of the
test.
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System Status Monitor

The system status monitor, which is always displayed, provides date, time,
equipment status and navigation data.

File Edit Transmit EGC Reports Logs Options Setup Position StopAlarm
IMN: 443156710
Date 02-02-25 BBER 000
Time 01:32 (UTC) CIN OK ( 0dB)
Send Level OK( 0)
Position LAT 34:30.00N Rx AGC Level OK (254)
LON 135:00.00E REF Offset Freq OK( OHz
Waypoint LAT Synthe Local OK
LON VCXO Control 131
Course 3455 DEG
Speed 10.2KTS
Current NCS 344 (IOR) LOGOUT Antenna Power Supply  OK
Current Channel  NCSCC
Current TDM NCSCC Water Temperature DEG
MES Status Idle Water Current
GPS Status 2D Direction DEG
Speed KTS
DCE Memory 32818 Bytes free Depth
Current State: IDLE Retuning 02-02-25 01:32 (UTC)
NCS: IOR LOGOUT LAT: 34:30.00N
DCE F16 Ver. ## LON: 135:00.00E

## = Version no. of RF CON Board

System status monitor display

Interpreting the system status monitor

Date:
Time:
Position:

Waypoint:
Course:

Speed:

Current NCS:
Current Channel:
Current TDM:
MES Status:
GPS Status:

Current date

Current time

Own ship’s L/L position (either manual entry or
automatic input by navigator)

Blank

Course

Ship’s speed

NCS your vessel is logged in with

Channel in use

Channel TDM

Operational status of MES

Receiving signal status from GPS receiver.
CST. Cold Start

ACK: Acquired; Almanac data acquired

IMP:  Impossible; cannot receive GPS signal

INT: Interrupted; object interfering with reception
of GPS signal

ALM: Receiving the almanac

2D, 3D: Position-fixing method by 2D or 3D
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7.5
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DCE Memory:
BBER:
C/N:

Send Level:

RX AGC Level:

REF Offset Freq:
Synthe Local:
VCXO Control:

Antenna Power Supply:

Temperature*:
Water Current*
Direction:

Speed:
Depth*:

Memory remaining in communication unit

Bulletin Board Error Rate (%)

Check of circuit status with LES, receiving circuit in
antenna unit and RF CON/CPU Board in
communication unit. OK appears for figure greater
than 31.

TX level check. At transmission, OK appears for
figure greater than 123. At reception, OK appears for
figure lower than 32.

Check of the receiving circuit of the antenna unit and
the RF CON/CPU Board in the communication unit.
OK appears for figure greater than 60.

OK appears for figure lower than 150.

Check of RF CON/CPU Board.

Oscillator frequency control value.

NG appears for discontinuity or short in antenna
cable. OK is shown if the antenna is receiving
electrical power.

Blank

Blank
Blank
Blank

* = Requires data from appropriate sensor.

Replacing the Fuse

The fuse (12 VDC: 10A, 24 VDC: 5A)

in the power cable protects the

communications unit from overcurrent and reverse polarity. If the fuse blows, find
out the case before replacing it. If it blows again after replacement, contact your
dealer for advice. Be sure to use the correct fuse. Use of a wrong will damage
the equipment and void the warranty.

/\ CAUTION

Use the proper fuse.

to the equipment.

Use of a wrong fuse can result in damage

Fuse

12 vDC

Type: FGBO 125V 10A PBF
Code No.: 000-155-826-10

24 VDC

Type: FGBO-A 125V 5A PBF

Code No.: 000-155-853-10
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Error Messages

This section describes the more commonly seen error messages and the means
to restore normal operation. If normal operation cannot be restored, contact your

dealer for advice.

Equipment trouble messages

Messages in this category are prefixed with “TROUBLE:”.

Equipment trouble messages

Error Message

Meaning

Action

ANT power voltage
abnormality.

Antenna power voltage.

Have a licensed
radiocommunications
technician check the set.

Carrier power level.

Carrier power level too high or
too low.

Have a licensed
radiocommunications
technician check the set.

EEPROM ERROR.

EEPROM trouble.

Contact a FURUNO agent
or dealer for advice.

Invalid MES ID, This
equipment is
defected. Please
contact FURUNO.

MES ID is corrupted.

Have a licensed
radiocommunications
technician check the set.

Synthesizer
UNLOCK.

Synthesizer unlock.

Have a licensed
radiocommunications
technician check the set.
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7.6.2

7-10

Warning messages

Messages in this category are prefixed with “WARNING:”

Warning messages

Error Message

Meaning

Action

BBER over 80%.
Scanning NCS start
manually.

BBER (Bulletin Board Error
Rate) exceeded 80%.

Select NCS manually.

Cannot enter new
DNID. Memory full for
DNIDs.

Memory for DNIDs is full.

Delete unnecessary
DNIDs to enter new ones.

Cannot enter new
ENID. Memory full for
ENIDs.

Memory for ENIDs is full.

Delete unnecessary
ENIDs to enter new ones.

Cannot find NCS CC in
all region. Scanning is
continued.

No NCS found in region.

Scanning automatically
continues.

Cannot find NCS CC in
preferred region.
Scanning all region is
started.

NCS could not be found in
region selected. Scanning
started to find NCS.

If NCS could not be
found, contact you dealer
for advice.

Internal GPS UNIT
failure.

GPS signal could not be
detected.

Internal GPS receiver
may be damaged if this
message appears
frequently. Contact your
dealer for advice.

Synchronization loss.
Please change EGC
channel.

Your station is not
synchronized with selected
EGC channel.

Change EGC channel.

Synchronization loss.
Please check the
current NCS.

Your station is not
synchronized with selected
NCS.

Change NCS.




APPENDIX

Menu Tree

F1: File

— 1.
— 2.
— 3.
— 4.
— 5.
— 6.
— 7.
— 8.

New

Open

Close

Save

Delete
Rename
Print

Print Setting

F2: Edit

. Cut

. Copy
. Paste

. Insert (With Citation)
. Select All

. Search or Replace —[ 1.
2

. Replace Search Word

. Goto Line 1.
EZ.
3

. Time or Pos. Ins —[ 1.
2

. Change Window

No Printer
E Windows Printer
PP-510

Search —[ Search Word
Direction

Forward, Back

Replace Word

Direction Forward, Back
Query or All — Query, All
Top of Text
End of Text
. Goto Line — Chooses line to go to.
Time
. Position
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F3: Transmit

— 1. Transmit Message —

— Priority Not used.
— Message File

[ Station Name

I Destination Type
[ Prefix Code (Prefix selected)
— Country/Ocean Code
| Station ID
— Modem Type

(FAX, FAX prefixed selected)
— Address (For e-mail)
|~ Subject (For e-mail)
| Attach File (For e-mail)
— LED ID

— Option. )
Confirmation

Send Delay ———
Delivery Delay
- Code

— TRANSMIT

— 2. Cancel Select Message
— 3. Request Delivery Status — Select Message
F4: EGC

1. Display EGC Message
2. EGC Network ID

-

AP-2

TELEX

— FAX

— E-Mail

— SMS

— PSDN

— X400

— DNID

— SPEC

— TELEX (Prefixed)
— FAX (Prefixed)
— PSDN (Prefixed)
— X400 (Prefixed)
— DNID (Prefixed)

— SPEC (Prefixed)

T30 FAX

— V21 V.21 300bps Duplex

— V22 V.22 1200bps Duplex

— V22B V.22bis 2400bps Duplex
— V23 V.23 600/1200bps

— V26B V.26bis 2400/1200bps

— V26T V.26ter 2400bps Duplex
— V27T V.27ter 4800bps/2400bps
— V32 V.32 9600bps Duplex

ON, OFF

00:00 - 99:59; 00:00
Immediate, Deferred
IA5, ITA2, DATA

L— Other



F5: Reports
— 1. Data Report —

— 2. Message
Report

1. Data Report 1 —7— Status

2. Data Report 2
3. Data Report 3
4. Data Report 4
1. Message Report 1

— Report Length

— Destination
— Activation

~Interval Time

(Regular Interval chosen)
— Report Times
— Start Time 1 (Daily chosen)—
~ Start Time 2 (Daily chosen)y—
— Start Time 3 (Daily chosen)—
— Start Time 4 Daily chosen) —

APPENDIX

OFF

ON: Enhanced Data Report
ON: Usual Data Report
Position Only

Position and Course/Speed
Position and Course/Speed
with SEA INF

DNID selection

Regular Interval, Daily
00:10-99:59; 00:10

1-999; 1, - - - (No Limit)
00:00-23:59
00:00-23:59
00:00-23:59

Same as Data Report 1
Same as Data Report 1
Same as Data Report 1

Max. 8

— PIN Code

ON, OFF
Subscriber selection

— Status

— Station Name
— Destination Type
~ Prefix Code (Prefix chosen)
~ Country/Ocean Code
— Station ID
~ Modem Type

(FAX, FAX Prefixed chosen)
— Address

(E-Mail, SMS chosen)
— Subject (E-Mail chosen)

TELEX

FAX

E-Mail

SMS

PSDN

X400

DNID

SPEC

TELEX (Prefixed)
FAX (Prefixed)
PSDN (Prefixed)
X400 (Prefixed)
DNID (Prefixed)
SPEC (Pefixed)

— T30 FAX

— V21 V.21 300bps Duplex

— V22 V.22 1200bps Duplex

— V22B V.22bis 2400bps Duplex
— V23 V.23 600/1200bps

— V26B V.26bis 2400/1200bps
— V26T V.26ter 2400bps Duplex
— V27T V.27ter 4800/2400bps
— V32 V.32 9600bps Duplex

L— Other
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— LES ID LES selection
— Activation Regular Interval, Daily
~ Interval Time ——— 00:10 - 99:59; 00:10
(Regular Interval chosen)
~ Report Times ——————— 1-999; 1, - - - (No Limit)

~ Start Time 1 (Daily chosen) — 00:00 - 23:59
~ Start Time 2 (Daily chosen) — 00:00 - 23:59
~ Start Time 3 (Daily chosen) — 00:00 - 23:59
— Start Time 4 (Daily chosen) — 00:00 - 23:59

— Report Contents ————— NAV,
NAV (R), FILE
— File (FILE chosen) —— File selection

— 2. Message Report 2 — Same as Message Report 1
— 3. Message Report 3 — Same as Message Report 1
— 4. Message Report 4 — Same as Message Report 1
— 3. Data Network ID

F6: Logs
1. Send Message Log
2. Receive Message Log
3. EGC Log
4. Log

F7: Options (FELCOM functions as Inmarsat MES)

— 1. Login—— Yes, No

— 2. Logout —  Yes, No

— 3. Abort — Yes, No

— 4. Select NCS

— 5. Ocean Region —— Auto, West-Atlantic, East-Atlantic, Pacific, Indian
— 6. LES Information

— 7. Test 1. PV Test Yes, No
E 2. PV Test Result
3. Diagnostic Test —— Yes, No

F7: Options (FELCOM functions as EGC receiver)

— 1. Login—— Yes, No
— 2. Logout —  Yes, No
— 3. Abort —  Yes, No

— 4. Select EGC Ch.
— 5. LES Information

— 6. Test 1. PV Test Yes, No
E 2. PV Test Result
3. Diagnostic Test ———— Yes, No
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F8: Setup
— 1. System Setup —

— 2. Editor Setup ——

— 3. Terminal Setup

— Screen Saver

APPENDIX

System Date & Time — Date input

IMN ——— IMN input
MES Operation Mode — INMARSAT-C, EGC
Nav Port*

Active Port*

Message Output Port*
EGC Output Port*
Network Setup*

Command Window * Not used.

(For service technicians.)

Text Mode ———— Telex, Ascii

Edit Mode —— Insert, Overwrite

Word Wrap ———— ON, OFF

Line No. ——— ON, OFF

Tab Width ————— 2 Char, 4 Char, 8 Char

Column Width —— Telex (fixed at 69 characters), Ascii (40-80,69)
Cursor Type Block, Underline

Scroll ——  Full Screen, Half Screen

Date Disp. Form — YY-MM-DD, MMM-DD-YY, DD-MMM-YY

Currency Unit SDR, US$, EUR, YEN, OTHER (Currency unit input, 4 digits max.)

ON, OFF

Window Color —— Window Color Setup — Window — Base Window
RCV Message Display,
EGC Message Display,
EDIT 1, EDIT 2,
Function, SUB Menu 1,
SUB Menu 2,
SUB Menu 3,
SUB Menu 4,
Messaage,

— Fore ColorI L-WHITE, YELLOW,

— Back Colord L-MAGENTA, L-RED,
L-CYAN, L-GREEN,
L-BLUE, GRAY,
WHITE, BROWN,
MAGENTA, RED,
CYAN, GREEN,
BLUE, BLACK

— Default Color —— Yes, No
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AP-6

— 4. EGC Setup

— 5. Auto Mode
Setup

— 6. E-mail Setup

Additional Position
Navarea

Fixed Area
Waypoint*
Station Code

Type of Message
— Ice reports

— Meteo. forecasts

— Pilot service

— DECCA messages
— LORAN messages
— OMEGA messages
— SATNAV messages
— Other navaid msg

~ QRU (no message)
— Auto Log Print

I Receive Alarm

— Auto Receive Message Print

— Auto EGC Message Save —

— Auto EGC Message Print —

— Auto Receive Message Save —

— Data Report & Polling Print—

LES settings

— 7. Directories —I: Message Directory

EGC Message Directory

1 position
9 areas max.

* Not used

A-Z

ON, OFF
ON, OFF
ON, OFF
ON, OFF
ON, OFF
ON, OFF
ON, OFF
ON, OFF
ON, OFF
ON, OFF
ON, OFF
ON, OFF
ON, OFF
ON, OFF
System
FleetNET
SafetyNET
(Routine)
SafetyNET
(Safety)
SafetyNET
(Urgent&Distress)
System
FleetNET
SafetyNET
(Routine)
SafetyNET
(Safety)
SafetyNET
(Urgent&Distress)

ON, OFF
ON, OFF
ON, OFF
ON, OFF
ON, OFF
ON, OFF
ON, OFF
ON, OFF

ON, OFF

ON, OFF



L 8. Configuration —

F9: Position
LAT
LON

F10: Stop Alarm

— 1. Station List
(Max. 99 stations)

— 2. LES List
(44 per ocean E
region)

— 3. EGC Channel List (20 per ocean region)
— 4. NCS Channel List (20 per ocean region)

— 5. E-Mail/SMS
Service List
(16 max.)

'— 6. Save/Load

L

Station Group

Station Name
Destination Type —
Prefix Code

(Prefix chosen)
Country Code

Station ID

Modem Type
(FAX, FAX Prefixed
chosen)

E-Mail Address
(E-Mail chosen)
Remarks

Name

Remarks

Charge (TELEX-SPEC)

Service LES Name
Service ID (E-mail)
Service ID (SMS)
LES ID (AORW)
LES ID (AORE)
LES ID (POR)
LES ID (IOR)

To:
Cc:

Subject:
Separator:
SMS

Attach File (MIME)

Save

Load

APPENDIX

Max. 5 characters

Max. 5 characters

TELEX

FAX

E-Mail

SMS

PSDN

X400

DNID

SPEC

TELEX (Prefixed)

FAX (Prefixed)

PSDN (Prefixed)

X400 (Prefixed)

DNID (Prefixed)

SPEC (Prefixed)

T30 FAX

V21 V.21 300bps Duplex
V22 V.22 1200bps Duplex
V22B V.22bis 2400bps Duplex
V23 V.23 600/1200bps
V26B V.26bis 2400/1200bps
V26T V.26ter 2400bps Duplex
V27T V.27ter 4800/2400bps
V32 V.32 9600bps Duplex
Other

Max. 20 characters
Max. 15 characters
Max. 20 characters
Enter charges per 256 bit

Max. 19 characters
Max. 9 characters
Max. 4 characters

3 digits

3 digits

3 digits

3 digits

Max. 9 characters
Max. 9 characters
Max. 9 characters
Max. 9 characters
Max. 4 characters
OFF, ON (BASE64),
ON (UUENCODE)
1. ALL

2. Station List

3. LES List

4. E-Mail/SMS Service List
5. Other
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International Telex/Telephone Country Code List

Area and Country nglnet%t]%r:)%e Teleégggntry Remarks for Telex Code
Afghanistan 93 79
Alaska 1 200
Albania 355 604
Algeria 21 408
American Samoa 684 770
American Virgin Is. 1 208 Telex calls to former WUI subscribers, insert the figure
"9" after the destination code "208".
Andorra 33 590
Angola 244 991
Anguilla 1 391
Antigua & Barbuda 2 393
Argentina 54 33 Disregard the figure "0" at head of subscriber number.
Armenia 7 684
Aruba 297 303 Subscriber numbers are 2XXX or 5XXX
Ascension 247 939 Manual calls 3XXX
Australia 61 71
Australian External 672 766
Territories
Austria 43 a7
Azerbaijani 994 784
Azores Is. 351 404 Destination code is the same as for Portugal.
Bahamas 1 297
Bahrain 973 490
Bangladesh 880 780
Barbados 1 392
Belarus 7 681
Belgium 32 46
Belize 501 371
Benin 229 972
Bermuda 1 290
Bhutan 975 890
Bolivia (Rep. of) 591 371
Bolivia (ENTAL) 309
Bosnia-Hercegovina 387 600
Botswana 267 962
Brazil 55 38 Disregard the figure "0" at head of subscriber number.
British Virgin Is. 1 292
Brunei Darussalam 673 809
Bulgaria 359 67
Burkina Faso 226 978
Burundi 257 903
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Telephone | Telex Country

Area and Country Remarks for Telex Code

Country Code Code
Cambodia 855 807 Kampuchea Rep.
Cameroon 237 970
Canada 1 21 Disregard the figure "0" at head of subscriber number.
{ 26
Canary Is. 34 52 Destination code is the same as for Spain.
Cape Verde 238 993
Cayman Is. 1 293
Central Africa Rep. 236 971
Chad 235 976

TCH subscribers 2XXXXX
ENTEL subscribers 5XXXXX
Chile 56 34 TRA subscribers 3XXXXX
TECOM subscribers 6XXXXX
VTR CM subscribers 4XXXXX

China 86 85

Christmas Is. (Aus) 672 766

CIS (formerly USSR) 7 64

Cocos-Keeling Is. 672 766

Colombia 57 35 Disregard the figure "0" at head of subscriber number.

Comoros 269 994 Manual calls

Congo 242 981

Cook Is. 682 772

Costa Rica 506 376

Cote d'lvoire 225 983 Ivory Coast

Croatia 385 599

Cuba 53 28

Cyprus 357 605

Czechoslovakia 42 66

Denmark 45 55

Diego Garcia 246 938

Djibouti 253 979

Dominica 1 394
201 RCA subscribers 4XXXXX

Dominican Rep. 1 202 For subscriber number beginning with 346, disregard

"346" at head of subscriber number.

241 AGEM IR subscribers 61XX

Ecuador 593 308

Egypt 20 91

El Salvador 503 373

Estonia 372 537

(formerly USSR)
Ethiopia 251 980
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Area and Country C;)rslnetrr);(():r;%e Tele)égggntry Remarks for Telex Code
Falkland Is. (Malvinas) 500 306
Faroe Is. 298 502
Fiji 679 701
Finland 358 57
France 33 42
French Guiana 594 300
French Polynesia 689 702
Gabon 241 973
Gambia 220 996
Georgia 7 683
Germany (Fed, Rep. of) 49 69 formerly East Germany
49 { 41 formerly West Germany
Ghana 233 94
Gibraltar 350 405
Greece 30 601
Greenland 299 503
Grenada 1 395
Guadeloupe 590 299
Guam (RCA) 671 700
Guatemala 502 372
Guiana 594 300
Guinea Conakry 224 995 Manual calls
Guinea Bissau 245 969
Guyana 592 295
Haiti 509 203 RCA subscribers 9XXX
704 RCA subscribers 8XXX or 2968XX
705 ITT subscribers 743XXX
Hawaii 1 708 WUI subscribers 63XXX or 63XXXX
709 WUH subscribers 39XXXX
(773) Telex calls to HTC subscribers can be made using
Semi-automatic calls.
Honduras 504 374
Hong Kong 852 802
Hungary 36 61
Iceland 354 501
India 91 81
Indonesia 62 73 Disregard the figure "0" at head of subscriber number.
Iran 98 88
Irag 964 491
Ireland 353 500
Israel 972 606 Disregard the figure "0" at head of subscriber number.
Italy 39 43
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Area and Country C(Iﬁlrﬁ?;]%%%e Teleégggntry Remarks for Telex Code
Jamaica 1 291
Japan 72 KDDI (for 5 digits)
81 NTT
Jordan 962 493
Kazakhstan 7 785
Kenya 254 987
Kiribati 686 761 Subscriber numbers are 770XX
Korea (Demo, People's 850 (899)
Rep. of)
Korea (Rep. of) 82 801
Kuwait 965 496
Kyrgyzstan 7 788
Lao 856 804
Latvia (formerly USSR) 371 538
Lebanon 961 494
Lesotho 266 963
Liberia 231 997
Libya 21 901
Liechtenstein 41 45
Lithunia 370 539
(formerly USSR)
Luxembourg 352 402
Macao 853 808
Macedonia 389 597
Madagascar 261 986 Subscriber number beginning with 4, 5, 7, 8 and 9 can
be reached by Manual Calls.
Madeira Is. 351 404 Destination code is the same as for Portugal.
Malawi 265 904
Malaysia 60 84
Maldives Is. 960 896
Mali 223 985
Malta 356 406 Subscriber number beginning with 11XX can be
reached by Semi-automatic calls.

403
Mariana Is. 671 760
Marshall Is. 692 765
Maritinique 596 298
Mauritania 222 974
Mauritius 230 966
Mexico 52 22 Disregard the figure "0" at head of subscriber number.
Micronesia 691 764
Moldova 373 682
Monaco 33 42 Destination code is the same as for France.
Mongolia 976 800
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Area and Country Cgﬁlﬁey%ﬁje Teleégggntry Remarks for Telex Code
Montserrat 1 396
Morocco 21 407
Mozambique 258 992
Myanmar 95 83
(formerly Burma)
Namibia 264 908
Nauru 674 775
Nepal 977 891
Netherlands 31 44
Netherlands Antilles 599 390
New Caledonia 687 706
New Zealand 64 74
Nicaragua 505 375
Niger 227 975 2XXXX other numbers are for Semi-automatic calls.
Nigeria 234 905
Niue Is. 683 776
Northern Mariana Is. 670
Norfolk Is. 672 766
Norway 47 56
Oman 968 498
Pakistan 92 82
Palau 680 763
377 TRT subscribers
Panama 507 378 AACR subscribers
379 INTEL subscribers
Papua New Guinea 675 703
Paraguay 595 305
Peru 51 36
PHILCOM subscribers 2XXXX
RCPI subscribers 7XXXX
Philippines 63 75 < | GMCR subscribers 4XXXX
ETPI subscribers 6XXXX
CAPWIRE subscribers 1XXXX
For PTT subscribers, insert the figure "8" after the
L | destination code "75".
Poland 48 63 Disregard the figure "0" at head of subscriber number.
Portugal 351 404
205 RCA subscribers 2XXX
Puerto Rico 1 206 ITT subscribers 345XXX
207 C&W, WUI subscribers
209 ACPR (PRCA) subscribers
Qatar 974 497
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Area and Country C;I)—S:](at?;]%%%e Teleéc():g:ntry Remarks for Telex Code
Reunion 262 961 Subscriber numbers are 916XXX
Romania 40 65 Disregard the figure "0" at head of subscriber number.
Russian Federation 7 64
Rwanda 250 909
Saipan 670 760
San Marino 378 505
Sao Tome & Principe 239 967 Manual calls
Saudi Arabia 966 495
Senegal 221 906
Seychelles 248 965
Sierra Leone 232 998
Singapore 65 87
Slovak 42 66
Slovenia 386 598
Solomon Is. 677 778
Somalia 252 900
Cape Town subscribers XXXXXX

South Africa 27 95 Bophuthatswana subscribers 08XXXX
Transkei subscribers 09XXX

Spain 34 52

Spanish North Africa 34 52

Sri Lanka 94 803

St. Helena 290 (960) Manual calls 4XXX

St. Kitts & Nevis 1 397

St. Lucia 1 398

St. Pierre & Miquelon 508 204

St. Vincent & 1 399

the Grenadines

Sudan 249 984

Suriname 597 304

Swaziland 268 964

Sweden 46 54

Switzerland 41 45

Syria 963 492

Tajikistan 7 787

Taiwan 886 769

Tanzania 255 989

Thailand 66 86

Togo 228 977

Tokelau 690 762

Tonga 676 777

Trinidad & Tobago 296 294

Tunisia 21 409

Turkey 90 607

Turkmenistan 7 789
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Telephone | Telex Country

Area and Country Remarks for Telex Code

Country Code Code
Turks & Caicos Is. 1 296
Tuvalu 688 774
U.A.E. 971 893
Abu Dhabi 2XXXX, 3XXXX, BXXXX
Ajman 695XX
Dubai AXXXX
Fujairah BXXXX
Ras Al Khaimah 9XXXX
Sharjah 68XXX
Umm Al Qaiwain 697XX
Uganda 256 988
Ukraine 7 680
United Kingdom 44 51
United Arab Emirates 971 893
Upper Volta 226 978 Same as "Burkina Faso".
Uruguay 598 32
Uzbekistan 7 786

CCI subscribers 7XXXXXX

U.S. A 1 23 ITT subscribers 4XXXXX, 4XXXXXX, 4XXXXXXXXX
RCA subscribers 2XXXXX

WUI subscribers 6XXXX, BXXXXX, BXXXXXX

23 TRT subscribers IXXXXX, IXXXXXXXXX

FTCC subscribers 8XXXX, 8XXXXX

U. S. A. (Mainland) ) GRPHNET subscribers 36 XXXXX, 37XXXXX

For WUT subscribers, insert the figure "0" after the
destination code "23".

25 Telex calls to TWX subscribers whose numbers do not
contain "0" as the third figure of the 10 figure code can
be made as Semi-automatic calls.

U. S. S. R. (Former) 7 640 Russian Federation

Vanuatu 678 771

Vatican 379 504

Venezuela 58 31

Viet Nam 84 805 Subscriber number beginning with 561XXX can be

made using manual calls

Wallis & Futuna Is. 681 707

Western Samoa 685 779

Yemen (Rep. of) 969 806 Formerly Yemen (P. D. Rep. of)
Yugoslavia (Former) 967 895 Formerly Yemen (Arab Rep.)
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Area and Country C(-)rﬁLet‘r);(():T)?je Teleégg:ntry Remarks for Telex Code
Zaire 243 982 Telex calls to places other than Kinshasa Subscriber
beginning with 2XXXX can be made as Semi-automatic
calls.
Zambia 260 902
Zanzibar 259 990
Zimbabwe 263 907
Ocean Area o(-;r:zli?]pgggﬁ)n RTeI.ex Ocean Remarks
Access Code egion Access
AOR-W 874 584 Atlantic Ocean-W
AOR-E 871 581 Atlantic Ocean-E
POR 872 582 Pacific Ocean
IOR 873 583 Indian Ocean
LES List
April/2003
Land earth station operator Country AOR- E | AOR- W IOR POR
Beijing Marine China 311 211
Bezeq Israel 127 327
CAT Thailand 319
CP Radio Marconi Portugal 118
Embratel Brazil 114
France Telecom France 121 021 321 221
France Telecom (Ex DeteSat) [France 115 333
KDDI Japan 103 003 303 203
Korea Telecom South Korea 308 208
Morviasputnik (Nudel Les) Russia 117 317
OTE Greece 120 305
Polish Telecom Poland 116 316
Saudi Telecom Co Saudi Arabia 125 325
Singapore Telecom Singapore 328 210
Stratos Mobile Networks Canada 102 002 302 202
Telecom Company of Iran Iran 314
Telecom Italia Italy 105 335
Telenor Satellite Services Inc  |USA 101 001 201
Telenor Satellite Services AS  |Norway 104 004 304 204
Turk Telecom Turkey 110 310
Vishipel Vietnam 330
VSNL India 306
Xantic Netherlands 112 012 312 212
Xantic Australia 122 022 322 222
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International Telex Abbreviations

Abbreviation Meaning
ADV Advise
ACK Acknowledge
AGN Again
Bl (GS) Good bye
BK | cut off.
CFN Confirm
CoL Collation
CRV How do you receive?
DER Out of order
DWN Down
EEE Error
FM From
GA Go ahead.
MNS Minutes
MOM Wait (Waiting)
MUTI Mutilated
NA Correspondence to this subscriber is not admitted.
NC No circuits
NCH Snbscriber’'s number has been changed.
NP The called party is not or no longer is a subscriber.
NR Indicate your call number.
ocCcC Subscriber is engaged.
OK Agreed.
P (or 0) Stop your transmission.
PLS (PSE) Please
PPR Paper
P (RCD) Received
RAP I will call you again.
RD Read
RE Referring to
RPT Repeat
SRY Sorry
SVP Please
TAX What is the charge?
TEST MSG Please send a test message?
THRU You are in communication with telex position
TKS (TNX) Thanks
TLX Telex
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International Telegraphy Alphabet

APPENDIX

No. FIGURES | LETTERS No. FIGURES | LETTERS
1 - A 17 1 Q
2 ? B 18 4 R
3 C 19 S
4 qp* D 20 5 T
5 3 E 21 7 U
6 L= F 22 = \Y
7 . g G 23 2 W
8 * H 24 / X
9 8 | 25 6 Y
10 BELL* J 26 + Z
11 ( K 27 CARRIAGE RETURN
12 ) L 28 LINE FEED
13 M 29 LETTERS
14 , N 30 FIGURES
15 9 0 31 SPACE
16 0 P 32 BLANK

* = Cannot be entered.
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Messages

Below are the various operational messages and their meanings. Messages are arranged
according to function key.

[F1] File

1. "Overwrite?"

You are asked if you are sure to overwrite file name entered.
2. "OK to save?"

You are asked if you are sure to save a file.
3. "OK to delete file?"

You are asked if it is OK to delete selected file.
4. "Can't delete."

File cannot be deleted.
5. "Enter new filename"

Enter a new file name (to save file under new name.)
6. "Can't rename."

Cannot rename file.
7. "Press any key to escape."”

Press any key to erase message displayed.
8. " Drive not ready."

No floppy disk in disk drive.
. "Write protected.”
Floppy disk is write protected.

10. " Drive error."

Floppy disk may be defective.
11. "Directory not found."

Directory specified could not be found.
12. "Checking "

Checking MIME-coded file.
13. "Decode ?"

Decode Base64 coded file.
14. "Now decoding..."

Decoding file.
15. "Complete."

File decoding completed.
16. "Decode failed. "

File could not be decoded.
17. "This terminal not support this code."

File could not be decoded because type of code not supported.
18. "Decoded 1 file(s)."

Decode MIME coded file.
19. "This file is not encoding."

Cannot encode file selected.
20. "File is already exist. Overwrite?"

File name encoded by MIME already exists.

(]
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[F3]: Transmit

1.

2."

3."

8."

9.

10

11.°

12. "

13.

14.

15."

16.

17

[F5]:
1."

2."

"Input Error : Message File."
Invalid message selected for transmission.
Input Error : Country/Ocean Code."
Invalid country/ocean code entered.
Input Error : Station ID."
Invalid station ID entered.
"Input Error : Modem Type."
Invalid mode type entered. (For FAX, choose T30.)
"Input Error : E-Mail Address."
Invalid e-mail address entered.
“Input Error : LES ID."
Invalid LES ID entered.
"Input Error : Send Delay."
Invalid send delay time entered.
Input Error : Prefix Code."
Invalid prefix code entered.

"Invalid character detected in message."

Invalid character found in TX message.
. "Don't support E-Mail service in this NCS."
Selected NCS does not handle e-mail.
Input Error : Too many stations."”
You have selected too many stations to transmit to.
Message file is too large (but send only with 32KB)."
The size of the file you want to send is larger than 32,000 bytes. (The file can be
sent, but only the first 32,000 bytes of information will be received.)
"Attach file is too large."
The size of the attachment you want to send is larger than 32,000 bytes.
"Attach file (file name) is not found."
Cannot find attached file.
Message is entered in sending Queue. Press any key."
Tx message entered into queue.
"Can't enter this message to sending Queue. Press any key."
Could not enter TX message into queue.
. “The LES is out of service.”
LES selected does not support Mini C.

Data report

Input Error : Country/Ocean Code."
Invalid country/ocean code entered.
Input Error : Station ID."
Invalid station ID entered.

“Input Error : LES ID."

Invalid LES ID entered.

"Input Error : Interval Time"

Invalid interval time entered.

. "Input Error : Start Time"

Invalid start time entered.
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6. "Input Error : Modem Type"
Invalid modem type entered.
7. "Input Error : Report Contents"
Invalid report contents entered.
8. "Input Error : Report Times"
Invalid number of report times entered.
9. "Input Error : Destination”
Invalid destination entered.
10. "Input Error : E-Mail Address"
Invalid e-mail address entered.
11. "Don't support E-Mail service in this NCS."
NCS does not handle e-mail.
12. "Input Error : Prefix Code"
Invalid prefix code entered.

[F7]: PV test

1. "Starting PV Test Process."

Going into PV test mode.
2. "Automatic test mode: Normal communication disabled."

Going into automatic test mode — all communications are disabled.
3. "Do not press any distress button unless you are in distress."

Do not operate the [DISTRESS] button except in an emergency.
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Parts List

This equipment contains complex modules in which fault diagnosis and repair down to
component level are not practical (IMO A.694(17)/8.3.1. Only some discrete components
are used. FURUNO Electric Co., Ltd. believes identifying these components is of no value
for shipboard maintenance; therefore, they are not listed in the manual. Major modules can
be located on the parts location photos on the next several pages.

FURUNO

PARTS LIST

SYMBOL TYPE REMARKS

COMMUNICATION UNIT IC-216
PRINTED CIRCUIT BOARD
16P0208B, RF CON/CPU
16P0217, PWR
16P0227, PWR C

ASSEMBLY
GN 8097, GN 80 (option)

ANTENNA UNIT IC-116
PRINTED CIRCUIT BOARD
ANTENNA CASE
(ANT RF BOARD (16P0216))
ANTENNA BASE
ANTENNA ELEMENT
(ANT-B BOARD (16P0206))
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Parts Location

Communication unit

PWR C Board
(16P0227)

PWR Board3

(16P0217) —  RF CON/CPU
Board
(16P0208 B)

INT GPS Assy.[

(GN809 7)
Communication unit, cover opened, INT GPS assy. installed
Antenna unit
ANT RF Board[l
(16P0216)
ANT B Board
(16P0206)

/ /

Antenna Case Antenna Element

Antenna unit, cover opened
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11
1.2
13
14
15
1.6
1.7
1.8
1.9
1.10

2.1
2.2

2.3
2.4
2.5

4.2
4.3

4.4

51
5.2
53

FELCOM 16

SPECIFICATIONS OF INMARSAT C MES

GENERAL

Transmitting Frequency

Receiving Frequency
Channel Interval

GIT

EIRP

Modulation
Modulation Rate
Coding

Decoding

Internal GPS Board

ANTENNA UNIT
Antenna Type
Gain

Horizontal:
Vertical:

Declination
Axial Ratio
VSWR

SOURCE
Communication Unit

FELCOM 16

1626.5 to 1646.5 MHz

1530.0 to 1545.0 MHz

5 kHz

Better than -23 dB/K (elevation angle 5°)

7 to 16 dBW (elevation angle 5°)

BPSK

1200 sps

Convolution with coding rate 1/2 and constraint length 7
Viterbi decoder

GGA, ZDA, GLL, VTG, RMC, GSV (IEC61162-1)

Daisy Loop Antenna

Omnidirectional

0 dBi or more (angle of elevation: 90°)
+1.3 dBi or more (angle of elevation: 5°)
Clockwise circular

Within 6 dB (5° to 90°)

1.5 or less (50 ohm)

12-24 VDC: 6.0-2.0 A (Transmit), 0.6-0.4 A (Receive)

ENVIRONMENTAL CONDITION

Ambient Temperature

Exposed equipment:
Protected equipment:
Relative Humidity

Waterproof (IEC 60529)

Antenna Unit
Communication Unit
Others

Vibration

COATING COLOR
Antenna Unit
Communication Unit
Others

-35°C to +55°C (storage: -35°C to +70°C)
-15°C to +55°C
95% (at +40°C)

IPX6
IPX2
IPX0
IEC 60945

Upper: N9.5, Lower: 2.5PB3.5/10
Cover: N3.0, Panel: N1.0
2.5GY5/1.5

SP-1 E5638S01G
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A
Aborting, 6-1

C
Colors
background, 2-3
foreground, 2-3
Communication unit
description, 1-1
testing, 7-2
Currency unit, 2-3

D
Data report
preparing, 5-2
printing, 5-7
Date
format, 2-3
manual input, 2-2
Delivery status
automatic confirmation, 4-17
manual confirmation, 4-19
Diagnostics, 7-2
Directory
creating, 2-31
specifying directory for message storage,
2-33
Display indications, 1-7
DNID
displaying, 5-12
enabling/disabling, 5-13

E

Editor setup, 3-4

EGC
description, 2-8
EGC channels, 2-13
ENID, 4-34
message log, 4-35
message printing, 4-33
printing messages automatically, 2-16
receiving channel selection, 6-3
saving messages automatically, 2-15
setup, 2-10

E-mail
service list, 2-34
setup, 2-37

ENID, 4-34

Error messages, 7-9

F
Files
combining, 3-15
decoding MIME files, 3-18
deleting, 3-16
opening, 3-12
printing files on hard disk, 3-15
renaming, 3-17
saving, 3-10
saving under new name, 3-14
switching between two, 3-12
Function key description, 1-5
Fuse replacement, 7-8

I

Inmarsat C system, x

International telegraphy alphabet, AP-17

International telex abbreviations, AP-16

International telex/telephone country code list,
AP-8

L
LES
editing stations, 2-22
information, 6-5
list, AP-15
printing LES list, 2-23
registering stations, 2-21
setting toll charges, 2-19
Log
displaying, 4-31
printing (automatic), 4-32
printing (manual), 4-31
Logging in, 2-5
Logging out, 2-7
M
Maintenance, 7-1

Menu overview, 1-11
Menu tree, AP-1
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Message report, 5-4
Messages
deleting received, 4-30
preparation of confidential, 3-3
preparation of routine, 3-2
printing received automatically, 4-28
saving received automatically, 4-29
Messages (alerts), AP-18
MIME, 3-18

N

NCS
adding channels, 2-17
channel selection, 6-4
scanning, 6-2

P
Parts list, AP-21
Parts location, AP-22
PC window setup, 2-3
Polling
printing commands, 5-7
Polling
commands, 5-8
reception, 5-11
Position input, 2-30
POWER switch (Communication unit), 1-1
Printer selection, 1-13
Printing
data report, 5-7
EGC messages, 4-33
EGC messages automatically, 2-16
files on hard disk, 3-15
LES list, 2-23
Log (automatic), 4-32
Log (manual), 4-31
polling command, 5-7
received messages (automatically), 4-28
station list, 2-29
Program no. list, viii
PV test
procedure, 7-5
results, 7-6
sequence, 7-4

R
Receiving
attachments, 4-27
description, 4-23
displaying received messages, 4-24

IN-2

printing received messages (automatically),
4-28
receive alarm, 4-24
receive alarm on/off, 4-24
saving received messages to hard disk
(automatically), 4-29
Replacing text, 3-8

S
Saving
EGC messages automatically, 2-15
file under new name, 3-14
files, 3-10
received messages to hard disk
(automatically), 4-29
received messages to hard disk (manually),
4-28
Searching text, 3-7
Send message log, 4-22
Shortcut key, 1-4
Standby display, 1-6
Station list
adding stations, 2-24
editing stations, 2-28
printing, 2-29
System configuration, ix
System settings
loading, 2-38
saving, 2-38
System setup, 2-1
System status monitor, 7-7

T
Terminal setup menu, 2-3
Terminal unit
application startup, quitting, 1-2
controls, 1-3
Text
copying and pasting, 3-6
cutting and pasting, 3-5
go to line, 3-9
inserting, 3-7
inserting time or position, 3-9
replacing, 3-8
searching, 3-7
selecting all, 3-7



Transmitting
canceling, 4-16
code number services, 4-20
delivery status (automatic receipt), 4-18
file stored on hard disk, 4-15
message to station not on station list, 4-8
message to station on station list, 4-2

W
Warning messages, 7-10
Window color, 2-3
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